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BAB I  

STATISTIK, PENELITIAN, DAN  

PROGRAM KOMPUTER 
 

 

 

 

 

 

 

A. PENGERTIAN STATISTIK 
Pengertian “statistik” secara etimologi berasal dari bahasa latin yaitu 

status yang berarti negara. Memiliki kesamaan dengan bahasa Inggris “state” 

dan Belanda, “staat”. Itu sebabnya kata statistik dapat diartikan keterangan 

atau data yang berguna bagi negara. Contohnya, keterangan atau data jumlah 

penduduk, luas negara, hasil pertanian dan lain sebagainnya. Jika melihat 

dalam kamus Bahasa Inggris maka dapat dijumpai dua kata yang memiliki 

kesamaan namun memiliki arti yang berbeda yaitu “statistics” dan “statistic”. 

Statistics adalah ilmu yang terkait dengan data atau keterangan (ilmu statistic) 

sedangkan statistic adalah data atau keterangan hasil penerapan algoritma 

statistic pada data atau keterangan. Jadi statistika (statistics) adalah ilmu yang 

mempelajari tantang proses perencanaan, pengumpulan, analisis, interpertasi 

dan penyajian data. 
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B. MANFAAT STATISTIK 
Statistik dalam aplikasinya memberikan dampak yang positif di dalam 

kehidupan. Jika dijabarkan satu persatu maka akan sangat banyak sekali 

manfaat yang diperoleh dari aplikasi statistik. Namun secara umum, statistik 

membantu dalam membuat keputusan. Dalam setiap pengambilan keputusan, 

baik itu presiden, menteri, direktur, karyawan, kepala rumah tangga, atau 

sebagai individu memerlukan data. Dari berbagai data diolah, dianalisis, 

disajikan berupa informasi untuk dijadikan dasar dalam pengambilan 

keputusan.  

Contohnya, seorang direktur akan mengambil keputusan terkait dengan 

biaya promosi. Maka akan muncul berbagai pertanyaan, apakah harus 

menaikan atau mengurangi biaya promosi?, Berapa promosi yang harus 

dikeluarakan, 1 juta, 2 juta atau 3 juta? Jika mengelurakan 1 juta, apakah akan 

meningkatkan atau justru menurunkan volume penjualan? Berapa, 2 unit, 3 

unit atau 4 unit? Jadi diperlukan penerapan statistik untuk menghasilkan 

informasi untuk menjawab pertanyaan-pertannyaan tersebut. 

 

C. JENIS STATISTIK 
Berdasarkan tujuan analisis, statistik dapat dibagi menjadi dua yaitu 

statistik deskriptif dan statistik inferensial: 

1. Statistik Deskriptif 

Metode yang berkaitan dengan pengumpulan suatu data yang bertujuan 

untuk mendeskripsikan data lalu disajikan baik secara numeric (frekuensi, 

nilai sentral, penyimpangan data dan distribusi data) maupun grafis (grafik, 

table atau diagram) agar lebih mudah dibaca dan disimpulkan. Namun 

penarikan kesimpulan hanya terbatas pada data yang diolah. Misalnya jumlah 

mahasiswa Fakultas Ekonomi Universitas ABC adalah 200 mahasiswa, terdiri 

dari 100 mahasiswa jurusan Manajemen, Akuntansi dan Ilmu Ekonomi. 

Standar kelulusan yang baik harus memiliki IPK 3,00. Rata-rata (mean) IPK 

mahasiswa Jurusan Manajemen Fakultas Ekonomi Universitas ABC adalah 

3,26 jadi dapat ditarik kesimpulan kelulusan mahasiswa jurusan manajemen 

adalah baik. Tidak dapat disimpulkan atau diramalkan kelulusan mahasiswa 

Fakultas Ekonomi Universitas ABC adalah baik. Artinya penarikan 

kesimpulannya hanya terbatas pada data mahasiswa manajemen tidak dapat 

digeneralisasikan atau diramalkan pada jurusan yang lain. 

2.  
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Statistik Inferensial 

Berbeda dengan statatistik deskripsi, pada statistik inferensial berkaitan 

dengan metode yang berkaitan dengan pengumpulan data yang bertujuan 

untuk menarik kesimpulan dan peramalan yang dapat digeneralisasikan pada 

suatu populasi.  Jadi data yang dikumpulkan adalah sampelnya, lalu dilakukan 

pengujian hipotesis yang hasilnya dapat disimpulkan dan diramalkan, yang 

dapat berlaku pada populasinya. Itu sebabnyak statistik inferensial dapat 

dikatakan statistik induktif. Alat analisisnya seperti uji independen sampel t 

test, uji z, uji t atau uji f dan lain sebagainnya. 

Berdasarkan asumsi dan distribusi data, statistik dapat dibagi menjadi 

dua yaitu statistik parametrik dan non parametrik: 

a. Statistik Parametrik 

Statistik parametrik adalah statistik yang didasarkan pada asumsi bahwa 

data berdistribusi normal (jika tidak normal maka dapat dilakukan 

transformasi agar data berdistribusi normal atau diasumsikan normal jika 

data yang dianalisis ≥ 30 dengan dasar teorema limit pusat) dengan data yang 

digunakan adalah yang skalanya interval dan rasio. Contoh statistic 

parametric antara lain uji z, regresi liner berganda dan lain sebagainya. 

b. Statistik Non Parametrik 

Statistik non parametrik adalah statistik yang tidak didasarkan pada 

asumsi bahwa data berdistribusi normal dengan data yang digunakan 

umumnya yang skalnya nominal dan ordinal. Contoh statistic parametric 

antara lain chi-square test, rank sum test dan lain sebagainya. 

Berdasarkan jumlah variabel, statistik dapat dibedakan menjadi dua yaitu 

statistik univariat dan multivariate. 

i. Statistik Univariat 

Statistik yang menganalisis satu variabel. Misalnya frekuensi, mean, 

variasi, persentase dan lain sebagainya. 

ii. Statistik Bivariat 

Statistik yang menganalisis dua variabel baik yang bersifat pengaruh, 

hubungan atau perbandingan. Misalnya uji korelasi, uji independen sampel t 

test dan lain sebagainya. 

iii. Statistik Multivariat 

Statistik yang menganalisis lebih dari dua variabel, misalnya analisis 

factor, diskriminan, dan lain sebagainya. 
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D. STATISTIK DAN PENELITIAN KUANTITATIF 
Paradigma penelitian adalah cara pandang peneliti dalam memahami 

masalah dan kreteria pengujiannya sebagai landasan dalam memberikan 

jawaban atas permasalahan tersebut. Secara umum paradigm penelitian 

dibagi menjadi dua, yaitu paradigma kuantitatif dan kualitatif. Setiap 

paradigma memiliki keunggulan dan kelemahan masing-masing. Kedua 

paradigma dapat digunakan (mix method) dalam suatu penelitian sehingga 

tercipta nilai tambah dalam mengurangi kelemahan masing-masing 

paradigma. 

Paradigma kuantitatif lebih menekankan pada pengujian teori melalui 

pengukuran variabel dengan menggunakan analisis statistika. Jadi pendekatan 

yang digunakan adalah deduktif dengan pengujian hipotesis. Pendekatan ini 

disebut juga pendekatan tradisional, positivis, eksperimental atau empiris. 

Sedangkan paradigm kualitatif memberi tekanan pada penyusunan teori 

memlalui pengungkapan fakta secara rinci, holistik dan kompleks. Jadi 

pendekatan yang digunakan adalah induktif dengan menyusun konstruksi 

teori melalui pengungkapan fakta. Pendekatan ini disebut juga pendekatan 

konstruktifis, naturalistis (interpretatif), atau perspektif postmodern. Jadi 

penggunaan statistika dengan metode dan pengujiannya digunakan pada 

paradigm penelitian kuantitatif. 

Tahapan-tahapa dalam penelitian kuantitatif adalah sebagai berikut: 

pertama, dilakukan identifikasi yang menjadi masalah dalam penelitian. 

Kedua, melakukan kajian teori dan empiris sehingga dapat diketahui variabel 

penelitiannya. Ketiga, penyusunan kerangka pikir yang didasarkan hasil kajian 

teoritis dan empiris dan keempat, disusun hipotesis dan pengujian hipotesis 

penelitian. 

 

E. STATISTIK DAN PROGRAM KOMPUTER 
Banyak masyarakat umum yang menilai bahwa ilmu statistik dinilai 

sebagai ilmu yang sulit, tidak jauh berbeda dengan matematika. Rumus-rumus 

yang bermacam-macam, dilihat saja suduh ribet, belum lagi dihapal. Padahal 

ilmu statistik adalah ilmu yang menarik khususnya bagi peneliti. Bahkan 

untuk belajar statistik, tidak harus menghapal berbagai rumus-rumus statistik 

karena tersedia berbagai macam program di komputer yang membantu 

mengolah berbagai data seperti program SPSS, Smart PLS, Eviews, AMOS, 

Lisrel, MATLAB, dan lainnya.  
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Adanya berbagai program pengolahan data di komputer memudahkan 

didalam pengolahan data. Hal ini karena aplikasi ilmu statistik dapat 

dilakukan dengan dua cara yaitu secara manual dan non manual 

(menggunakan komputer). Jika data yang diolah jumlahnya tidak banyak 

maka penerapan ilmu statistik secara manual dapat diterapkan. Namun jika 

data yang diolah jumlahnya sangat banyak maka perlu penerapan ilmu 

statistik dengan menggunakan komputer. Tujuannya adalah untuk efektifitas 

dan efisiensi. Efektif artinya berapa pun data yang diolah, apapun tujuan 

pengolahaannya maka komputer mampu untuk mengolahkannya. Efisien 

artinya tidak membutuhkan banyak waktu, lebih tepat, rapi, handal dan 

meminimalkan human error. 

Secara sederhana untuk belajar statistik menggunakan program di 

komputer ada dua hal yang harus diketahui, yaitu: 

1. Alat, Guna dan Syaratnya. 

Dalam statistik tersedia berbagai macam alat yang dapat digunakan untuk 

mengolah data.  Masing-masing alat memiliki fungsi yang berbeda-beda. Jadi 

ketahui alatnya apa dan buat apa. Misalnya independen sampel t test berguna 

untuk menguji perbedaan dua sampel yang independen, regresi liner 

berganda bergunan untuk menguji pengaruh dua variabel independen atau 

lebih terhadap variabel dependen dan lainnya.  Namun setiap alat memiliki 

syarat tertentu sebelum menggunakannya. Misalnya, untuk menggunakan 

regresi liner berganda maka syaratnya datanya harus interval atau rasio, 

berdistribusi normal dan liner. Jika datanya interval atau rasio, berdistribusi 

normal dan liner maka data dapat diolah dengan regresi liner berganda. Jadi 

ketahui alatnya apa, gunannya buat apa dan apa syarat menggunakan alat 

tersebut. 

2. Mengolah dan Menginterpertasikannya 

Jika sudah mengetahui alat dan kegunaannya maka selanjutnya perlu 

diketahui bagaimana pengolahannya. Tahapan-tahapan yang harus dilalui 

untuk mengolah data. Setiap program memiliki tahapan pengolahan yang 

berbeda-beda. Hasil dari pengolahan berupa output akan diinterpertasikan 

sesuai ketentuan. Tersedia berbagai buku petunjuk penggunaan program di 

komputer termasuk pengolahan dan interpertasinya. 
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TEORI, VARIABEL DAN DATA 

 

 

 

 

 

 

 

 

A. TEORI 
Teori memiliki peran penting dalam penelitian kuantitatif karena menjadi 

landasan dalam menerangkan fenomena yang ada untuk memperoleh 

jawaban dari masalah di dalam penelitian. Teori adalah serangkaian konsep, 

definisi dan proporsisi tentang fenomena yang disusun secara sistematis 

dengan cara merumuskan hubungan antar konsep. 

Konsep adalah fenomena yang bersifat abstrak. Jenis konsepsi yang 

memiliki tingkat abstraksi yang lebih tinggi disebut konsutruk. Contoh konsep 

kepusaan. Agar konsep dapat diteliti secara empiris maka konsep tersebut 

harus dioperasionalisasikan menjadi variabel dengan cara mengambil 

dimensi-dimensi (konstruk) yang disebut indikator dari kepuasan (misalnya 

senang, tidak komplain dan membagi informasi yang positif) yang 

mengandung variasi nilai. 
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Hubungan-hubungan antar konsep atau lebih yang dapat diuji 

kebenarannya disebut dengan proporsisi. Misalnya, konsep kualitas pelayanan 

dan kepusaan pelanggan, proporsisinya adalah semakin baik kualitas 

pelayanan maka semakin puas pelanggan. Benarkah kualitas pelayanan 

menentukan tinggi rendahnya kepuasan pelanggan. Jika diduga meningkatnya 

kualitas pelayanan akan meningkatkan kepuasan pelanggan, begitu pula 

sebaliknya maka pernyataan ini berubah menjadi hipotesis. 

 

B. VARIABEL 
Variabel adalah hasil oprasionalisasi konsep yang mempunyai variasi 

nilai. Jadi segala sesuatu dapat disebut variabel asal memiliki nilai yang 

bervariasi. Misalnya, konsumsi, disebut variabel, karena memiliki nilai yang 

bervariasi. Usia, pendapatan, jenis kelamin disebut juga variabel karena 

semuanya memiliki variasi nilai. Variabel tidak hanya terkait dengan variasi 

nilai yang kuantitatif tetapi juga kualitatif. Misalnya kepuasan, motivasi dan 

lain sebaginya. Variabel mana yang digunakan, sangat tergantung dari 

permasalahan penelitian. 

Berdasarkan nilai variasinya, variabel dibagi menjadi dua yaitu variabel 

discrete dan variabel continous. Discrete berarti variabel tidak memiliki nilai 

pecahan, misalnya jumlah keluarga adalah 3 orang, 12 orang atau 10 orang 

dan tidak pernah ada jumlah keluarga 3,5 orang atau 12,7 orang. Hal sama 

juga berlaku misalnya pada jumlah mobil, jumlah anak dan lain sebagainya. 

Sebaliknya variabel continous dapat dinyatakan dengan angka pecahan. 

Misalnya panjangnya mobil 2,5 meter atau beratnya anak mencapai 22,7 

kilogram dan lain sebaginya. 

Berdasarkan fungsinya, variabel dibagi menjadi empat variabel, yaitu: 

pertama, variabel dependen adalah variabel yang menjadi perhatian utama 

peneliti karena hasil analisis variabel dependen memungkinkan peneliti untuk 

menemukan jawaban atau solusi dari masalah penelitian. Kedua, variabel 

independen adalah variabel yang mempengaruhi variabel dependen baik 

positif maupun negatif. Ketiga, variabel moderator adalah variabel yang 

memperkuat atau memperlemah pengaruh variabel independen terhadap 

variabel dependen. Keempat, variabel antara (Intervening) adalah variabel 

yang ada saat variabel independen mulai bekerja mempengaruhi variabel 

dependen. Jadi variabel antara berfungsi mengkonsepkan dan menjelaskan 

bagaimana variabel independen dapat mempengaruhi variabel dependen 

secara tidak langsung. 
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Berdasarkan model persamaan, variabel dibagi menjadi dua yaitu 

pertama,variabel eksogen variabel sebab dalam model persamaan. Variabel 

eksogen terdiri dari variabel eksogen yang diteliti dan variabel eksogen yang 

tidak diteliti (residual/error variabel). Kedua, variabel endogen adalah 

variabel akibat dalam model persamaan. Variabel endogen dapat 

diperlakukan sebagai variabel antara (intervening). 

Berdasarkan pengamatannya, variabel dapat dibagi dua yaitu, pertama, 

variabel laten/unobserver adalah variabel yang tidak dapat diobeservasi 

secara langsung tetapi memerukan indikator-indikator untuk mengukurnya. 

Contonya kepuasan pelanggan, loyalitas, dan lain sebaginya. Kedua, variabel 

manifest/observer adalah variabel yang dapat diobeservasi secara langsung. 

Contohnya, jumlah keluarga, tingkat pendapatan, inflasi dan lain sebagainya. 

 

C. DATA 
Data adalah sekumpulan fenomena baik kualitatif maupun kuantitatif 

sebagai hasil dari pengamatan dan pengukuran dari berbagai obyek kajian. 

Data dikalsifikasikan oleh berbagai jenis, seperti sumber, bentuk, dan waktu. 

Keragaman 
Tenaga Kerja 

Sinergi Kreatif Efektivitas 
Organisasi 

Keahlian 
Manjerial 

Variabel 

Independen 

Variabel Antara Variabel  
dependen 

Variabel 
Moderator 

Variabel 
Eksogen 

Variabel 
Endogen 

residual/error 
variabel 

Tidak 

Diteliti 
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Pengetahuan tentang data akan memudahkan dalam menentukan alat analisis 

statistik yang akan digunakan. 

Berdasarkan sumber, data dibagi menjadi dua yaitu data perimer dan 

data sekunder. Data primer adalah data yang diperoleh dari pihak pertama 

sedanngkan data sekunder adalah data yang diperoleh dari pihak kedua. 

Misalnya data laporan keuangan bank ABC, jika diperoleh langsung dari bank 

ABC maka disebut data primer, namun jika diperolehnya dari pihak kedua 

(misal, Bank Indonesia) mka disebut data sekunder. Jadi terkait dengan data 

primer dan sekunder bukan pada soal diolah atau belum diolah. 

Berdasarkan bentuknya dibagi menjadi dua data kualitatif dan data 

kuantitatif. Data kualitatif adalah data yang berupa kata, gambar, atau kalimat. 

Sedangkan data kuantitatif adalah data yang berupa angka. Namun dapat pula 

data yang berupa angka adalah data kualitatif yang dikuantitatifkan (data 

nominal dan ordinal). Data kuantitatif dibagi menjadi dua yaitu data kategori 

(nominal) dan kontiniu (ordinal, interval dan rasio). Data dapat juga dibagi 

dua yaitu data matric (interval dan rasio) dan mnon matric (nominal dan 

ordinal). 

Berdasarkan skala ukurnya, data dibagi empat yaitu:  

1. Data Nominal  

Data yang mengandung unsur penamaan (bahasa latin, nomos = nama). 

Cirinya posisi data sejajar dan tidak berlaku operasi matematik. Misalnya Pria 

(diberi skor 1) dan wanita (diberi sekor 2), atau Perusahaan A (diberi skor 1), 

perusahaan B (diberi skor 2) dan perusahaan C (diberi skor 3). Pemberian 

skor hanya penamaan saja. Bukan berarti Wanita lebih tinggi dari Pria karena 

skornya 2. Tidak dapat juga dioperasikan matematis, dimana perusahaan A 

ditambah perusahaan B sama dengan Perusahaan C. 

2. Data Ordinal 

Data yang mengandung unsur penamaan dan urutan (order). Cirinya 

posisi data bertingkat, tidak berlaku operasi matematik dan jarak skor 

(interval) tidak mempunyai arti. Misalnya, SD (diberi skor 1), SLTP (diberi 

skor 2), SLTA (diberi skor 3), atau Sangat Setuju (diberi skor 5, Setuju (diberi 

skor 4), Cukup (diberi skor 3), Tidak Setuju (diberi skor 2), Sangat Tidak 

Setuju (diberi skor 1). Tidak bisa 1 + 2 = 3 adalah sangat tidak setuju ditambah 

tidak setuju sama dengan cukup, lalu jarak antara skor 4 dengan 2 yaitu 2 dan 

3 dengan 1 yaitu 2, maka angka jarak 2 (4 dengan 2) dan 2 (3 dengan 1) tidak 

ada artinya. 
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3. Data Interval 

Data yang mengandung unsur penamaan, urutan, dan jarak (interval). 

Cirinya tidak ada skor seperti data nominal dan ordinal, berlaku operasi 

matematis, nilai nol (0) bukan angka mutlak dan jarak data sama. Misalnya: 

 

Variabel Suhu 

(0C) 

Variabel 

Ketinggian 

(Meter) 

0 -100 

10 0 

20 100 

30 200 

40 300 

 

Nilai 0 memiliki arti, seperti 0 0C = 32 0F, atau 0 Meter berarti ketinggian 

permukaan tanah sama dengan permukaan air laut, sedangkan - 100 Meter 

berarti ketinggian permukaan tanah 100 Meter di bawah permukaan laut. 

Terdapat jarak yang sama 10 0C dengan 40 0C adalah 30 0C atau jarak antara 

20 Meter dengan 100 Meter dari permukaan tanah adalah 80 Meter. 

4. Data Rasio 

Data yang mencakup semua unsur dimana nilai 0 memiliki arti. 

Contohnya, data berat badan, tinggi, tingkat pendapatan. Jadi jika 

pendapatannya 0 rupian berarti tidak memiliki pendapatan. Pada kasus 

tertentu dapat saja data rasio dirubah menjadi data ordinal, misalnya data 

berat badan, dibawah 25 kg (diberi skor 1) diantara 25 – 100 kg (diberi skor 

2) dan lebih dari 100 kg (diberi skor 3). 

Berdasarkan waktu data dibagi menjadi tiga yairu data time seris (urut 

waktu), cross section (silang tempat), dan pooling (data gabungan). Data time 

seris adalah data pada suatu obyek dengan beberapa urutan waktu. Data cros 

section adalah data beberapa obyek dalam satu waktu, sedangkan polling 

adalah penggabungan data time seris dan cros section.  

Contoh: 
 

Time Seris Cross Section Pooling 

Perus

ahaan 
Tahun 

Laba 

(Juta) 

Perus

ahaan 
Tahun 

Laba 

(Juta) 

Perusah

aan 
Tahun 

Laba 

(Juta) 

A 2000 2 A 2000 2 A 2000 2 

 2001 3 B 2000 7  2001 3 

 2002 4 C 2000 3 B 2000 7 
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 2005 7 D 2000 10  2001 7 

 2006 9 E 2000 9 C 2000 3 

 2007 7 F 2000 6  2001 9 
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BAB III  

ANALISIS DATA MENGGUNAKAN  

PROGRAM SPSS 
 

 

 

 

 

 

 

 

A. PENGENALAN PROGRAM SPSS 
SPSS adalah singkatan dari Statistical Package for Social Science. Software 

SPSS digunakan untuk melakukan analisis data seperti statistic deskriptif atau 

inferensial, paramterik atau non parametrih, atau univariat, bivariat atau 

multivariat yang berbasis windows. Software SPSS telah menucul dengan 

berbagai versi, pada buku ini akan digunakan versi 20 yang lisensinya dari 

Software SPSS dimiliki oleh IBM. 

 

  



Bab III Analisis Data Menggunakan Program SPSS 13 

B. MEMUNCULKAN LAYAR SPSS 
Sebelum melakukan analisis terhadap berbagai data, perlu memasukan 

(input) data ke dalam program SPSS. Pada IBM SPSS versi 20 (SPSS 20) maka 

ada beberapa hal yang harus dilakukan sebagai berikut: 

1. Buka program SPSS 20, maka akan muncul Kotak Dialog seperti berikut: 

 

2. Kotak dialog muncul untuk memudahkan user (pengguna) dalam memilih 

proses selanjutnya. Namun untuk alasan kepraktisan, abaikan kotak 

dialog dengan menekan Cencel atau aktifkan  Don’t show this dialog in 

the future lalu tekan OK, maka kontak dialog tersebut tidak akan muncul 

lagi. 
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3. Setelah tidak mengaktifkan kotak dialog atau menekan Cencel maka akan 

muncul tampak layar SPSS seperti berikut: 

 
 

4. Pada sisi kiri layar bagian bawah terdapat SPSS Data Editor yang 

mempunyai fungsi berbeda, yaitu (1) VARIABEL VIEW yaitu tempat 

memberikan “identitas” variabel dan (2) DATA VIEW yaitu tempat 

menginput data1. 

                                                           
1
 Variabel adalah nama dari sekumpulan data. Jadi data adalah isi dari variabel. Jika variabel 

berjumlah satu maka data dapat dapat berjumlah lebih dari satu. Misalnya variabel LABA 
PERUSAHAAN maka didalamnya berisi data laba perusahaan A 2 Juta, laba perusahaan B, 3 Juta 
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C. MEMASUKKAN DATA 
1. Pertama yang kita lakukan adalah membuka Variabel View untuk 

memberikan identitas pada data. Identitas yang perlu diberikan kepada 

data adalah: 

 
a. Name 

Name digunakan untuk memberikan nama dari variabel. Untuk 

memberikan nama maka klik ganda pada sel tersebut lalu ketik nama dari 

variabel yang diinginkan lalu tekan Enter. Jika nama dari variabel lebih 

dari satu kata maka gunakan tanda underline (_) sebagai penghubung. 

Contohnya, Nama_Pengusaha atau Jumlah_Pegawai_Perusahaan. Namun 

ada pula yang cukup mengisi name dengan symbol, misalnya X1, X2, Y 

atau dapat pula JK, ktg_umur, pddkn dan lainnya. 

                                                                                                                                                    
dan seterusnya. Contoh lain, variabel JENIS KELAMIN maka didalmnya berisi data Pria dan/atau 
Wanita. 
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b. Type 

Tipe data dari variabel yang digunakan. Untuk mengetahui tipe data maka 

klik pada ujung di dalam sel ( ). 

  
maka akan muncul: 
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Pilih tipe datanya, misalnya  lalu klik OK. Tipe data yang 

umumnya digunakan hanya dua yaitu Numeric dan String. Jika data 

berupa angka maka digunakan tipe numeric dan jika berupa huruf (non 

angka) maka digunakan string, sedangkan tipe data yang lain dapat 

diabaikan. 

c. Width 

Untuk memberikan batasan jumlah karakter yang digunakan. Untuk 

keseragaman dapat menggunakan 8 karakter. 

 
d. Decimals 

Jika tipe data yang digunakan adalah string maka otomatis, decimal akan 

menghilang. Namun, jika yang digunakan adalah numeric maka pilihan 

decimal akan muncul. Misalnya data yang digunakan adalah data 

pengalaman kerja selama 3,5 tahun yang berarti ada 1 angka dibelakang 

koma (decimal). Dapat langsung diisi pada kotak variabel type atau pada 

sel decimal: 

 
 

e. Label 

Label adalah keterangan rinci yang diberikan kepada variabel. Misalnya 

pada pada kolom Name di beri keterangan nama maka pada label dirinci 
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keterangan variabelnya dengan diisi Nama Pegawai Perusahaan XYZ, atau 

symbol Y maka pada label dirinci keteranganya dengan diisi Tingkat 

Produktifitas Pegawai Perusahaan XYZ. 

 
f. Value 

Jika data yang dianalisis jenisnya adalah nominal dan ordinal maka perlu 

diisi valuenya. Misalnya data nominal pada variabel jenis kelamin, maka 

cara mengisinya tentukan nilai dari jenis kelamin (1. Pria dan 2. Wanita). 

Klik kolom value pada ujung sel jenis kelamin 

 
Maka akan muncul kotak value labels lalu isi value (nilai) dan label 

keterangannya. Misalnya value 1 dan label-nya Pria, lalu klik add untuk 

memasukan value dan label ke dalam kotak input dan lakukan pengisian 

sampai seluruh keterangan value label terisi. Jika sudah terisi maka 

selanjutnya klik OK. 

 
Jika ingin menghilangkan Value atau Label, caranya tempatkan krusor 

pada kotak input (misalnya, keterangan 2,00 = “Wanita”)  lalu klik Remove 

maka keterangan 2,00 = “Wanita” akan hilang.  
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Untuk merubah (Change) Value atau Label, caranya tempatkan krusor 

pada kotak input (misalnya, keterangan 2,00 = “Wanita”) lalu arahkan 

krusor pada bagian yang akan diganti (Value atau Label), misalnya 

“Wanita” diganti “Pria” lalu klik change, jika semua sudah diganti sesuai 

keinginan maka klik OK. 

 
 

g. Missing 

Untuk memberikan informasi terkait adanya data yang hilang atau tidak 

ada dalam inputan. Data dianggap terinput sehingga pada bagian ini 

diabaikan, dengan posisi None 

 
 

h. Column 

Fungsi Column menyerupai dengan fungsi width, untuk menyediakan 

lebar kolom yang diperlukan. Untuk keseragaman maka samakan nilai 

column dengan nilai width. 
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i. Algn 

Berfungsi untuk menentukan posisi data, apakah sebelah kanan, kiri, atau 

ditengah sel. 

 
j. Measure 

Ada tiga tipe variabel yaitu scale, ordinal dan nominal. Untuk 

memudahkan pengisian, jika type data adalah string maka measurenya 

adalah nominal dan jika type data adalah numeric maka measurenya 

adalah scale. 

 
k. Role 

Tetap pada posisi input. 
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2. Setelah data telah diberi identitas pada variabel view maka tahap 

selanjutnya adalah memasukan data di data view. Caranya sebagai 

berikut: 

a. Untuk memasukan data, buka data di exel terlebih dahulu yaitu pada file 

Data Deskripsi.excel. 

 
b. Blok data pada table yang berwarna kuning, hanya yang akan diinput lalu 

klik Copy seperti berikut: 
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c. Buka SPSS, beri identitas data dengan mengisi variabel view. 

 
d. Jika variabel view sudah terisi maka tahap selanjutnya mengisi Data View, 

dengan menempatkan krusor pada sel kanan paling atas, lalu klik Paste 

  

Jika ingin lebih mudah, dapat langsung membuka file Data Statistik 

Deskripsi.sav. 

D. MENAMBAH DAN MENGHAPUS VARIABEL 
1. Jika ada variabel yang ingin ditambahkan maka dapat langsung mengisi 

pada baris bagian bawah. 
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Namun jika ingin manambah variabel diantara variabel yang tersedia 

maka caranya, letakan krusor pada kolom nomor pada baris yang 

inginkan, misalnya ingin manabah variabel setelah JK, maka tempatkan 

krusor di bawah JK yaitu pada nomor 3 ktg_umur seperti berikut: 

 

Lalu klik kanan (pada mouse) lalu klik insert variable 
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Akan muncul  

 

Lalu isi sesuai dengan identitas pada variabel yang diinginkan misalnya 

luas pabrik. 

 

2. Untuk menghapus variabel, cukup dengan memblok variabel yang ingin 

dihapus, lalu klik kanan, pilih clear, maka variabel akan hilang. 

 
 

Statistik deskriptif adalah bagian dari statistik yang berkaitan dengan 

pengumpulan suatu data yang bertujuan untuk mendeskripsikan data lalu 

disajikan baik secara numeric (distribusi frekuensi, nilai sentral, 

penyimpangan data, ukuran penempatan dan distribusi data) maupun grafis 

(grafik, table atau diagram) agar lebih mudah dibaca dan disimpulkan. Namun 

penarikan kesimpulan hanya terbatas pada data yang diolah. 

Pada IBM SPSS versi 19 (SPSS 19) untuk analisis yang terkait dengan 

statatistik Deskriptif dapat menggunakan Deskriptive Statistik yang 
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didalamnya mencakup beberapa bagian analisis seperti Frequencies, 

Descriptives, Explore, Crosstabs, Ratio, P-P Plot dan Q-Q Plot seperti gambar 

berikut: 

 

 

E. FREQUNCIES 
Frequncies mencakup analisis distribusi frekuensi, nilai sentral, ukuran 

penyimpangan, ukuran penempatan dan distribusi data. 

1. Frequncies 

Distribusi frekuensi adalah penyajian data dalam bentuk kelas/kategori 

yang telah ditetapkan. Misalnya data jenis kelamin dibagi menjadi dua 

kelas/kategori yaitu 1) pria dan 2) wanita. Jadi saat menginput data, user 

sudah membagi kelas/kategori terlebih dahulu. 

2. Central Tendency 

Ukuran sentral mencakup ukuran data yang dapat mewakili keseluruhan 

data (sum). Jadi ukuran sentral akan menghasilkan data tunggal yang 

dianggap sebagai wakil keseluruhan data. Ukuran yang dapat digunakan yaitu 

nilai rata-rata (mean), nilai tengah (median) dan nilai yang sering 

muncul/modus (mode). 
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3. Dispersion 

Ukuran penyimpangan mencakup pengukuran nilai-nilai data yang 

menyimpang dari ukuran centralnya. Jadi dengan pengukuran penyimpangan 

akan diketahui banyaknya atau seberapa jauh nilai pada data yang berbeda 

dengan nilai centralnya. Ukuran yang dapat digunakan yaitu:  

a. Rentangan (range) antara nilai terkecil (Minimum) dan nilai terbesar dari 

sebuah data,  

b. Simpangan baku (standar deviation) yaitu nilai yang menunjukkan besar 

simpangan rata-rata keseluruhan nilai yang ada dalam suatu data dengan 

nilai pusatnya/mean dengan cara menghilangkan kemungkinan memiliki 

nilai nol dengan dikuadratkan. 

c. Varians (variance) yaitu nilai yang menggambarkan pencaran suatu data. 

Variasi adalah kuadrat dari standar deviasi. Varians diberi simbol  σ2 

(baca: sigma kuadrat) untuk populasi dan untuk s2 sampel. 

d. Standar Error Mean yaitu nilai yang mengukur ketepatan nilai mean atau 

dengan kata lain mengukur seberapa dekat nilai mean. Standar error 

mean adalah akar dari nilai variance yang sudah dibagi dengan n (jumlah 

data) 

 

4. Percentile Value 

Ukuran penempatan mencakup pengukuran kuartil, desil dan percentile.  

a. Kuartil 

Kuartil adalah suatu nilai yang dibagi menjadi empat bagian yang sama 

setelah data disusun dari yang terkecil ke yang terbesar. Jadi data dibagi 

pada kelompok masing-masing 25% sehingga suatu kelompok data akan 

hanya mempunyai 3 buah kuartil yaitu: Kuartil Bawah (Q1), Kuartil 

Tengah (Q2) dan Kuatil Atas (Q3). 

b. Desil  

Desil adalah titik atau skor atau nilai yang membagi seluruh distribusi 

frekuensi dan data yang kita selidiki ke dalam 10 bagian yang sama besar. 

Jika kuartil data dibagi dibagi 4 sama besar maka desil membagi data 

pada 10 bagian yang sama sehingga diperoleh 9 bagian yaitu Desil1 

sampai Desil9. 

c. Persentil  

Persentil adalah titik atau nilai yang membagi distribusi data menjadi 

seratus bagian yang sama besar, karena itu persentil sering disebut 

“ukuran perseratusan”. Jika desil data dibagi dibagi 10 sama besar maka 
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persentil membagi data pada 100 bagian yang sama sehingga diperoleh 

99 bagian yaitu Persentil1 sampai Persentil99. 

5. Distribution 

Distribusi data dapat dilihat dari nilai Skewness dan Kurtosis. Jadi nilai 

Skewness dan Kurtosis digunkan untuk mengetahui data berdistribusi normal 

atau tidak. 

a. Skewness (Kemiringan) 

Skewness menunjukan miring atau tidaknya bentuk kurva suatu 

distribusi frekuensi. Sebuah distribusi yang tidak simetris akan memiliki 

rata-rata, median, dan modus yang tidak sama besarnya sehingga 

distribusi akan terkonsentrasi pada salah satu sisi dan kurvanya akan 

menceng. Jika kurva frekuensi suatu distribusi memiliki ekor yang lebih 

memanjang ke kanan (dilihat dari meannya) maka dikatakan menceng 

kanan (positif) dan jika sebaliknya maka menceng kiri (negatif). 

b. Kurtosis (Keruncingan) 

Kurtosis menunjukan runcing atau tidaknya bentuk kurva suatu 

distribusi frekuensi. Jadi, ukuran keruncingan distribusi data adalah 

derajat atau ukuran tinggi rendahnya puncak suatu distribusi data 

terhadap distribusi normalnya data. Kurva yang lebih lebih runcing dari 

distribusi normal dinamakan leptokurtik, yang lebih datar platikurtik dan 

distribusi normal disebut mesokurtik. 

 

F. CONTOH KASUS APLIKASI FREQUNCIES 
Pemerintah daerah di Kabupaten XYZ melakukan survey terhadap 100 

pengusaha di 5 kecamatan. Berdasarkan hasil survei diperoleh data jenis 

kelamin dan lama waktu menjadi pengusaha. Data hasil survei akan diolah 

untuk mendapatkan informasi tentang distribusi frekunsi, ukuran pemusatan, 

ukuran penempatan, ukuran penyimpangan dan distribusi datanya.    

Berikut aplikasi mengolah data menggunakan Frequncies: 

1. Buka file SPSS dengan nama Frequncies.sav 
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2. Klik analyze, lalu Descriptive Statistik, lalu Frequncies 
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3. Maka akan muncul 

 
4. Masuk variabel yang akan dianalisis ke dalam kotak Variable(s) dengan 

mengarahkan krusor pada variabel, misalnya Jenis Kelamin  

lalu klik   
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Maka akan menjadi seperti ini: 

 
Jika ingin mengeluarkan variabel yang dianalisis maka arahkan krosur di 

kotak Variable(s) misalnya Jenis Kelamin  lalu klik  maka 

akan menjadi seperti ini: 
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5. Kembali lagi, masukan variabel yang dianalisis, misalnya jenis kelamin 

dan kategori pengalaman, lalu pastikan display frekuency tables2 aktif (

) maka hasilnya seperti ini: 

 
 

6. Klik statistic maka akan muncul kotak Frequencies: Statistics seperti ini: 

 
  

                                                           
2
 Display frekuency tables digunakan untuk melakukan analisis frekuensi pada variabel. Jika 

tidak ingin menghitung frekuensi maka non aktifkan display frekuency tables. 
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7. Klik  pada item yang ingin dianlaisis misalnya seluruh item akan 

dianalisis maka aktifkan seluruhnya lalu klik  seperti berikut: 

 
8. Maka akan muncul kembali kotak Frequencies 
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9. Untuk gambar, maka klik Chart seperti ini: 

 
10. Maka akan muncul 

 
11. Pilih gambar yang ingin ditampilkan, misalnya dalam bentuk Pie charts, 

maka aktifkan Pie charts dan pilih juga data yang dianalisis, apakah 

Frequencies atau percentages, misal percentages maka aktifkan lalu klik 

Contineu Maka akan muncul 
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12. Maka akan muncul kembali lalu klik OK ( ) 

 
13. Maka hasilnya seperti ini: 
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14. Interpertasi 

a. Jenis Kelamin 

1. Pada table statistics diketahui N adalah jumlah data yang 

dianalisis yaitu sebanyak 20 data (pengusaha) pada variabel 

jenis kelamin. Valid bernilai 20 artinya sebanyak 20 data 

(pengusaha) pada jenis kelamin teranalisis/dihitung. Missing 

sama dengan 0 artinya tidak ada yang tidak 

teranalisis/terhitung. 

2. Pada variabel jenis kelamin, data yang diolah adalah data 

nomian jadi untuk perhitungan nilai sentral, ukuran 

penempatan, ukuran penyimpangan, distribusi data, tidak dapat 

digunakan atau diabaikan. Salah satu ciri data nominal atau 

ordinal adalah tidak dapat dimatematiskan, misalnya 1 adalah 

wanita dan 0 adalah pria, jika mean atau nilai rata-ratanya 1,25 

maka menjadi tidak jelas masuk dalam ketegori apa. Jadi jika 

data yang diolah adalah data nominal dan ordinal maka 

perhitungan nilai sentral, ukuran penempatan, ukuran 

penyimpangan, distribusi data, tidak dapat diinterpertasikan. 

3. Pada Frequency Table Jenis Kelamin, diketahui bahwa jumlah 

pengusaha ada 20 dimana 75 persen atau 15 pengusaha berjenis 

kelamin pria sedangkan sisanya 25 persen atau 5 pengusaha 

berjenis kelamin wanita. Valid percent dalah jumlah persentase 

yang teranalisis. Antara nilai Percent dengan Valid percent sama 

sema artinya seluruh data teranalisis, itu sebabnya nilai nilai 

missing-nya bernilai 0. Untuk Cumulative percent adalah 

akumulasi dari setiap persen yang terhitung, misalnya pria, 

cumulative percentnya 75 persen lalu pada wanita 100 persen 

(gabungan/akumulasi dari 75 persen pada pria dan 25 persen 

pada wanita). 

 

b. Pengalaman Kerja 

1. Pada table statistics diketahui N adalah jumlah data yang 

dianalisis yaitu sebanyak 20 data (pengusaha) pada variabel 

pengalaman kerja. Valid bernilai 20 artinya sebanyak 20 data 

(pengusaha) pada jenis kelamin teranalisis/dihitung. Missing 

sama dengan 0 artinya tidak ada yang tidak 

teranalisis/terhitung. 
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2. Titik Sentral 

Pada variabel pengalaman kerja, data yang digunakan adalah 

data rasio sehingga perhitungan mean, median, mode dan sum 

dapat diiterpertasikan. Mean atau nilai rata-rata sebesar 13,15 

(263 : 20) yang diperoleh dari jumlah nilai pengalaman setiap 

pengusaha (sum) dibagi dengan jumlah data/pengusaha (N). 

Artinya seluruh pengusaha memiliki rata-rata pengalaman kerja 

selama 13,15 tahun. Median atau nilai tengah sebesar 12 tahun. 

Mode atau nilai yang sering muncul adalah 12 tahun. 

3. Ukuran penyimpangan 

Pada variabel pengalaman kerja, data yang digunakan adalah 

data rasio sehingga perhitungan Standar error of Mean, Standar 

Deviation, Variance, Range, Minimum dan Maximum dapat 

diinterpertasikan.  

a. Standar Error of Mean  

Standar error of mean sebesar 1,847 dimana, rumus untuk 

menghitung adalah sebagai berikut: 

847,1
20

258,8

DataJumlah 

Deviation Standard
 Mean  SE 

  

Nilai 1,847 menunjukan kedekatan dengan mean. Untuk 

mengetahui kedekatannya maka cara menghitungnya adalah 

dengan menggunakan rumus sebagai berikut: 

Mean ± (t hitung x standar error of mean) 

Dimana: 

t hitung diperoleh dari angka t table atau z table. Jika jumlah 

sampel < 30 maka digunakan t table dan jika sampel ≥ 30 maka 

mengunakan z table dengan tingkat kepercayaan, misalnya 95% 

dan tingkat error 5%. Pada kasus ini, data yang digunakan 20 

maka menggunakan t table dengan tingkat kepercayaan 95% 

dengan df = 20-1 =19 adalah 2,05. Jadi dapat diperoleh hasil 

sebagai berikut: 

13,15 tahun ± (2,05 x 1,847 tahun) = 9,36 sampai 16,93 tahun.  

Artinya dengan rata-rata pengalaman kerja pengusaha adalah 

13,15 tahun, dapat diperkirakan seluruh pengusaha pengalaman 
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kerjanya ada di antara 9,36 sampai 16,93 tahun dengan tingkat 

kepercayaan 95% dan tingket error 5%. Maksudnya jika diambil 

100 pengusaha dan semua diukur maka akan ada 95% (95% x 

100 = 95 pengusaha) pengusaha yang pengalaman kerjanya 9,36 

sampai 16,93 tahun sedangkan sisanya 5% (5% x 100 = 5 

pengusaha) pengusaha kemungkinan mempunyai pengalaman 

kerja dibawah atau diatas 9,36 sampai 16,93 tahun. 

b. Standar Deviation  

Standar deviation sebesar 8,258 tahun artinya tingkat rata-rata 

penyimpangan data terhadap meannya adalah sebesar 8,258 

tahun. Jika nilai standar deviasi jauh lebih besar dibandingkan 

nilai mean, maka nilai mean merupakan representasi yang buruk 

dari keseluruhan data. Sedangkan jika nilai standar deviasi 

sangat kecil dibandingkan nilai mean, maka nilai mean dapat 

digunakan sebagai representasi dari keseluruhan data. Karena 

nilai mean (13,15) > standar deviasi (8,258) menunjukan nilai 

mean dapat digunakan sebagai representasi dari keseluruhan 

data. 

c. Variance  

Variance atau varians sebesar 68,199 tahun yang diperoleh dari 

kuadrat dari standar deviasi. 

d. Range, Maximum dan Minimum 

Range adalah selisih nilai maksimum dan nilai minimum. 

Diketahui nilai maksimum (nilai data terbesar) sebesar 30 dan 

nilai minimum (nilai data terkecil) sebesar 2, selisihnya sebesar 

28. 

4. Distribusi Data 

Distribusi data dapat dilihat dari nilai skewness dan Kurtosis 

sebagai berikut: 

a. Skewness 

Nilai skewnessnya sebesar 0,598 dengan standar error of 

skewness sebesar 0,512. Lalu dicari nilai rasio skewnessnya 

dengan rumus sebagai berikut: 

Rasio skewness = 167,1
512,0

598,0


ss of SkewneStd. Error

Skewness
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Sebagai pedoman, jika nilai rasio skewness diantara -2 dan 2 

maka data berdistribusi normal. Rasio skewness adalah 1,167 

yang berarti diantara -2 dan 2 maka dapat diinterpertasikan 

data berdistribusi normal. 

b. Kurtosis 

Nilai kurtosisnya sebesar -0,127 dengan standar error of 

skewness sebesar 0,992. Lalu dicari nilai rasio kurtosisnya 

dengan rumus sebagai berikut: 

Rasio kurtosis = 128,0
992,0

127,0





is of KurtosStd. Error

Kurtosis
 

Sebagai pedoman, jika nilai rasio skewness diantara -2 dan 2 

maka data berdistribusi normal. Rasio skewness adalah -0,128 

yang berarti diantara -2 dan 2 maka dapat diinterpertasikan 

data berdistribusi normal 

5. Ukuran penempatan dapat dilihat dari kuartil, desil atau 

persentil. 

Untuk interpertasinya sebagai berikut: 

a. Ada 10 persen pengusaha yang mempunyai pengalaman kerja 

dibawah 2,13 tahun. 

b. Ada 20 persen pengusaha yang mempunyai pengalaman kerja 

dibawah 4,80 tahun.  

c. Ada 30 persen pengusaha yang mempunyai pengalaman kerja 

dibawah 8,21 tahun.  

d. Ada 40 persen pengusaha yang mempunyai pengalaman kerja 

dibawah 9,60 tahun.  

e. Ada 50 persen pengusaha yang mempunyai pengalaman kerja 

dibawah 12  tahun.  

f. Ada 60 persen pengusaha yang mempunyai pengalaman kerja 

dibawah 14,28 tahun.  

g. Ada 70 persen pengusaha yang mempunyai pengalaman kerja 

dibawah 18,26 tahun. 

h. Ada 80 persen pengusaha yang mempunyai pengalaman kerja 

dibawah 19,80 tahun.  

i. Ada 90 persen pengusaha yang mempunyai pengalaman kerja 

dibawah 20,06 tahun.  
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6. Distribusi Frekuensi 

Pada variabel pengalaman kerja, data yang dianalisis tidak di 

kategorikan, misalnya 1) 0 – <10 Tahun, 2) 10 - <20 3) 20 -<30 

Tahun 4) >30 Tahun untuk memudahkan analisis seperti pada 

variabel jenis kelamin. Namun secara singkat dapat diketahui 

bahwa pada baris pertama table diketahui ada 1 pengusaha atau 

5 persen pengusaha yang memiliki pengalaman 2 tahun lalu 

pada baris kedua ada 1 pengusaha atau 5 persen pengusaha 

yang memiliki pengalaman 2 tahun sehingga kumulatif persen 

sebesar 10 persen dan seterusnya. 

 

G. DESKRIPTIVES 
1. Deskripsi 

Deskriptives mencakup analisis yang termuat di Frequncies seperti 

perhitungan nilai sentral dan ukuran penyimpangan. Namun pada bagian ini 

terdapat menu analisis yang tidak dimiliki Frequncies yaitu angka baku/nilai 

standar/Z score. Angka baku adalah angka yang menunjukan tingkat 

penyimpangan data dari nilai rata-ratanya dalam satuan standar deviasi.  

2. Angka Baku 

Angka baku digunakan untuk membandingkan suatu perubahan data atau 

membandingankan data dengan satuan yang berbeda, misalnya Rupiah 

dengan Kilogram. Rumusnya: 

Zscore = 
s

X 
     

Dimana 

Zscore = Angka Baku 

X      = nilai dari data 

µ      = nilai rata-rata/mean 

s       = Standar deviasi 

Jika nilai Z score positif maka nilainya diatas rata-rata, jika Z score nol 

maka nilainya sama dengan rata-rata dan jika nilai Z score negatif maka 

nilainya dibawah rata-rata. 

Berikut 2 contoh aplikasi penggunaan angka baku sebagai berikut: 

a. Diketahui terdapat 5 perusahaan dengan tingkat produksi dan rata-rata 

produksi sebagai berikut: 

Perusahaan A: Tingkat produksi = 85; mean = 70 dengan standar deviasi 

= 5. 
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Perusahaan B: Tingkat produksi = 95; mean = 75 dengan standar deviasi 

= 4. 

Perusahaan C: Tingkat produksi = 85; mean = 80 dengan standar deviasi = 

5. 

Perusahaan D: Tingkat produksi = 95; mean = 70 dengan standar deviasi 

= 10. 

Perusahaan E: Tingkat produksi = 100; mean = 85 dengan standar deviasi 

= 5. 

Jawaban:  

Z score perusahaan A = 2
5

7080



 

Z score perusahaan B = 5
4

7595



 

Z score perusahaan C = 1
5

8085




 

Z score perusahaan D = 2
10

7090



 

Z score perusahaan E = 3
5

85100



 

Jika dilihat dilihat dari besar tingat produksinya maka perusahaan D yang 

paling baik drajadtnya yaitu 100 jika dibandingkan dengan perusahaan 

lain. Namun jika dinilai secara relative dibandingkan dengan rata-ratanya 

maka perlu dilihat dari angka bakunya. Berdasarkan hasil perhitungan Z 

score diperoleh hasil bahwa kedudukan perusahaan B lebih baik dari 

perusahaan E. 

b. Diketahui ada dua pedagang di Pasar Malam yaitu Bang Udin dan Bang 

Amir. Bang Udin berdagang buah memiliki penghasilan rata-rata Rp 

25.000,00/hari dengan standar deviasi Rp 500,00. Sedangkan Bang Amir 

berdagang sayur memiliki rata-rata penghasilan Rp 50.000,00/hari 

dengan standar deviasi Rp 2.500,00/hari. Ketika ada acara festival dan 

bazaar di Pasar Malam, Bang Undi mampu meningkatkan penjualannya 

menjadi Rp 75.000,00 dan Bang Amir menjadi Rp 100.000,00. 

Pertanyaanya: Pedagang manakah yang lebih baik dalam meningkatkan 

penjulannya: 

Bang Udin = 00100
00500

0000250000075
,Rp 

,Rp 

,.Rp ,.Rp 



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Bang Amir = 0020
005002

000005000000100
,Rp 

,.Rp 

,.Rp ,.Rp 




 

Berdasarkan analisis diperoleh hasil bahwa Bang Udin lebih berhasil 

menaikan volume penjualannya dengan angka baku sebesar Rp 100,00. 

 

H. CONTOH KASUS APLIKASI DESCRIPTIVES 
Pemerintah daerah di Kabupaten XYZ melakukan survey terhadap 100 

pengusaha di 5 kecamatan. Berdasarkan hasil survei diperoleh data jenis 

kelamin dan lama waktu menjadi pengusaha. Data hasil survei akan diolah 

untuk mendapatkan informasi tentang ukuran pemusatan, ukuran 

penyimpangan dan angka baku data.    

Berikut aplikasi mengolah data menggunakan Descriptives: 

1. Buka file SPSS dengan nama Descriptives.sav 
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2. Klik analyze, lalu Descriptive Statistik, lalu Descriptives 

 
3. Maka akan muncul Kotak Descriptives 
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4. Masuk variabel yang akan dianalisis yaitu Laba Perusahaan, lalu klik 

Options 

 
5. Maka akan muncul kotak Desciptives: Options 
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6. Aktifkan menu yang dianalisis, misalnya seluruhnya dianalisis, lalu klik 

Continue 

 
7. Maka akan muncul kembali kotak Descriptives 
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8. Jika menginginkan terhitung nilai Z Score dari Laba Perusahaan maka 

aktifkan   Save standardized values as variables lalu klik OK 

 
9. Maka akan muncul out put seperti berikut: 

 
10. Sedangkan untuk Input Data akan muncul nilai Z Score dari Laba 

Perusahaan 
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11. Interpertasi 

Pada variabel laba perusahaan (satuan juta), data yang digunakan adalah 

data rasio sehingga seluruh perhitungan nilai sentral, penyimpangan dan 

distribusi data dapat diiterpertasikan.  

c. Ukuran Pemusatan 

Jumlah data (N) yang dianalisis sebanyak 100 dimana tidak ada yang 

tidak teranalisis (Valid N = 100). Range adalah selisih nilai maximum 

dan nilai minimum. Diketahui nilai maximum (nilai data terbesar) 

sebesar 67,99 dan nilai minimum (nilai data terkecil) sebesar 2,72 

selisihnya sebesar 65,27. Mean atau nilai rata-rata sebesar 33,8961 

(2289,61 : 100) yang diperoleh dari jumlah nilai laba perusahaan 

(sum) dibagi dengan jumlah data/laba perusahaan (N). Artinya 

seluruh perusahaan memiliki rata-rata laba sebesar 33,8961.  

d. Ukuran Penyimpangan 

Standar deviation sebesar 19,63087 artinya tingkat rata-rata 

penyimpangan data terhadap meannya adalah sebesar 19,63087. 

Karena nilai mean (33,8961) < standar deviasi (19,63087) 

menunjukan nilai mean dapat digunakan sebagai representasi dari 

keseluruhan data. Variance atau varians sebesar 68,199 tahun yang 

diperoleh dari kuadrat dari standar deviasi yang menggambarkan 

keseragaman datanya. Standar error of mean sebesar 1,96309. Nilai 

1,96309 menunjukan kedekatan dengan mean. 

e. Distribusi Data 

Nilai skewnessnya sebesar -0,230 dengan standar error of skewness 

sebesar 0,241. Hasil perbandingan nilai skewness dengan standar 

error of skewness sebesar -0,954. Nilai kurtosisnya sebesar -0,127 

dengan standar error of skewness sebesar 0,992. Hasil perbandingan 

nilai kurtosis dengan standar error of kurtosis sebesar -0,128. 

Berdasarkan hasil perbadingan baik skewness maupun kurtosis 

berada diantara -2 dan 2 maka dapat diinterpertasikan data 

berdistribusi normal. 

 

I. KONSEP REGRESI 
Pada analisis korelasi dapat diketahui tingkat keeratan hubungan antara 

variabel namun tidak dapat diestimasi secara kuantitatif, berapa dampak 

perubahannya terhadap variabel yang lain. Sedangkan, analisis regresi dapat 

digunakan untuk mengetahui estimasi secara kuantitatif, berapa perubahan 

variabel yang satu terhadap variabel yang lain. Misalnya jika variabel promosi 
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meningkat satu juta maka akan meningkatkan volume penjualan sebesar satu 

unit. 

Analisis regresi adalah bentuk hubungan antara variabel independen 

terhadap variabel dependen yang persamaannya adalah Y = f(X). Artinya 

dapat diestimasi nilai variabel dependen (Y) jika diketahui nilai variabel 

dependen (X) beserta perubahannya. Bentuk hubungan ini harus sesuai 

dengan fenomena yang dikaji atau didasarkan teori. Jika variabel independen 

yang dikaji berjumlah satu maka disebut analisis regresi sederhana, dan jika 

lebih dari satu disebut analisis regresi berganda. 

Model regresi liner sederhana dan liner berganda dapat ditulis sebagai 

berikut: 

Yi = α + βXi + ei ; i = 1, 2, 3, …n. dimana n adalah banyaknya data yang 

diobservasi 

Analisis regresi dapat digunakan untuk mengetahui estimasi secara 

kuantitatif perubahan variabel yang satu (misal X) terhadap variabel yang lain 

(misal Y). Tentu saja, yang kita inginkan adalah nilai estmiasi mendekati nilai 

observasinya (rillnya). Untuk itu, perlu dicari nilai α dan β agar garis 

persamaan (Yi = α + βXi) terletak pada semua observasi. Namun dalam 

realitasnya tidak mungkin seratus persen nilai estimasi sama dengan 

observasi (y). Jadi upaya terbaiknya adalah bagaimana meminimalkan jarak 

(deviasi) antara nilai observasi (y) dengan estimasi (Ŷ). Atau dengan kata lain, 

model yang dihasilkan memiliki nilai error (ei) yang minimum, dimana ei = Yi – 

Ŷi = Yi - α + βXi.  Hasil signifikan menunjukan bahwa data estimasi mendekati 

data observasinya atau berada dibawah batas error yang ditetapkan. 

Untuk mencapai nilai error yang minimum maka metode yang dapat 

digunakan adalah metode kuadrat terkecil (Ordinary Last Square/OLS). 

Metode OLS adalah metode yang mencari Σei2 minimum karena nilai ei dapat 

bernilai positif dan negatif maka perlu dikuadratkan sehingga menjadi ei2 = (Yi 

- α + βXi)2. Dari masing-masing ei2 maka akan diperoleh jumlah nilai error (Σ 

ei2). Jadi hasil model yang ditunjukan pada kurva dibawah ini, harus 

mendekati tanda bintang. Berikut gambarannya: 

 

 

 

 

 

 X 

Y 

e * 

* 
* * 

* 

* 
* 
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Dalam suatu penelitian, jarang sekali datanya berupa populasi karena 

menghadapi keterbatasan dan efisiensi. Jadi data yang digunakan bukan data 

populasi tetapi data estimasi. Jika data yang digunakan adalah data popluasi 

maka modelnya disebut population regretion fungtion, sedangkan jika data 

yang digunakan adalah data sempel maka modelnya disebut semple regretion 

function. Lalu pertanyaannya adalah, apakah model semple regretion function 

dapat digeneralisasikan/diberlakukan pada population regretion fungtion. 

Maka jawabannya bisa, jika modelnya valid. 

 

J. APLIKASI ANALISIS REGRESI LINER BERGANDA 
Analisis regresi liner berganda dengan menggunakan metode kuadran 

terkecil (Ordinary Last Square/OLS) akan menghasilkan suatu 

model/persamaan yang akan digunakan untuk melihat hubungan antara 

variabel independen terhadap independen. Model/persamaan dapat 

digunakan untuk mengestimasi hubungan variabel independen terhadap 

independen. Misalnya jika terjadi kenaikan 1 persen terhadap variabel laba 

(independen) akan meningkatkan nilai perusahaan (variabel dependen) 

sebesar 0,02 persen dengan asumsi variabel independen yang lain konstan. 

Namun perlu dilihat, apakah estimasi dari model yang digunakan valid 

(akurat, teliti dan absah) karena jika tidak valid maka model yang digunakan 

tidak dapat dijadikan pegangan/pedoman dalam estimasi variabel. 

Validasi suatu model dapat dilihat dari akurasi model, ketelitian model 

dan keabsahan model. Berikut penjelasannya: 

1. Akurasi Model 

Untuk memastikan model memiliki tingkat akurasi (goodness of fit) yang 

tinggi dapat dilihat dari koefisien determinasinya (R2) yang bernilai dari 0 

– 1. Semakin besar nilai R2 maka semakin akuart model atau semakin 

kecil nilai errornya. Misalnya nilai R2 = 0,90 berarti 90 persen (0,90 x 

100) variasi variabel dependen dapat dijelaskan oleh variabel 

independen sedangkan sisanya 10 persen (100 persen – 90 persen) 

dijelaskan oleh variabel lain. 

2. Ketelitian Model 

Untuk melihat ketelitian model/kelayakan model dapat diketahui dari p-

value (nilai peluang) hasil uji F hitung atau nilai signifikansi F pada 

ANOVA (menguji koefisien regresi keseluruhan) dan p-value (nilai 

peluang) hasil uji t hitung atau nilai signifikan t (menguji koefisien regresi 

per variabel/parsial) pada Coefficients. Misalnya hasil uji F ditemukan p-

value adalah 0,03 dengan batas error 0,05 (0,03 < 0,05) yang berarti 
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signifikan. Artinya hasil dari koefisien regresi keseluruhan variabel 

berupa nilai estimasi mendekati observasinya.  

3. Keabsahan Model 

Keabsahan model dapat diketahui jika asumsi-asumsi yang mendasari 

dari metode OLS dapat dipenuhi. Jika asumsi ini terpenuhi maka menurut 

Teori Gauss-Markov penduga koefisien regresi (β) dengan OLS akan BLUE 

(Best Linear Unbias Estimator). Asumsi ini dikenal dengan asumsi klasik. 

Asumsi itu adalah: 

i. Hubungan antara variabel independen dan denpenden adalah liner 

dalam parameter. 

ii. Variabel gangguan atau residual berdistribusi normal. 

iii. Tidak terjadi multikolinearitas (artinya tidak ada hubungan yang erat 

antar variabel independen, jika analisisnya adalah regresi liner 

berganda) 

iv. Tidak terjadi heterokedaktasitas (artinya variasi nilai error (ei) 

mempuyai variasi yang sama) 

v. Tidak terjadi autokolerasi (artinya tidak ada korelasi antara nilai 

error (ei) variabel satu observasi dengan observasi lainnya) 

Untuk aplikasi sebagai berikut: 

1. Buka data Regresi Liner Berganda.sav 
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2. Klik Analyze -> Regression -> Linear 

 
3. Maka akan muncul kotak Linear Regression 
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4. Isi variabel dependen dan independent sesuai dengan teorinya, lalu klik 

statistics 

 
5. Maka akan muncul kotak Linear Regression: Statistics, lalu aktifkan 

estimates, model fit, descriptive dan collinearity diagnostics, lalu klik 

continue seperti gambar berikut: 
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6. Maka akan muncul kembali kotak Linear Regression, lalu klik OK 

 
7. Maka akan muncul output berikut: 
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8. Interpertasi 

a. Tabel Descriptive Statistics 

Tabel ini menjelaskan tentang nilai rata-rata (mean) dan standar 

deviasi setiap variabel. Jika nilai mean lebih kecil dari standar 

deviasinya menunjukan data pada variabel memiliki tingkat 

penyimpangan yang tinggi atau data-data didalam variabel memiliki 

tingkat penyimpangan yang tinggi terhadap nilai rata-ratanya. 

Diketahui bahwa nilai mean variabel nilai perusahaan sebesar 3,1362 

persen dengan standar deviasi sebesar 3,30663 persen. Artinya 

variabel nilai perusahaan memiliki tingkat penyimpangan yang tinggi. 

 
b. Tabel Correlation 

Tabel ini menjelaskan hubungan antar variabel. Misalnya korelasi 

antara variabel profitabilitas dengan nilai perusahaan adalah 0,372 

dengan nilai signifikansi 0,001. Ini menunjukan bahwa hubungan 

antara variabel profitabilitas dengan nilai perusahaan adalah positif 

signifikan (0,001 < 0,05) dengan tingkat keeratan hubungan dalam 

kategori lemah. Misalnya lagi korelasi antara variabel struktur modal 

dengan ukuran perusahaan adalah -0,081 dengan nilai signifikansi 

0,256. Ini menunjukan bahwa hubungan antara variabel struktur 

modal dengan ukuran perusahaan adalah negative tidak signifikan 

(0,256 < 0,05) dengan tingkat keeratan hubungan dalam kategori 

sangat lemah. 



54 Laboratorium Statistik 

 
c. Tabel Variables Entered/Removed 

Tabel ini menunjukan bahwa dalam analisis menggunakan metode 

enter yang berarti tidak ada variabel yang dikeluarkan/dianalisis. Jadi 

seluruh variabel diperhitungkan dalam analisis regrsi baik yang 

hasilnya signifikan atau tidak. 

 
d. Tabel Model Summery 

Tabel ini menjelaskan akurasi model dengan melihat R (korelasi), R 

square (koefisien determinasi), dan standar error of estimate. Hasil 

menunjukan bahwa nilai R sebesar 0,441 yang berati tingkat keeratan 

hubungan antara variabel nilai perusahaan dengan struktur modal, 

ukuran perusahaan dan profitabilitas adalah sedang. Nilai R square 

sebesar 0,195 hal ini menunjukkan bahwa 19,5% (0,195 x 100%) 

variasi variabel dependen dapat dijelaskan oleh variabel independen, 

sedangkan sisanya 80,5% (100% - 19,5%) dijelaskan oleh variabel 

independen lain yang tidak termasuk dalam model penelitian ini.  

Standar error of the estimate digunakan untuk memberikan informasi 

bagi model penelitian, yang mana lebih baik digunakan sebagai 

predictor. Jika nilai standar error of the estimate < standar deviasi 
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varaibel dependen maka model regresi dapat lebih baik bertindak 

sebagai predictor varaibel depenen dari pada rata-rata variabel 

dependen itu sendiri. Standar error of the estimate sebesar 3,03635 

persen (sesuai dengan satuan variabel dependen) < standar deviasi 

nilai perusahaan sebesar 3,303363 berarti model regresi dapat lebih 

baik bertindak sebagai predictor nilai perusahaan dari pada rata-rata 

nilai perusahaan. 

 
e. Tabel ANOVA 

Dari Uji Anova atau F test didapat nilai F hitung sebesar 5,153 dan 

hasil ini lebih besar daripada F tabel yaitu sebesar 2,75 dengan 

probabilitas 0,003. Karena probabilitas lebih kecil dari 0,05 maka 

model regresi dapat digunakan untuk memprediksi PBV (nilai 

perusahaan) atau dapat dikatakan bahwa model regresi adalah model 

yang baik/layak (Goodness of fit) atau model teliti. 

 
f. Tabel Coefficient 

 
Dari tabel coefficient menghasilkan model penelitian sebagai berikut: 

Y = -0,063 + 0,765 X1 + 0,012 X2 + 0,119 X3 
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Dari data hasil pada tabel 4.8 diperoleh hasil sebagai berikut: 

1. Konstanta 

Konstanta menunjukan hasil -0,063 yang berarti, jika variabel struktur 

modal (X1), ukuran perusahaan (X2), dan profitabilitas (X3) tidak 

diperhitungkan/tidak ada maka nilai perusahaan (Y) akan menurun 

sebesar 0,063 persen. 

2. Pengaruh struktur modal (X1) terhadap nilai perusahan (Y) 

Hasil pengujian menunjukkan nilai variabel struktur modal (X1) 

sebesar 0,765 dengan signifikansi sebesar 0,039 dan <0,05 yang 

berarti bahwa model regresi tersebut signifikan. Nilai variabel 

struktur modal (X1) sebesar 0,765 berarti bahwa setiap kenaikan 1 

miliar hutang dibandingkan dengan modalnya akan meningkatkan 

nilai perusahaan sebesar 0,765 atau 76,5% dengan mengasumsikan 

variabel indenpenden lain konstan. Dengan demikian secara parsial 

struktur modal (X1) berpengaruh positif signifikan terhadap nilai 

perusahaan (Y). 

3. Pengaruh ukuran perusahaan (X2) terhadap nilai perusahaan (Y) 

Hasil pengujian menunjukkan nilai variabel ukuran perusahaan (X2) 

sebesar 0,012 dengan signifikansi sebesar 0,953 dan >0,05 yang 

berarti bahwa model regresi tersebut tidak signifikan. Hasil pengujian 

menunjukan nilai sebesar 0,012 yang berarti bahwa setiap kenaikan 

1% total aset akan menaikkan nilai perusahaan sebesar 0,012 atau 

1,2% dengan mengasumsikan variabel indenpenden lain konstan. 

Dengan demikian secara parsial ukuran perusahaan (X2) berpengaruh 

positif dan tidak signifikan terhadap nilai perusahaan (Y). 

4. Pengaruh profitabilitas (X3) terhadap nilai perusahaan (Y) 

Hasil pengujian menunjukkan nilai variabel profitabilitas (X3) sebesar 

0,119 dengan signifikansi sebesar 0,000 dan <0,05 yang berarti bahwa 

model regresi tersebut signifikan. Nilai variabel profitabilitas (X3) 

sebesar 0,119 yang berarti bahwa setiap kenaikan 1 % profitabilitas 

akan menaikkan nilai perusahaan sebesar 0,119 atau 11,9% dengan 

mengasumsikan variabel indenpenden lain konstan. Dengan demikian 

secara parsial profitabilitas (X3) berpengaruh positif dan signifikan 

terhadap nilai perusahaan (Y). 
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K. UJI ASUMSI KLASIK 
Keabsahan model dapat diketahui jika asumsi-asumsi yang mendasari 

dari metode OLS dapat dipenuhi. Jika asumsi ini terpenuhi maka menurut 

Teori Gauss-Markov penduga koefisien regresi (β) dengan OLS akan BLUE 

(Best Linear Unbias Estimator). Asumsi ini dikenal dengan asumsi klasik. 

Asumsi itu adalah: 

1. Uji Normalitas 

Uji normalitas digunakan untuk mengetahui apakah model regresi 

memiliki variabel residual (error) yang berdistribusi normal. Hal ini karena 

dalam uji t untuk melihat tingkat signifikasi variabel independen terhadap 

variabel dependen tidak dapat diaplikasikan jika residual tidak mempunyai 

distribusi normal. Misalnya model regresi sebagai berikut: 

Ŷ = 2,3 + 1,2X1 

Dimana: 

Ŷ = Penjualan 

X1 = Biaya promosi 

Misalnya berdasarkan data obeservasi diketahui data yang di analisis (N) 

sebanyak 50 data. Jika diketahui salah satu data obeservasi di bulan Maret 

2013 memiliki biaya promosi (X1) sebesar 2 juta dan penjulan (Y) 5 unit maka 

jika dimasukan ke dalam model maka estimasi penjualan (Ŷ) menjadi Ŷ = 2,3 + 

1,2(5) = 8,3 unit. Sedangkan observasinya pada penjualan sebesar (Y) 5 unit. 

Jadi residual adalah selisih nilai estimasi dan observasi sebesar 3,3 unit yang 

diperoleh dari 8,3 – 5 unit. Jadi terdapat 50 data residual, yang ada di di dalam 

model regresi. Tujuan pengujian normalitas adalah untuk melihat apakah 

sebuah model regresi menghasilkan residual berdistribusi normal atau tidak. 

Untuk mengetahui data residual berdistribusi normal atau tidak dapat 

dilakukan uji normalitas. Namun jika ditemukan residual tidak berdistribusi 

normal maka dapat tetap dianggap normal dengan menggunakan dalil limit 

pusat atau teorema limit pusat (central limit theorem). Dalil ini menjadi dasar 

jika ditemukan tidak berdistribusi normal maka dapat dianggap normal asal 

data yang dianalisis berjumlah lebih dari 30 (N > 30).  

Ada beberapa pilihan alat yang dapat digunakan untuk uji normalitas 

seperti analisis grafis (histogram dan normal probability plot) atau analisis 

statistik (nilai skewness dan kurtosis). Namun kedua analisis ini cenderung 

menimbulkan persepsi yang berbeda (pada analisis grafis) dan tidak praktis 

(pada analisis statistik) karena nilainya harus dibandingkan lagi dengan Z-

tabel. Jadi agar tidak menimbulkan perbedaan persepsi dan kepraktisan, maka 
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dapat menggunakan uji normalitas dengan One-Sample Kolmogorov-Smirnov 

Test yang aplikasinya sebagai berikut: 

1. Buka data Uji Normalitas Data.sav 

 
2. Klik Analyze -> Regresi -> Liner  
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3. Maka akan muncul Kotak Liner Regression 

 
4. Isi kotak Dependen dengan variabel depend dengan EV (Y) dan 

independen dengan variabel CR (X1), DER (X2) dan ROA (X3, lalu klik 

Save 
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5. Maka akan muncul kotak Liner Regression: Save, aktifkan Residulal 

Unstandardized, lalu klik Continue, lalu Kotak Liner Regression lalu klik 

OK 

 
6. Selanjutnya, Klik Analyze -> Nonparametric Tests -> Legacy Dialogs -> 1-

Sample K-S  



Bab III Analisis Data Menggunakan Program SPSS 61 

 
7. Maka akan muncul Kotak One-Sample Kolmogorov-Smirnov Test 

 
8. Masukan variabel Unstandardizet Residual yang akan diuji kedalam kotak 

Test Variable List dan aktifkan Test Distribution yang normal ( ) 

lalu klik OK 
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9. Maka akan muncul out put seperti berikut: 

 
10. Interpertasi 

Untuk mengetahui data residual berdistribusi normal maka cukup dengan 

membandingkan nilai Asymp. Sig. (2-tailed) dengan tingkat error yang 

ditetapkan (misalnya 5% atau 0,05). Jika nilai Asymp. Sig. (2-tailed) < 

0,05 maka data residual berdistribusi tidak normal dan jika nilai Asymp. 

Sig. (2-tailed) > 0,05 maka data residual berdistribusi normal. Dapat 

diketahui nilai Asymp. Sig. (2-tailed) Unstandardizet Residual > 0,05 

sehingga data residual berdistribusi normal. 

 

2. Uji Linearitas  

Uji linearitas menjadi asumsi penting dalam regresi liner sederhana 

ataupun berganda. Uji ini untuk memastikan spesifikasi model yang tepat 

untuk digunakan dari data yang akan dianalisis, berbentuk liner, kuadran, 

kubik invers, logaritmik, power, S, compound, growth, logistic atau 

eksponensial. Jadi jika hasil uji menunjukan, misalnya spesifikasi model yang 

tepat untuk digunakan berbentuk kuadran maka tidak dapat dipaksakan 

harus liner.  Uji linearitas adalah syarat yang digunakan sebelum melakukan 

analisis regresi liner. 

Ada beberapa uji yang dapat digunakan untuk melakukan uji lineritas 

data seperti Mean (compare mean), Uji Durbin Watson, Ramsey Test, atau Uji 

Lagrange Multiplier. Namun uji-uji tersebut, cenderung tidak praktis dan 
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membingungkan karena tidak terjawab model apa yang tepat digunakan 

ketika ditemukan model pada data tidak tepat dalam bentuk liner. Jadi alat 

yang praktis dapat digunakan dan memberikan jawaban model apa yang tepat 

digunakan dapat menggunakan curve fit yang aplikasinya sebagai berikut: 

1. Buka data Uji Linearitas Data.sav 
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2. Klik Analyze -> Regression -> Curve Estimation 

 
3. Maka akan muncul kotak Curve Estimation 

 
4. Misalnya ingin mengetahui model yang tepat pada variabel nilai 

perusahaan dan struktur modal maka masukan variabel nilai perusahaan 

di dependen dan struktur di independent lalu aktifkan semua model 

seperti gambar berikut lalu klik OK 
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5. Maka akan muncul out sebagai berikut 

 
6. Interpertasi 

Dari seluruh table output yang dihasilkan, tidak semua table 

diinterpertasikan, cukup table Model Summary and Parameter Estimates 

yang diinterpertasikan. Model mana yang tepat untuk digunakan, apakah 

liner, kuadran, kubik atau lainnya diperoleh dengan membandingkan nilai 

sig. model summary dengan tingkat error yang ditetapkan (misalnya 5% 

atau 0,05). Ada tiga hal yang harus diperhatikan: 

1. Jika hasil sig. pada model summary baris liner menunjukan nilai sig. < 

0,05 maka model yang tepat digunakan adalah liner. Contohnya jika 

hasilnya seperti gambar dibawah ini: 
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2. Jika hasil sig. pada model summary baris liner menunjukan nilai sig. > 

0,05 sedangkan hasil sig. pada model summary baris selain liner 

(Logarithmic, Invers, Quadratic, Cubic, Compound, Power, S, Growth dan 

Exponential) juga nilai sig. > 0,05 maka dapat dikatakan model yang tepat 

digunakan adalah liner. Contohnya jika hasilnya seperti gambar dibawah 

ini: 

 
3. Jika hasil sig. pada model summary baris liner menunjukan nilai sig. > 

0,05 maka model adalah tidak liner jika hasil sig. pada model summary 

baris selain liner (Logarithmic, Invers, Quadratic, Cubic, Compound, 

Power, S, Growth dan Exponential) ada yang nilai sig. < 0,05. Seperti 

contoh gambar berikut: 
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Jadi berdasarkan table ini maka model yang tepat digunakan adalah 

model yang nilai sig. > 0,05, misalnya Logarithmic, Invers, Power dan S 

karena signifikan. 

 

3. Autokorelasi dan Multikolinearitas 

Uji autokolerasi digunakan untuk mengetahui ada atau tidaknya 

hubungan antara residual pada satu pengamatan dengan pengamatan lain 

pada model regresi.  Prasyarat yang harus terpenuhi adalah tidak adanya 

autokorelasi dalam model regresi. Kasus terjadinya autokorelasi dapat 

ditemukan pada data time seris, sedangkan pada data cross section jarang 

ditemukan autokorelasi. Jika terjadi autokorelasi lakukan trasformasi data dan 

penambahan data. Salah satu uji untuk mendeteksi ada tidaknya autokorelasi 

dapat menggunakan Durbin Watson. 

Uji mutikolinearitas ini pada dasarnya bertujuan untuk menguji apakah di 

dalam model regresi ditemukan adanya korelasi antar variabel bebas. 

Multikolinieritas dapat dilihat dari perhitungan nilai tolerance serta Varian 

Inflation Factor (VIF). Jika terjadi multikolinearitas maka salah satu variabel 

dapat dihilangkan dalam analisisnya. Untuk apalikasi autokorelasi dan 

multikolinearitas sebagai berikut: 

1. Buka file data Regresi Liner Berganda.sav 
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2. Klik Analyze -> Regression -> Linear 
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3. Maka akan muncul kotak Linear Regression 

 
4. Isi variabel dependen dan independent sesuai dengan teorinya, lalu klik 

statistics 
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5. Maka akan muncul kotak Linear Regression: Statistics, lalu aktifkan 

collinearity diagnostics dan durbin-watson, lalu klik continue seperti 

gambar berikut: 

 
6. Maka akan muncul kembali kotak Linear Regression, lalu klik OK 

 
7. Maka akan muncul output berikut: 
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8. Interpertasi 

1. Multikolinieritas  

Suatu model regresi dikatakan tidak memiliki kecenderungan adanya 

gejala multikolinieritas adalah apabila memiliki nilai VIF yang lebih kecil 

dari 10.  

 
Dari hasil tersebut menunjukkan bahwa semua nilai VIF bebas memiliki 

nilai yang lebih kecil dari 10. Hasil pengujian model regresi tersebut 

menunjukkan tidak adanya gejala multikolinier dalam model regresi. Hal 

ini berarti bahwa semua variabel bebas tersebut layak digunakan sebagai 

prediktor. 
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2. Autokolerasi 

Untuk uji autokorelasi dapat dilakukan pengujian Durbin Watson (DW) lalu 

lihat Tabel Durbin Watson sebagai berikut: 

a. Bila DW < dL maka ada autokorelasi positif atau DW > 4 – dL maka ada 

autokorelasi negatif. 

b. Bila dL < DW < dU atau 4 – dU < DW < 4 – dL tidak dapat disimpulkan. 

c. Bila dU < DW < 4 – dU tidak terjadi autokorelasi 

 
Pada table diketahui bahwa terlihat bahwa nilai DW sebesar 1.238, dL = 

1,525 dan dU = 1,703 nilai berada pada kategori DW < dL yang berarti 

terdapat autokorelasi positif.  

 

4. Heterokedaktasitas 

Uji heteroskedastisitas bertujuan untuk menguji apakah dalam model 

regresi terjadi ketidaksamaan variance dari residual satu pengamatan ke 

pengamatan yang lain. Jika variance dari satu pengamatan ke pengamatan 

yang lain tetap, maka disebut homokedastisitas dan jika berbeda disebut 

heteroskedastisitas. Untuk mendeteksi heterokedaktasitas dapat dianalisis 

dengan Grafik Plot, Uji Park, Uji Glejser, atau Uji White. Untuk alasan 

kepraktisan dilakukan uji Glejser sebagai berikut: 
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1. Buka file data Regresi Liner Berganda.sav 

 
2. Klik Analyze -> Regression -> Linear 

 
  



74 Laboratorium Statistik 

3. Maka akan muncul kotak Linear Regression 

 
4. Isi variabel dependen dan independent sesuai dengan teorinya, lalu klik 

statistics 

 
5. Maka akan muncul kotak Linear Regression: Statistics, lalu aktifkan 

estimates dan model fit, lalu klik continue seperti gambar berikut: 
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6. Maka akan muncul kembali kotak Linear Regression, lalu klik OK 

 
7. Lalu klik Save maka akan muncul Kotak Liner Regression: Save 
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8. Aktifkan Residual pada Unstandardized seperti gambar dibawah ini, lalu 

klik continue 

 
9. Maka akan kembali muncul Kotak Liner Regression, lalu klik OK 
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10. Maka akan muncul out put berikut: 

 
11. Lalu kembali pada file inputan, klik menu Transform -> Compute Variable 

 
  



78 Laboratorium Statistik 

12. Maka akan muncul 

 
13. Klik All pada Function group 
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14. Maka akan muncul seperti ini, lalu klik Abs 

 
15. Lalu ketik absolute pada Target Variable dan ABS( pada Numeric 

Expression: 
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16. Aktifkan Unstandardized Residual (RES_1) untuk dimasukan kedalam 

kotak Numeric Expression 

 
17. Maka akan seperti ini, lalu klik OK 
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18. Lalu kembali ke inputan untuk Klik Analyze -> Regression -> Linear 

 
19. Maka akan muncul Kotak Liner Regresssion, lalu keluarkan variabel Nilai 

Perusahaan (Y)(PBV) untuk diganti dengan variabel absolut 
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20. Maka hasilnya seperti ini, lalu klik OK 

 
21. Maka akan muncul output berkut: 
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22. Interpertasi 

Model regresi yang baik adalah tidak terjadi heteroskedastisitas. 

 
Untuk mengetahui data non heteroskedatisitas digunakan metode park 

gleyser. untuk meregresi nilai absolut residual terhadap variabel 

independen.  Jika nilai sig. > 0,05 maka data non heteroskedaktisitas. 

Hasil analisis menunjukan seluruh variabel nilai sig. > 0,05 yaitu 0,328 

(x1), 0,683 (x2) dan 0,166 (x3) maka data non heteroskedaktisitas. 

 

L. REGRESI DENGAN VARIABEL MODERASI 

Pada Bab II sebelumnya telah dijelaskan tentang variabel. Variabel adalah 

hasil operasionalisasi dari konsep yang memiliki variasi nilai. Berdasarkan 

fungsinya, variabel dibagi menjadi empat variabel, yaitu: variabel dependen, 

independen, moderasi dan intervening. Variabel dependen adalah variabel 

yang dipengaruhi. Variabel ini menjadi perhatian utama dari peneliti karena 

hasil analisis varaiabel dependen memungkinkan peneliti untuk menemukan 

jawaban atau solusi dari masalah penelitian. Variabel independen adalah 

variabel yang mempengaruhi. Variabel ini menjadi sebab dari variabel 

dependen. Kondisi variabel independen (peningkatan atau penurunan variasi 

nilai) akan menentukan kondisi variabel dependen. Variabel moderator atau 

moderasi adalah variabel yang memperkuat atau memperlemah pengaruh 

variabel independen terhadap variabel dependen. Variabel antara 

(intervening) adalah variabel yang ada saat variabel independen mulai 

bekerja mempengaruhi variabel dependen.  

Variabel moderasi berbeda dengan variabel antara. Kedua variabel tidak 

dapat ditempatkan dalam satu analisis, di mana variabel moderasi juga 

sebagai variabel antara. Jadi variabel moderasi akan bertindak sebagai 

variabel moderasi yaitu memperkuat atau memperlemah pengaruh variabel 

independen terhadap variabel dependen, begitu pula variabel antara akan 
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bertindak sebagai variabel antara, yaitu sebagai variabel yang menjadi 

perantara pengaruh variabel independen terhadap variabel dependen. Contoh 

model penelitian yang menggunakan variabel independen, moderasi, antara 

dan dependen sebagai berikut. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Penetapan variabel moderasi yang digunakan dalam model penelitian 

merupakan hasil dari telah teori dan pertimbangan rasional dari peneliti. 

Variabel moderasi juga dapat diketahui dari interaksi antara variabel 

independen dengan variabel moderasi dalam memprediksi variabel dependen. 

Jika dimisalkan dalam model persamaan, variabel moderasi, interaksi, 

independen dan dependen dapat dilihat sebagai berikut: 

Y = α + β1X1 + β2M + β3X1*M + e…………………………………………………………….L.1. 

dimana : 

Y     = Nilai perusahaan  

X1     = Struktur Modal 

M     = Peluang Pertumbuhan (Variabel Moderasi)  

Keragaman 
Tenaga Kerja 

Sinergi Kreatif Efektivitas 
Organisasi 

Keahlian 
Manjerial 

Variabel Independen Variabel Antara Variabel dependen 

Variabel Moderasi 

Struktur 
Modal 

Peluang 
Pertumbuhan 

Variabel Independen Variabel Dependen 

Variabel Moderasi 

Nilai 
Perusahaan 
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X1*M = Interaksi Variabel Struktur Modal dengan Peluang Pertumbuhan 

(Variabel Interaksi) 

β1,2,3  = koefisien variabel X1, M dan X1*M   

e       = Variabel Pengganggu 

Meskipun variabel peluang pertumbuhan (M) disebut variabel moderasi dan 

variabel interaksi struktur modal dengan peluang pertumbuhan (X1*M) 

disebut variabel interaksi tetapi kedua variabel tersebut tetap berfungsi 

sebagai variabel independen sehingga dapat digambar sebagai berikut: 

 

 

 

 

 

 

 

 

 

 

 

Gambar 3.1. Model Analisis Variabel Moderasi 

 

Variabel moderasi diklasifikasikan menjadi 4 jenis. Jika menggunakan 

contoh gambar 3.1. maka dapat digunakan untuk memberikan gambaran 

klasifikasi variabel moderasi sebagai berikut: 

 

 

 

Tabel 3.1. Klasifikasi Variabel Moderasi 

Jenis Variabel 

Moderasi 

Ciri-Ciri 
Keterangan 

β2 β3 

Moderasi Murni Tidak Signifikan Signifikan Moderasi 

Moderasi semu Signifikan Signifikan Moderasi 

Moderasi potensial Tidak Signifikan Tidak Signifikan Moderasi 

Moderasi prediksi Signifikan Tidak Signifikan 
Bukan 

Moderasi 

 

  

Variabel Independen 

β3 

β2 

β1 

 
(X1) 

 
(Y) 

 
(M) 

 

 
(X1*M) 

Variabel Dependen 
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1. Moderasi Murni (Pure Moderator) 

Moderasi murni dapat diidentifikasi pada koefisien variabel peluang 

pertumbuhan (β2) dan interaksi variabel struktur modal dengan peluang 

pertumbuhan (β3) dimana jika koefisien variabel peluang pertumbuhan 

(β2) signifikan dan koefisien variabel interaksi (β3) tidak signifikan secara 

statistik. Artinya variabel peluang pertumbuhan (β2) tidak berperan 

seperti variabel independen tetapi langsung berinteraksi dengan struktur 

modal (X1). 

2. Moderasi Semu (Quasi Moderator) 

Moderasi semu terjadi jika koefisien peluang pertumbuhan (β2) dan 

koefisien variabel interaksi (β3) signifikan secara statistik. Artinya 

variabel moderasi (β2) berperan seperti variabel struktur modal (X1) 

sekaligus berinteraksi dengan variabel struktur modal (X1). 

3. Moderasi Potensial (Homologiser Moderator) 

Moderasi potensial terjadi jika koefisien variabel peluang pertumbuhan 

(β2) dan koefisien variabel interaksi (β3) tidak signifikan secara statistik. 

Artinya variabel peluang pertumbuhan (β2) mempengaruhi kekuatan 

hubungan variabel struktur modal (X1) dan tidak berhubungan secara 

signifikan dengan variabel interaksi (β3) maupun dengan variabel nilai 

perusahaan (Y). 

4. Moderasi Prediksi (Predictor Moderator) 

Moderasi prediksi terjadi jika koefisien variabel peluang pertumbuhan 

(β2) signifikan dan koefisien variabel interaksi (β3) tidak signifikan secara 

statistik. Artinya variabel peluang pertumbuhan (β2) hanya berperan 

seperti variabel struktur modal (X1). Jadi variabel peluang pertumbuhan 

(β2) bukan sebagai variabel moderasi tetapi sama seperti variabel 

struktur modal (X1). 

 

Regersi moderasi digunakan untuk menganalisis yang melibatkan 

variabel moderasi dalam analisis model yang diteliti. Sesuai dengan fungsinya, 

variabel moderasi di dalam model penelitian akan berperan sebagai variabel 

yang akan memperkuat atau memperlemah pengaruh variabel independen 

terhadap variabel dependen. Regresi yang tidak melibatkan variabel moderasi 

dalam modelnya maka disebut sebagai regresi (sederhana atau berganda 

tergantung dari variabel dan data yang digunakan) seperti pada persamaan 

berikut: 
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Y = α + β1X1 + e…………………………………………………………………….. L.2  

Y = α + β1X1 + β2M + e…………………………………………………………… L.3 

Y = α + β1X1 + β2M + β3X1*M + e…………………………………………….. L.4 

Pada persamaan L.2. menunjukan persamaan regresi biasa (tanpa melibatkan 

variabel moderasi). Pada persamaan L.3 melibatkan variabel moderasi 

sedangkan persamaan L.4 melibatkan variabel moderasi dan interaksi. 

Analisis regresi moderasi memiliki kesamaan dalam regresi liner berganda 

metode OLS, artinya asumsi-asumsi yang digunakan dalam regresi liner 

berganda metode OLS akan berlaku pula pada analisis regresi moderasi.  

Ada beberapa metode pengujian yang dapat digunakan untuk mengetahui 

suatu variabel disebut sebagai variabel moderasi yaitu metode sub-goups (sub 

kelompok), moderated regression analysis (MRA) dan uji nilai selisih mutlak.  

 

1. Sub Group 

Analisi sub group atau sub kelompok digunakan untuk mengidentifikasi 

variabel yang diduga sebagai variabel moderasi dengan cara memecah 

variabel menjadi dua sub kelompok. Misalnya variabel jenis kelamin (dipecah 

menjadi variabel jenis kelamin pria dan wanita), jenis perusahaan 

(manufaktur dan non manufaktur). Namun jika variabel berbentuk kuantitatif, 

misalnya variabel ROA, maka cara membaginya dengan mencari nilai median 

(nilai tengah) atau nilai mean (rata-rata) sehingga menjadi dua kelompok 

yaitu nilai dibawah dan diatas median atau nilai dibawah dan diatas mean. 

Setelah variabel moderasi dibagi menjadi dua kelompok maka tahapan 

selanjutnya adalah melihat kesamaan koefisien dari dua kelompok tersebut 

dengan menggunakan uji chow test. Rumus yang digunakan untuk uji chow 

test sebagai berikut: 

)221/(

/)(

knnSSRu

kSSRuSSRr
Fhitung




  

Keterangan: 

SSRr = Sum of Squared Residual dari Restricted Regression (Total Regresi) 

SSRu = Sum of Squared Residual dari Unrestricted Regression (masing-masing 

kelompok yaitu SSRr Kelompok Pertama + SSRr Kelompok Kedua 

n1 = jumlah observasi kelompok pertama 

n2 = jumlah observasi kelompok kedua 

k = jumlah parameter atau variabel yang diesimasi pada restricted 

regression  

Jika ditemukan hasil Fhitung > Ftabel maka dapat disimpulkan sub kelompok 

pertama dengan kelompok kedua berbeda signifikan yang berarti variabel 
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yang memecah dua kelompok sebagai variabel moderasi. Jika sebaliknya yaitu 

Fhitung < Ftabel maka variabel yang memecah dua kelompok bukan sebagai 

variabel moderasi.  

Sebagai contoh, dianalisis pengaruh biaya promosi terhadap jumlah 

penjualan dengan media promosi sebagai variabel moderasi. Untuk media 

promosi ada dua kelompok yaitu kelompok pertama, promosi menggunakan 

media TV dan kelompok kedua, promosi menggunakan media Koran sehingga 

diperoleh 3 persamaan sebagai berikut: 

Y = α + β1XK + e untuk kelompok pertama menggunakan media Koran  

Y = α + β1XTV + e   untuk kelompok kedua menggunakan media TV 

Y = α + β1XTV&K + e  untuk semua kelompok menggunakan media TV dan 

Koran 

Jadi dilakukan 3 analisis regresi untuk masing-masing persamaan sehingga 

diperoleh 3 hasil out yang berbeda. Aplikasi sub group dengan menggunakan 

program SPSS sebagai berikut: 

1. Buka file Regresi Moderasi Sub Group Untuk Observasi Promosi Melalui 

Koran.sav 
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2. Klik Analyze -> Regression -> Linear 

 
3. Maka akan muncul kotak Linear Regression 

 
4. Isi variabel dependen dan independent sesuai dengan teorinya, lalu klik 

statistics 
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5. Maka akan muncul kotak Linear Regression: Statistics, lalu aktifkan 

estimates, model fit, descriptive dan collinearity diagnostics, lalu klik 

continue seperti gambar berikut: 

 
6. Maka akan muncul kembali kotak Linear Regression, lalu klik OK 

7. Maka akan muncul output untuk persamaan kelompok pertama untuk data 

kelompok yang menggunakan media Koran sebagai berikut: 

 
8. Untuk kelompok kedua untuk data kelompok yang menggunakan media 

TV. Buka file Regresi Moderasi Sub Group Untuk Observasi Promosi Melalui 

TV.sav. Lakukan langkah yang sama seperti pada kelompok pertama 

sehingga muncul out put sebagai berikut: 
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9. Untuk semua kelompok (data kelompok pertama dan kedua digabung) 

untuk data kelompok yang menggunakan media TV dan Koran. Buka file 

Regresi Moderasi Sub Group Untuk Observasi Promosi Melalui TV dan 

Koran.sav. Lakukan langkah yang sama seperti pada kelompok pertama 

dan kedua sehingga muncul out put sebagai berikut: 
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10. Interpertasi 

Hasil ringkasan pada analisis regresi dengan pada kelompok pertama, 

kedua dan semua sebagai berikut: 

Kelompok Pertama 

Ŷ 
Variabel  

Independen 

Koefisien 

Regresi 

t 

hitung 
Prob. Arah Ket. 

Penjulanan 

Intersep (α) 1,933 6,071 0,000 + Sig. 

Biaya Promosi 

(Xk) 
0,054 2,730 0,015 + Sig. 

R             : 0,576 SSRr    : 0,909 F Statistik    : 7,454 

R Square  : 0,332 n         : 17 F Signifikan  : 0,015 

 

Kelompok Kedua 

Ŷ 
Variabel  

Independen 

Koefisien 

Regresi 

t 

hitung 
Prob. Arah Ket. 

Penjulanan 

Intersep (α) -7,010 -5,536 0,000 -  Sig. 

Biaya Promosi 

(XTV) 
0,246 8,049 0,006 +  Sig. 

R             : 0,874 SSRr    : 0,640 F Statistik    : 64,794 

R Square  : 0,764 n         : 22 F Signifikan  : 0,000 

 

Semua Kelompok (Pertama dan Kedua) 

Ŷ 
Variabel  

Independen 

Koefisien 

Regresi 

t 

hitung 
Prob. Arah Ket. 

Penjulanan 

Intersep (α) 2,483 19,588 0,000 +  Sig. 

Biaya Promosi 

(XTV&K) 
0,017 4,495 0,000 +  Sig. 

R             : 0,594 SSRr    : 3,579 F Statistik    : 20,208 

R Square  : 0,353 n         : 39 F Signifikan  : 0,000 

 

Lakukan pengujian chow test dengan menggunakan rumus sebagai 

berikut: 

 

 

Keterangan: 

SSRu = SSRr Kelompok Pertama + SSRr Kelompok Kedua 

        = 0,909 + 0,640 = 1,549 

934,22
044,0

015,1

35/549,1

2/030,2

)222217/(549,1

2/)549,1579,3(







x
Fhitung
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Jadi diperoleh hasil nilai F hitung sebesar 22,934 sedangkan nilai F tabel 

3,2673. Hasil perbandingan menunjukan F Hitung > F Tabel sehingga 

disimpulkan bahwa persamaan regresi antar sub kelompok yang 

menggunakan media promosi dengan TV dan Koran tidak berbeda secara 

signifikan yang berarti variabel media promosi sebagai variabel moderasi. 

Selain itu, Jika dibandingkan nilai R square antara kelompok pertama dan 

kedua yaitu sebesar 0,322 dan 0,764 maka dapat disimpulkan bahwa 

pengaruh biaya promosi terhadap jumlah penjualan dengan variabel 

media promosi sebagai moderasi menunjukan promosi melalui media TV 

memperkuat pengaruh biaya promosi terhadap penjualan dibandingkan 

dengan media koran. 

 

2. Moderated Regression Analysis 

Jika pada analisis sub group maka dilakukan pemecahan data menjadi 

dua kelompok pada variabel yang diduga sebagai variabel moderasi maka 

pada analisis moderated regression analysis (MRA) mempertahankan kesatuan 

data pada variabel yang diduga sebagai variabel moderasi untuk mengontrol 

pengaruh dari variabel moderasi. Sebagai contoh dilakukan analisis pengaruh 

struktur modal terhadap nilai perusahaan dengan peluang pertumbuhan 

sebagai variabel moderasi dengan persamaan sebagai berikut: 

NP = α + β1SM+ β2PP + β3INTERAKSI + e 

Dimana 

NP    = Nilai perusahaan  

SM    = Struktur Modal 

PP    = Peluang Pertumbuhan (Variabel Moderasi)  

INTERAKSI = Interaksi Variabel Struktur Modal dengan Peluang 

Pertumbuhan (Variabel Interaksi) 

β1,2,3   = koefisien variabel SM, PP dan INTERAKSI   

e       = Variabel Pengganggu 

Mengikuti klasifikasi variabel moderasi pada tabel 9.1. dimana variabel 

peluang pertumbuhan merupakan variabel moderasi jika koefisien variabel 

peluang pertumbuhan (β2) signifikan dan koefisien variabel interaksi (β3) 

tidak signifikan secara statistik (moderasi murni), jika koefisien peluang 

                                                           
3 Hasil F tabel dapat diperoleh dengan melihat F tabel atau dengan menggunakan rumus pada 
program excel yaitu =FINV(probability, deg_freedom1, deg_freedom2). Misalnya pada kasus ini 
dengan probablitas 0,05, deg_freedom1 (df1) sebesar 2, deg_freedom2 (df2) sebesar 35 (dari 
n1+n2-2k). Hal yang sama juga jika ingin mengetahui t tabel dapat menggunakan program exel 
dengan rumus =TINV(probability, deg_freedom). Misalnya dengan probablitas 0,05 dengan df 
sebesar 10 maka t tabel sebasar 2,228 (diperoleh dari =TINV(0,05;10)). 
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pertumbuhan (β2) dan koefisien variabel interaksi (β3) signifikan secara 

statistik (moderasi semu), jika jika koefisien variabel peluang pertumbuhan 

(β2) dan koefisien variabel interaksi (β3) tidak signifikan secara statistik 

(moderasi potensial), jika koefisien variabel peluang pertumbuhan (β2) 

signifikan dan koefisien variabel interaksi (β3) tidak signifikan secara statistik 

(bukan variabel moderasi).  

Aplikasi analisis MRA Kasus 1 dengan menggunakan program SPSS 

sebagai berikut: 

1. Buka file MRA Kasus 1.sav 

 
2. Buat variabel interkasi dengan klik Transform ->Compute Varible 
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3. Maka akan muncul kotak Compute Variable 

 
4. Isi Target Variabel (memberi nama variabel) dengan nama INTERAKSI, 

klik All lalu pilih Abs 

 
5. Isi kotak Numeric Expression untuk menginterasksikan variabel yang 

diinginkan, dalam hal ini variabel Struktur Modal (X1) dan Peluang 

Pertumbuhan (M) dengan cara blok variabel Struktur Modal (X1) klik  

sehingga masuk ke dalam kotak Numeric Expression  lalu klik 

 sehingga menjadi  lalu masukan variabel Peluang 

Pertumbuhan (M)   lalu klik OK 



96 Laboratorium Statistik 

 
6. Lalu Klik Analyze -> Regression -> Linear 

 
7. Maka akan muncul kotak Linear Regression 
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8. Isi variabel dependen dan independent sesuai dengan teorinya, lalu klik 

statistics 

 
9. Maka akan muncul kotak Linear Regression: Statistics, lalu aktifkan 

estimates, model fit, descriptive dan collinearity diagnostics, lalu klik 

continue seperti gambar berikut: 

 
10. Maka akan muncul kembali kotak Linear Regression, lalu klik OK 
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11. Maka akan muncul output sebagai berikut: 

 
 

 

12. Interpertasi 

Hasil ringkasan pada analisis MSA kasus 1 sebagai berikut: 

Ŷ 
Variabel  

Independen 

Koefisie

n Regresi 

t 

hitung 
Prob Arah Ket. 

Nilai 

Perusahaan 

Intersep (α) 36,516 2,717 0,009 + Sig. 

Struktur Modal 

(SM) 
-2,519 -1,177 0,244 - Sig. 

 

Peluang 

Pertumbuhan 

(PP) 

6,630 3,196 0,002 + Sig. 

 
INTERAKSI 

(SM*PP) 
-0,730 -2,730 0,006 - Sig. 

R             : 0,793 
F Statistik    : 

31,659 
 

R Square  : 0,629 
F Signifikan  : 

0,000 
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Interpertasi analisis MSA tidak berbeda dengan interpertasi regresi liner 

berganda atau regresi dengan variabel independen berbentuk kualitatif baik 

akurasi, kelayakan dan keabsahan modelnya. Namun sebelumnya harus 

ditentukan terlebih dahulu apa peluang pertumbuhan (M) merupakan 

variabel moderasi. Diketahui bahwa koefisien peluang pertumbuhan (β2) dan 

koefisien variabel interaksi (β3) signifikan secara statistik yang berarti 

variabel peluang pertumbuhan (PP) adalah variabel moderasi semu. 

Selanjutnya untuk aplikasi analisis MRA Kasus 2, tidak berbeda dengan 

MRA Kasus 1. Sebagai contoh dilakukan analisis pengaruh Kesempatan 

Investasi terhadap Dividen Payout Ratio dengan Kepemilikan Insider sebagai 

variabel moderasi dengan persamaan sebagai berikut: 

DPR = α + β1KI+ β2KIns + β3INTERAKSI + e 

Dimana: 

DPR   = Dividen Payout Rasio  

KI     = Kesempatan Investasi 

KIns   = Kesempatan Insider (Variabel Moderasi)  

INTERAKSI = Interaksi Variabel Kesempatan Investasi dengan 

Kesempatan Insider (Variabel Interaksi) 

β1,2,3   = koefisien variabel KI, KIns dan INTERAKSI   

e       = Variabel Pengganggu 

maka aplikasi dengan menggunakan program SPSS sebagai berikut: 

1. Buka file MRA Kasus 2.sav 

 
2. Buat variabel interkasi dengan klik Transform ->Compute Varible 

3. Maka akan muncul kotak Compute Variable 
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4. Isi Target Variabel (memberi nama variabel) dengan nama INTERAKSI, 

klik All lalu pilih Abs 

5. Isi kotak Numeric Expression untuk menginterasksikan variabel yang 

diinginkan, dalam hal ini variabel Kesempatan Investasi (X1) dan 

Kepemilikan Insider (M) dengan cara blok variabel Kesempatan Investasi 

(X1) klik  sehingga masuk ke dalam kotak Numeric Expression 

 lalu klik  sehingga menjadi  lalu masukan variabel 

Kepemilikan Insider (M)   lalu klik OK 

6. Lalu Klik Analyze -> Regression -> Linear 

7. Maka akan muncul kotak Linear Regression 

8. Isi variabel dependen dan independent sesuai dengan teorinya, lalu klik 

statistics 

9. Maka akan muncul kotak Linear Regression: Statistics, lalu aktifkan 

estimates, model fit, descriptive dan collinearity diagnostics, lalu klik 

continue seperti gambar berikut: 

10. Maka akan muncul kembali kotak Linear Regression, lalu klik OK 

11. Maka akan muncul output sebagai berikut: 

 
12. Interpertasi 
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Hasil ringkasan pada analisis MSA kasus 1 sebagai berikut: 

Ŷ 
Variabel  

Independen 

Koefisien 

Regresi 

t 

hitung 
Prob Arah Ket. 

Dividen 

Pay Out 

Ratio 

Intersep (α) 0,071 0,418 0,676 + TidakSig. 

Kesempatan 

Investasi (KI) 
-0,039 -0,324 0,746 - TidakSig. 

 
Kepemilikan 

Insider (KIns) 
0,467 3,569 0,001 + Sig. 

 
INTERAKSI 

(KI*KIns) 
0,043 0,514 0,608 - TidakSig. 

R             : 0,487 
F Statistik    : 

11,403 
 

R Square  : 0,237 
F Signifikan  

: 0,000 
 

 

Berdasarkan tabel 9.1 diketahui bahwa koefisien kesempatan investasi 

(β2) signifikan dan koefisien variabel interaksi (β3) tidak signifikan secara 

statistik yang berarti masuk dalam kategori moderasi prediksi, yang berate 

variabel Kepemilikan Insider (M) bukan sebagai variabel moderasi. 

 

3. Uji Nilai Selisih Mutlak 

Uji nilai selisih mutlak adalah analisis regresi moderasi yang menguji 

interaksi dari hasil selisih absolut angka baku (standardize)4 antara variabel 

independen dengan variabel yang diduga variabel moderasi. Uji ini didasarkan 

hasil penelitian Frecout dan Shearon (1991) dengan persamaan seperti 

berikut: 

Y = α + β1ZX+ β2ZM + β3׀ZX- ZM׀ + e 

Dimana: 

Y     = Variabel Dependen  

ZX      = Variabel Independen  

ZM     = Variabel Moderasi  

 -ZX׀ Variabel Interaksi (nilai absolut dari hasil pengurangan = ׀ZX-ZM׀

ZM׀) 

β1,2,3   = koefisien variabel ZX, ZM dan ׀ZX- ZM׀  

e       = Variabel Pengganggu 

Sebagai contoh kasus analisis pengaruh struktur modal terhadap nilai 

perusahaan dengan peluang pertumbuhan sebagai variabel moderasi dengan 

persamaan sebagai berikut: 

                                                           
4 Rumus nilai standarisasi dapat dilihat pada Bab III Deskriptif mengenai angka baku. 
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NP = α + β1ZSM+ β2ZPP + β3INTERAKSI + e 

Dimana 

NP    = Nilai perusahaan  

ZSM   = Struktur Modal  

ZPP   = Peluang Pertumbuhan (Variabel Moderasi)  

INTERAKSI = Interaksi Variabel Struktur Modal dengan Peluang 

Pertumbuhan (׀ZX- ZM׀) 

β1,2,3   = koefisien variabel SM, PP dan INTERAKSI   

e       = Variabel Pengganggu 

Z       = Nilai distandarisasi 

Aplikasi uji nilai selisih mutlak dengan program SPSS sebagai berikut: 

1. Buka file Uji Nilai Selisih Mutlak.sav 
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2. Buat variabel baru untuk angka baku dari variabel Struktur Modal (ZSM) 

dan Peluang Pertumbuhan (ZPP) dengan cara klik analyze, lalu 

Descriptive Statistik, lalu Descriptives 

 
3. Maka akan muncul Kotak Descriptives 
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4. Masukan variabel yang akan dihitung angka bakunya kedalam kotak 

Variabel(s). Lalu aktifkan  Save standardized values as variables lalu 

klik OK 

 
5. Maka akan terbentuk variabel baru dengan angka baku untuk variabel 

struktur modal dan peluang pertumbuhan. Sedangkan untuk menghitung 

selisih maka klik Trasform -> Compute Variable sehingga muncul kotak 

Compute Variable sebagai berikut: 

 
6. Isi kotak Target Variabel dengan nama INTERAKSI, klik All lalu pilih Abs. 

Isi kotak Numeric Expression untuk menginterasksikan variabel yang 

diinginkan, dalam hal ini variabel Angka Baku Struktur Modal (ZSM) dan 

Peluang Pertumbuhan (ZPP) dengan cara blok variabel Zscore: Struktur 

Modal klik  sehingga masuk ke dalam kotak Numeric Expression 

 lalu klik  sehingga menjadi  lalu masukan variabel 

Peluang Pertumbuhan (M)   lalu klik OK. 
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7. Setelah terbentuknya seluruh variabel maka klik Analyze -> Regression -> 

Linear 

8. Maka akan muncul kotak Linear Regression 

9. Isi variabel dependen dan independent sesuai dengan teorinya, lalu klik 

statistics 

 
10. Maka akan muncul kotak Linear Regression: Statistics, lalu aktifkan 

estimates, model fit, descriptive dan collinearity diagnostics, lalu klik 

continue seperti gambar berikut: 

11. Maka akan muncul kembali kotak Linear Regression, lalu klik OK 

12. Maka akan muncul output sebagai berikut: 
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13. Interpertasi 

Hasil ringkasan pada analisis Uji Nilai Selisih Multlak sebagai berikut: 

Ŷ 

Variabel  

Independe

n 

Koefisien 

Regresi 

t 

hitung 
Prob Arah Ket. 

Nilai 

Perusahaan 

Intersep (α) 0,766 5,656 0,000 + Sig. 

Struktur 

Modal 

(ZSM) 

0,265 3,272 0,002 + Sig. 

 

Peluang 

Pertumbuh

an (ZPP) 

-0,409 -5,063 0,000 - Sig. 

 
INTERAKSI 

 (׀ZSM-ZPP׀)
0,302 2,507 0,017 + Sig. 

R             : 0,705 
F Statistik    : 

11,561 
 

R Square  : 0,498 
F Signifikan  : 

0,000 
 

 

Diketahui bahwa koefisien struktur modal (β2) dan koefisien variabel 

interaksi (β3) signifikan secara statistik yang berarti masuk dalam kategori 

moderasi prediksi, yang berarti variabel peluang pertumbuhan (PP) adalah 

variabel moderasi (moderasi semu). 
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M. ANALISIS JALUR 

Analisis jalur (Path Anlysis) adalah analisis hubungan yang membahas 

pengaruh langsung (direct effect) dan tidak langsung dari variabel (indirect 

effect) dari variabel. Berbeda dengan analisis regresi yang dapat mengestimasi 

atau memprediksi secara kualitatif pengaruh variabel independen terhadap 

variabel dependen maka analisis jalur tidak dapat digunakan untuk 

mengestimasi atau memprediksi secara kualitatif sehingga hanya digunakan 

untuk menguji hubungan teoritis antar variabel. 

Variabel yang digunakan dalam analisis jalur adalah variabel endogen dan 

eksogen. Variabel yang hanya dipengaruhi dan tidak mempengaruhi disebut 

variabel endogen sedangkan variabel yang dipengaruhi dan dapat 

mempengaruhi disebut variabel eksogen. Namun hal penting dalam analisis 

jalur adalah variabel yang digunakan baik edogen maupun eksogen adalah 

variabel yang dapat diukur secara langsung (observer/manifest). Jika variabel 

yang digunakan bukan variabel observer/manifest tetapi variabel 

unobserver/laten maka disebut model persamaan struktural atau disebut 

Structural Equation Modeling (SEM). 

1. Tahapan Analisis Jalur 

a. Pembuatan Model 

Tahapan dalam analisis jalur dimulai dari pembuatan spesifikasi model 

analisis jalur. Model yang dibuat didasarkan pada teori teori-teori dan 

konsep-konsep yang relevan. Spesifikasi model akan memberikan 

gambaran hubungan antar variabel. Ada berbagai macam kemungkinan-

kemungkinan spesifikasi model yang dapat dibuat sehingga menghasilkan 

berbagai macam model-model spesifikasi analisis jalur untuk 

menjelaskan besarnya pengaruh antar variabel. Salah satu contohnya 

sebagai berikut. 

 

 

 

 

 

 

 

Gambar 3.2. Contoh Model Analisis Jalur 
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Besarnya pengaruh dapat dilihat dari koefisien analisis jalur yang 

menggunakan koefisien regresi parsial tersandarisasi (standardize partial 

coefficient regression). Koefisien regresi parsial tersandarisasi digunakan 

untuk menjelaskan pengaruh (bukan memprediksi) variabel eksogen 

terhadap variabel endogen. Misalnya pengaruh langsung variabel X1 terhadap 

Y1 (ρx1y1). 

Pada gambar M.1 variabel X1 dan X2 merupakan variabel eksogen 

sedangkan variabel Y1 dan Y2 adalah variabel endogen. Variabel X1 dan X2 

berpengaruh secara langsung terhadap Y1 dan Y2 serta berpengaruh tidak 

langsung terhadap Y2 melalui Y1. Untuk variabel Y1 berpengaruh secara 

langsung terhadap Y2. Dari gambar tersebut maka dapat dibuat persamaan 

struktural sebagai berikut: 

Persamaan Struktur I: Y1 = α + β1X1 + β2X2 + e1………………………………… M.1 

Persamaan Struktur II: Y2 = α + β1X1 + β2X2 + β3Y1 + e2……….…………….. M.2 

Selain itu, penggunaan koefisien regresi parsial tersandarisasi terjadi 

karena variabel yang digunakan dapat memiliki satuan berbeda. Misalnya 

variabel X1 adalah jumlah anak dengan satuan orang, variabel X2 adalah lama 

pendidikan satuannya tahun. Artinya antara variabel X1 dan X2 memiliki 

satuan yang berbeda sehingga jika menggunakan koefisien regresi parsial 

tidak terstandarisasi besarnya pengaruh tidak dapat disamakan karena 

berbeda besaran koefisien dengan satuan orang (X1) dan satuan tahun (X2) 

sehingga pada persamaan M.1 dan M.2 dapat dibuat persamaan struktural 

yang distandarisasi sebagai berikut: 

Persamaan Struktur I: ZY1 = Z1X1 + Z2X2 + e1………………………………… M.3 

Persamaan Struktur II: ZY2 = Z1X1 + Z2X2 + Z3Y1 + e2…………...…………. M.4 

b. Uji Asumsi 

Ada beberapa asumsi yang mendasari analisis jalur. Asumsi ini harus 

dipenuhi sebagai berikut: 

 Hubungan antar variabel adalah liner dan aditif (bukan persamaan 

matematis) 

 Model rekrusif artinya sistem aliran kausal ke satu arah atau tidak kausal 

yang berbalik arah. 

 Variabel yang digunakan dalam skala interval atau rasio. 

 Variabel observer/manifest 

 Jika analisis menggunakan sample maka teknik penarikan sampelnya 

menggunakan probability sampling. 
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 Model yang dibentuk didasarkan pada teori-teori dan konsep-konsep 

yang relevan. 

 Setiap model memenuhi asumsi klasik. 

 

c. Perhitungan Koefisien Jalur 

Perhitungan koefisien jalur menggunakan model dekomposisi. Model 

dekomposisi adalah model yang lebih menekankan pada analisis jalur antar 

variabel (pengaruh langsung dan tidak langsung) tanpa memperhitungkan 

koefisien korelasi yang ada pada variabel eksogen. Analisis jalur antar variabel 

dibagi menjadi tiga yaitu: 

 Pengaruh langsung (direct effect) yaitu pengaruh antara variabel eksogen 

terhadap variabel endogen tanpa melalui variabel endogen lain. 

 Pengaruh tidak langsung (indirect effect) yaitu pengaruh antara variabel 

eksogen terhadap variabel endogen melalui variabel endogen lain. 

 Total pengaruh (total effect) adalah jumlah pengaruh langsung dan 

pengaruh tidak langsung. 

Contoh bentuk dekomposisi antar variabel dapat digambarkan dalam 

kerangka model sebagai berikut: 

a. Contoh yang melibatkan dua variabel eksogen. 

 

 

 

 

 

 

 

 

Gambar 3.3. Contoh Model Analisis Jalur Dua Variabel Eksogen 

Tabel 3.2. Pengaruh Kausal Dengan Dua Variabel Eksogen 

Pengaruh 

Variabel 

Pengaruh Kausal 

Langsung 
Tidak Langsung 

Total 
Melalui Y1 

X1 terhadap Y1 (1) - (1) 

X1 terhadap Y2 (3) (1) (5) (3) + (1) (5) 

X2 terhadap Y1 (2) - (2) 

X2 terhadap Y2 (4) (2) (5) (4) + (2) (5) 

Y1 terhadap Y2 (5) - (5) 

5 

4 

3 

2 

1 

rx1x2 

X1 

X2 

Y1 

e1 

Y2 

e2 
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Keterangan: 

Angka 1 – 5 menjelaskan besar pengaruh antar variabel 

 

d. Contoh yang melibatkan tiga variabel eksogen. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 3.4. Model Dekomposisi Dengan Tiga Variabel Eksogen 

 

Tabel 3.3. Pengaruh Kausal Dengan Tiga Variabel Eksogen 

Pengaruh 

Variabel 

Pengaruh Kausal 

Langsung 

Tidak Langsung 

Total Melalui 

Y1 

Melalui 

Y2 

Melalui Z 

X1 terhadap Y1 (1) - - - (1) 

X1 terhadap Y2 (3) (1) (7) - - (3) + (1) 

(7) 

X1 terhadap Z (2) (1) (8) (3) (9) (1) (7) 

(9) 

(2) + (1) 

(8) + (3) 

(9) + (1) 

(7) (9) 

X2 terhadap Y1 (4) - - - (4)  

X2 terhadap Y2 (6) (4) (7) - - (6) + (4) 

(7) 

X2 terhadap Z (5) (4) (8) (6) (9) (4) (7) 

(9) 

(5) + (4) 

(8) + (6) 

4 

3 

7 9 

8 

1 

6 

5 

2 
rx1x2 

X2 

Y2 

Z 

X1 

e2 

e3 
Y1 

e1 
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(9) + (4) 

(7) (9) 

Y1 terhadap Y2 (7) - - - (7) 

Y1 terhadap Z (8) - (7) (9) - (8) + (7) 

(9) 

Y2 terhadap Z (9) - - - (9) 

Keterangan: 

Angka 1 – 9 menjelaskan besar pengaruh antar variabel 

 

d. Pemeriksaan Kelayakan Modal 

Kelayakan model dalam analisis jalur tidak berbeda seperti analisis 

regresi. Setiap persamaan struktural memenuhi asumsi klasik dan secara 

keluruhan model layak di mana nilai F hitung atau nilai signifikansi F pada 

ANOVA (menguji koefisien regresi keseluruhan) signifikan. Namun pada 

akurasi model yang tergambar pada nilai R-Square dapat dijelaskan untuk 

setiap persamaan struktural atau secara keseluruhan (seluruh persamaan 

struktural yang ada). 

Misalnya terdapat 2 persamaan struktural (menggunakan persamaan M.1 

dan M.2) diperoleh nilai R-square pada variabel X1 dan X2 terhadap Y1 dengan 

nilai 0,327 yang berarti model dapat menjelaskan fenomena atau variasi Y1 

dapat dijelaskan oleh variabel X1 dan X2 sebesar 32,7 persen (0,327 x 100%) 

sedangkan sisanya dijelaskan oleh variasi variabel lain diluar dari model 

penelitian sebesar 67,3 (100% - 32,7%). R-square pada variabel X1 X2 dan Y1 

terhadap Y2 dengan nilai 0,324 yang berarti model dapat menjelaskan 

fenomena atau variasi Y2 dapat dijelaskan oleh variabel X1 X2 dan Y1 sebesar 

32,4 persen (0,324 x 100%) sedangkan sisanya dijelaskan oleh variasi 

variabel lain diluar dari model penelitian sebesar 67,6 (100% - 32,4%). 

Namun total R-Square untuk dua persamaan struktural sekaligus dapat 

dijelaskan dengan menggunakan rumus sebagai berikut: 

R2m = 1 – ( 1 – R21) (1 – R22) ( 1 – R2n)………………………………………………………M.5 

Dimana: 

R2m  = R Squre total 

R21   = R Squre pada persamaan struktural I 

R22   = R Squre pada persamaan struktural II 

R2
n   = R Squre pada persamaan struktural N 

Jadi jika diketahui persamaan struktural I memiliki R Square sebesar 

0,327 dan persamaan struktural I memiliki R Square sebesar 0,324 maka  R 

Squre seluruh persamaan struktural sebesar R2m = 1 - ( 1 – 0,327) (1 – 0,324) 
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= 0,545. Artinya model dapat menjelaskan fenomena atau variasi Y2 dapat 

dijelaskan oleh variabel X1, X2 dan Y1 terhadap Y2 sebesar 54,5 persen (0,545 x 

100%) sedangkan sisanya dijelaskan oleh variasi variabel lain diluar dari 

model penelitian sebesar 45,5 (100% - 54,5%). 

 

2. Aplikasi Analisis Jalur Dengan Dua Variabel Eksogen 

 

Analisis ini digunakan untuk menguji besarnya pengaruh kausal antar 

variable X1 dan X2 terhadap Y1 dan Y2 yang ditunjukkan oleh koefisian jalur 

pada setiap diagram jalur dari hubungan kausal antar variabel tersebut. 

Misalnya kasus pengaruh investasi terhadap PDRB dan tenaga kerja di 

Provinsi ABC. Pada kasus ini dibuat terlebih dahulu model yang digambarkan 

dalam bentuk diagram penelitian dan model persamaan struktural sebagai 

berikut: 

Y1 = α + β1X1 + β2X2 + e1…………………………………………………………………..…M.6 

Y2 = α + β1X1 + β2X2 + β3Y1 + e2……………………………………………………………M.7 

Kemudian persamaan tersebut diubah menjadi persamaan dalam bentuk 

standar persamaan struktural yang distandarisasi sebagai berikut: 

Persamaan Struktur I: ZY1 = Z1X1 + Z2X2 + e1………………………………………M.8 

Persamaan Struktur II: ZY2 = Z1X1 + Z2X2 + Z3Y1 + e2…………………..………M.9 

Dimana : 

Y1  = Pertumbuhan Ekonomi (persen) 

Y2  = Penyerapan Tenaga Kerja (Juta) 

X1  = Penanaman Modal Dalam Negeri/PMDN (Trilyun Rupiah) 

X2  = Penanaman Modal Asing/PMA (Juta Dollar AS) 

Z  = Koefisien yang distandarkan (Standardized Coeffisient) 

e    = Variabel Pengganggu 

Membuat diagram jalur dan persamaan struktur 

Berdasarkan persamaan struktural I dan II maka dapat digambarkan 

diagram jalur sebagai berikut: 
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Jadi dari diagram jalur lengkap diatas dapat diambil 2 Sub Struktur yaitu 

untuk sub struktur 1 dan 2 diperoleh rumusan:  

Y1 = ρy1x1 X1 + ρy1x2 X2 + e1…………………..……………………………..M.10   

Y2 = ρy2x1 X1 + ρy2x2 X2 + ρy2y1Y1 + e2……………………..………..……M.11 

Lakukan perhitungan untuk persamaan M.10 dan M.11 dengan 

menggunakan program SPSS sebagai berikut: 

1. Buka data Analisis Jalur Dua Variabel Eksogen.sav 

 
2. Klik Analyze -> Regression -> Linear 
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3. Maka akan muncul kotak Linear Regression 

 
4. Isi variabel dependen dan independent sesuai dengan persamaan, untuk 

persamaan M.10. lalu klik statistics 
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5. Maka akan muncul kotak Linear Regression: Statistics, lalu aktifkan 

estimates, model fit, dan Descriptives lalu klik continue seperti gambar 

berikut: 

 
6. Maka akan muncul kembali kotak Linear Regression, lalu klik OK 

 
7. Maka akan muncul output berikut: 
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8. Untuk Persamaan M.11 maka lakukan kembali kilk Analyze -> Regression -

> Linear 
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9. Lalu masukan variabel Y1 ke Independen dan Y2 ke dependen. 

 
10. Klik Ok sehingga  muncul out put sebagai berikut: 

 
 

11. Interpertasi 

a. Persamaan Struktural I 

Hubungan (korelasi) antar variabel dapat dilihat pada tabel 

Correlations. Hubungan antara variabel PMDN (X1) dan PMA (X2) adalah 

positif dengan nilai koefisien korelasi sebesar 0,194 dan signifikan 

(0,273 > 0,05). Artinya dengan tingkat keeratan hubungan antara 

variabel PMDN (X1) dan PMA (X2) dalam kategori lemah dan tidak 

signifikan. 
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Hasil out put untuk persamaan M.10 menunjukan nilai R square 

(koefisien determinasi) sebesar 0,624 hal ini menunjukkan bahwa 

62,4% (0,195 x 100%) variasi variabel dependen (PMDN dan PMA) 

dapat dijelaskan oleh variabel independen (Pertumbuhan Ekonomi), 

sedangkan sisanya 37,6% (100% - 62,4%) dijelaskan oleh variabel 

independen lain yang tidak termasuk dalam model penelitian ini.  

 
Dari Uji Anova signifikansi F sebesar 0.012. Signifikan jika nilai 

signifikansi F < 0,05, jika sebaliknya maka tidak signifikan. 

 
Karena probabilitas lebih kecil dari 0,05 (0,012 < 0,05) maka model 

regresi dapat digunakan untuk memprediksi Y (pertumbuhan ekonomi) 

atau dapat dikatakan bahwa model regresi adalah model yang 

baik/layak (Goodness of fit) atau model teliti. 
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Dari tabel coefficient menghasilkan persamaan struktural I sebagai 

berikut: 

Y1 = 0,603 X1 + 0,407 X2  

1. Pengaruh PMDN (X1) terhadap pertumbuhan ekonomi (Y1) 

Hasil pengujian menunjukkan besarnya pengaruh variabel PMDN (X1) 

sebesar 0,603 terhadap pertumbuhan ekonomi (Y1)dengan signifikansi 

sebesar 0,018 yang berarti <0,05 atau signifikan. 

2. Pengaruh PMA (X1) terhadap pertumbuhan ekonomi (Y1) 

Hasil pengujian menunjukkan besarnya pengaruh variabel PMA (X1) 

sebesar 0,407 terhadap pertumbuhan ekonomi (Y1) dengan signifikansi 

sebesar 0,083 yang berarti >0,05 atau tidak signifikan. 

 

b. Persamaan Struktural II 

Hubungan (korelasi) antar variabel dapat dilihat pada tabel 

Correlations. Hubungan antara variabel PMDN (X1) dan PMA (X2) adalah 

positif degan nilai koefisien korelasi sebesar 0,194 dan signifikan (0,273 

> 0,05). Artinya dengan tingkat keeratan hubungan antara variabel 

PMDN (X1) dan PMA (X2) dalam kategori lemah dan tidak signifikan. 

 
Hasil out put untuk persamaan M.11 menunjukan nilai R square 

(koefisien determinasi) sebesar 0,829 hal ini menunjukkan bahwa 

82,9% (0,829 x 100%) variasi variabel dependen (PMDN, PMA dan 

pertumbuhan ekonomi) dapat dijelaskan oleh variabel independen 
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(tenaga kerja), sedangkan sisanya 17,1% (100% - 82,9%) dijelaskan 

oleh variabel independen lain yang tidak termasuk dalam model 

penelitian ini.  

 
Dari Uji Anova signifikansi F sebesar 0,002. Signifikan jika nilai 

signifikansi F < 0,05, jika sebaliknya maka tidak signifikan. 

 
Karena probabilitas lebih kecil dari 0,05 (0,002 < 0,05) maka model 

regresi dapat digunakan untuk memprediksi Y2 (penyerapan tenaga 

kerja) atau dapat dikatakan bahwa model regresi adalah model yang 

baik/layak (Goodness of fit) atau model teliti. 

 
Dari tabel coefficient menghasilkan persamaan struktural II sebagai 

berikut: 

Y2 = -0,211 X1 + 0,270 X2 + 0,859 Y1 

1. Pengaruh PMDN (X1) terhadap penyerapan tenaga kerja (Y2) 

Hasil pengujian menunjukkan besarnya pengaruh variabel PMDN (X1) 

sebesar -0,211 terhadap penyerapan tenaga kerja (Y2) dengan 

signifikansi sebesar 0,339 yang berarti >0,05 atau tidak signifikan. 

2. Pengaruh PMA (X1) terhadap penyerapan tenaga kerja (Y2) 
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Hasil pengujian menunjukkan besarnya pengaruh variabel PMA (X1) 

sebesar 0,270 terhadap penyerapan tenaga kerja (Y2) dengan 

signifikansi sebesar 0,168 yang berarti >0,05 atau tidak signifikan. 

3. Pengaruh pertumbuhan ekonomi (Y1) terhadap penyerapan tenaga 

kerja (Y2) 

Hasil pengujian menunjukkan besarnya pengaruh variabel 

pertumbuhan ekonomi (Y1) sebesar 0,859 terhadap penyerapan tenaga 

kerja (Y2) dengan signifikansi sebesar 0,007 yang berarti <0,05 atau 

signifikan. 

Berdasarkan persamaan struktural I dan II maka dapat digambarkan 

diagram jalur sebagai berikut: 

 

 

 

 

 

 

 

 

 

Untuk mengetahui pengaruh langsung, pengaruh tidak langsung dan total 

pengaruh dapat dirangkum dalam tabel 3.5 berikut ini: 

Tabel 3.5. Hasil Pengaruh Kausal Dengan Dua Variabel Eksogen 

Pengaruh Variabel 

Pengaruh Kausal 

Langsung 
Tidak Langsung 

Total 
Melalui Y1 

X1 terhadap Y1 0,603 - 0,603 

X1 terhadap Y2 -0,211 (0,603) (0,859) 0,307 

X2 terhadap Y1 0,407 - 0,407 

X2 terhadap Y2 0,207 (0,407) (0,859) 0,556 

Y1 terhadap Y2 0,859 - 0,859 

Keterangan : Interpertasi dan pembahasan lebih lanjut terkait dengan tabel 

3.5 diserahkan kepada pembaca sesuai dengan bidang keilmuannya masing-

masing dengan asumsi bahwa setiap persamaan sudah memenuhi asumsi 

yang disyaratkan dalam analisis jalur. 
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3. Aplikasi Analisis Jalur Dengan Tiga Variabel Eksogen 

Untuk analisis jalur menggunakan tiga variabel eksogen dapat dilihat pada 

kasus pengaruh investasi terhadap PDRB dan tenaga kerja di Provinsi ABC. 

Pada kasus ini dibuat terlebih dahulu model yang digambarkan dalam bentuk 

diagram penelitian dan model persamaan struktural sebagai berikut: 

Y1 = α + β1X1 + β2X2 + e1……………………………………………………………..…M.12 

Y2 = α + β1X1 + β2X2 + β3Y1 + e2………………………………………………………M.13 

Y3 = α + β1X1 + β2X2 + β3Y1 + β4Y2+ e3……………………………………………M.14 

Kemudian persamaan tersebut diubah menjadi persamaan dalam bentuk 

standar persamaan struktural yang distandarisasi sebagai berikut: 

Persamaan Struktur I: ZY1 = Z1X1 + Z2X2 + e1………………………………M.15 

Persamaan Struktur II: ZY2 = Z1X1 + Z2X2 + Z3Y1 + e2……….…………..M.16 

Persamaan Struktur II: ZY3 = Z1X1 + Z2X2 + Z3Y1 + Z3Y2 + e3……...…M.17 

Dimana : 

Y1  = Return Saham (persen) 

Y2  = Debt Equty Ratio/DER (Persen) 

Y2  = Deviden Payout Ratio/DPR (Persen) 

X1  = Return on Asset/ROA (Persen) 

X2  = Ukuran Perusahaan/UP (Log Natura Total Asset) 

Z  = Koefisien yang distandarkan (Standardized Coeffisient) 

e    = Variabel Pengganggu 

Membuat diagram jalur dan persamaan struktur 

Berdasarkan persamaan struktural I, II dan III maka dapat digambarkan 

diagram jalur sebagai berikut: 

 

 

 

 

 

 

 

 

 

 

 

 

 

ρy1x1

ρy1x2 

ρy2x1 

ρy2y1 

ρy3y2 

ρy3y1 

ρy1x2 

ρy3x2 

ρy3x1 
rx1x2 

UP (X2) 

DER (Y2) 

Return 

Saham 

(Y3) 

ROA (X1) 

e2 

e3 

DPR (Y1) 

e1 



Bab III Analisis Data Menggunakan Program SPSS 123 

Jadi dari diagram jalur lengkap diatas dapat diambil 2 Sub Struktur yaitu 

untuk sub struktur 1 dan 2 diperoleh rumusan:  

Y1 = ρy1x1 X1 + ρy1x2 X2 + e1…………………..……………………………..M.18   

Y2 = ρy2x1 X1 + ρy2x2 X2 + ρy2y1Y1 + e2……………………..………..…M.19 

Y3 = ρy3x1 X1 + ρy3x2 X2 + ρy3y1Y1 + ρy3y2Y2 + e3………………………M.20 

Lakukan perhitungan untuk persamaan M.18, M.19 dan M.20 dengan 

menggunakan program SPSS sebagai berikut: 

1. Buka data Analisis Jalur Tiga Variabel Eksogen.sav 

2. Klik Analyze -> Regression -> Linear 

3. Maka akan muncul kotak Linear Regression 

 
4. Isi variabel dependen dan independent sesuai dengan persamaan, untuk 

persamaan M.18. lalu klik statistics 
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5. Maka akan muncul kotak Linear Regression: Statistics, lalu aktifkan 

estimates, model fit, dan Descriptives lalu klik continue seperti gambar 

berikut: 

 
6. Maka akan muncul kembali kotak Linear Regression, lalu klik OK 

7. Maka akan muncul output berikut: 

 
8. Untuk Persamaan M.19 maka lakukan kembali kilk Analyze -> Regression -

> Linear 

9. Lalu masukan variabel Y1 ke Independen dan Y2 ke dependen. 
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10. Klik Ok sehingga  muncul out put sebagai berikut: 

 
11. Untuk Persamaan M.20 maka lakukan kembali kilk Analyze -> Regression -

> Linear 

12. Lalu masukan variabel Y2 ke Independen dan Y3 ke dependen. 
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13. Klik Ok sehingga  muncul out put sebagai berikut: 

 
14. Interpertasi 

a. Persamaan Struktural I 

Hubungan (korelasi) antar variabel dapat dilihat pada tabel 

Correlations. Hubungan antara variabel ROA (X1) dan UP (X2) adalah 

positif dengan nilai koefisien korelasi sebesar 0,574 dan signifikan 

(0,000 < 0,05). Artinya dengan tingkat keeratan hubungan antara 

variabel ROA (X1) dan UP (X2) dalam kategori sedang dan signifikan. 
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Hasil out put untuk persamaan M.18 menunjukan nilai R square 

(koefisien determinasi) sebesar 0,438 hal ini menunjukkan bahwa 

43,8% (0,438 x 100%) variasi variabel dependen (ROA dan UP) dapat 

dijelaskan oleh variabel independen (DPR), sedangkan sisanya 56,2% 

(100% - 43,8%) dijelaskan oleh variabel independen lain yang tidak 

termasuk dalam model penelitian ini.  

 
Dari Uji Anova signifikansi F sebesar 0,000. Signifikan jika nilai 

signifikansi F < 0,05, jika sebaliknya maka tidak signifikan. 

 
Karena probabilitas lebih kecil dari 0,05 (0,000 < 0,05) maka model 

regresi dapat digunakan untuk memprediksi Y (DPR) atau dapat 

dikatakan bahwa model regresi adalah model yang baik/layak 

(Goodness of fit) atau model teliti. 
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Dari tabel coefficient menghasilkan persamaan struktural I sebagai 

berikut: 

Y1 = 0,428 X1 + 0,416 X2  

1. Pengaruh ROA (X1) terhadap DPR (Y1) 

Hasil pengujian menunjukkan besarnya pengaruh variabel ROA (X1) 

terhadap DPR (Y1) sebesar 0,428 dengan signifikansi sebesar 0,000 yang 

berarti <0,05 atau signifikan. 

2. Pengaruh UP (X1) terhadap DPR (Y1) 

Hasil pengujian menunjukkan besarnya pengaruh variabel UP (X1) 

terhadap DPR (Y1) sebesar 0,416 dengan signifikansi sebesar 0,001 yang 

berarti >0,05 atau signifikan. 

b. Persamaan Struktural II 

Hasil out put untuk persamaan M.19 menunjukan nilai R square 

(koefisien determinasi) sebesar 0,233 hal ini menunjukkan bahwa 

23,3% (0,233 x 100%) variasi variabel dependen (ROA, UP dan DPR) 

dapat dijelaskan oleh variabel independen (DER), sedangkan sisanya 

76,7% (100% - 23,3%) dijelaskan oleh variabel independen lain yang 

tidak termasuk dalam model penelitian ini.  

 
Dari Uji Anova signifikansi F sebesar 0,000. Signifikan jika nilai 

signifikansi F < 0,05, jika sebaliknya maka tidak signifikan. 
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Karena probabilitas lebih kecil dari 0,05 (0,000 < 0,05) maka model 

regresi dapat digunakan untuk memprediksi Y2 (DER) atau dapat 

dikatakan bahwa model regresi adalah model yang baik/layak 

(Goodness of fit) atau model teliti. 

 
Dari tabel coefficient menghasilkan persamaan struktural II sebagai 

berikut: 

Y2 = -0,054X1 - 0,009X2 + 0,519Y1 

1. Pengaruh ROA (X1) terhadap DER (Y2) 

Hasil pengujian menunjukkan besarnya pengaruh variabel ROA (X1) 

terhadap DER (Y2) sebesar -0,054 dengan signifikansi sebesar 0,652 

yang berarti >0,05 atau tidak signifikan. 

2. Pengaruh UP (X2) terhadap DER (Y2) 

Hasil pengujian menunjukkan besarnya pengaruh variabel UP (X2) 

sebesar -0,009 terhadap DER (Y2) dengan signifikansi sebesar 0,937 

yang berarti >0,05 atau tidak signifikan. 

3. Pengaruh DPR (Y1) terhadap terhadap DER (Y2) 

Hasil pengujian menunjukkan besarnya pengaruh variabel DPR (Y1) 

sebesar 0,519 terhadap DER (Y2) dengan signifikansi sebesar 0,000 yang 

berarti <0,05 atau signifikan. 

c. Persamaan Struktural III 

Hasil out put untuk persamaan M.20 menunjukan nilai R square 

(koefisien determinasi) sebesar 0,292 hal ini menunjukkan bahwa 

29,2% (0,292 x 100%) variasi variabel dependen (ROA, UP, DPR dan 

DER) dapat dijelaskan oleh variabel independen (DER), sedangkan 

sisanya 70,8% (100% - 29,2%) dijelaskan oleh variabel independen lain 

yang tidak termasuk dalam model penelitian ini.  
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Dari Uji Anova signifikansi F sebesar 0,000. Signifikan jika nilai 

signifikansi F < 0,05, jika sebaliknya maka tidak signifikan. 

 
Karena probabilitas lebih kecil dari 0,05 (0,000 < 0,05) maka model 

regresi dapat digunakan untuk memprediksi Y3 (Return Saham) atau 

dapat dikatakan bahwa model regresi adalah model yang baik/layak 

(Goodness of fit) atau model teliti. 

 
Dari tabel coefficient menghasilkan persamaan struktural II sebagai 

berikut: 

Y2 = -0,078X1 + 0,239X2 + 0,360Y1 + 0,109Y2 

1. Pengaruh ROA (X1) terhadap Return Saham (Y3) 

Hasil pengujian menunjukkan besarnya pengaruh variabel ROA (X1) 

terhadap Return Saham (Y3) sebesar -0,078 dengan signifikansi sebesar 

0,505 yang berarti >0,05 atau tidak signifikan. 

2. Pengaruh UP (X2) terhadap Return Saham (Y3) 

Hasil pengujian menunjukkan besarnya pengaruh variabel UP (X1) 

sebesar 0,239 terhadap Return Saham (Y3) dengan signifikansi sebesar 

0,035 yang berarti <0,05 atau signifikan. 

3. Pengaruh DPR (Y1) terhadap Return Saham (Y3) 

Hasil pengujian menunjukkan besarnya pengaruh variabel DPR (Y1) 

sebesar 0,360 terhadap Return Saham (Y3) dengan signifikansi sebesar 

0,005 yang berarti <0,05 atau signifikan. 

3. Pengaruh DER (Y2) terhadap Return Saham (Y3) 
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Hasil pengujian menunjukkan besarnya pengaruh variabel DER (Y2) 

sebesar 0,109 terhadap Return Saham (Y3) dengan signifikansi sebesar 

0,272 yang berarti >0,05 atau tidak signifikan. 

Berdasarkan persamaan struktural I dan II maka dapat digambarkan 

diagram jalur sebagai berikut, 

 

 

 

 

 

 

 

 

 

 

 

 

 

Untuk mengetahui pengaruh langsung, pengaruh tidak langsung dan total 

pengaruh dapat dirangkum dalam tabel 10.3 berikut ini: 

Tabel 3.4. Hasil Pengaruh Kausal Dengan Tiga Variabel Eksogen 

Pengaruh 

Variabel 

Pengaruh Kausal 

Langsung 
Tidak Langsung 

Total 
Melalui Y1 Melalui Y2 Melalui Z 

X1 terhadap Y1 (0,428) - - - 0,428 
X1 terhadap Y2 (-0,054) (0,428) x 

(0,519) 
- - 0,618 

X1 terhadap Y3 (-0,078) (0,428) x 
(0,360) 

(-0,054) x  
(0,109) 

(0,428) x  
(0,519) x 
(0,109) 

0,094 

X2 terhadap Y1 (0,416) - - - 0,416 
X2 terhadap Y2 (-0,009) (0,416) x  

(0,519) 
- - 0,206 

X2 terhadap Y3 (0,239) (0,416) x  
(0,360) 

(-0,009) x 
(0,109) 

(0,416) x 
(0,519) x  
(0,109) 

-0,066 

Y1 terhadap Y2 (0,519) - - - 0,519 
Y1 terhadap Y3 (0,360) - (0,519) x 

(0,109) 
- 0,416 

Y2 terhadap Y3 (0,109) - - - 0,109 

0,428

3 
0,416 

-0,054 

0,519 

0,109 

0,360 

-0,009 

0,239 

-0,078 
0,574 

UP (X2) 

DER (Y2) 

Return 

Saham 

(Y3) 

ROA (X1) 
DPR (Y1) 

0,562 

0,708 

0,767 
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BAB IV  

ANALISIS DATA MENGGUNAKAN  

PROGRAM EVIEWS  
 

 

 

 

 

A. PENGENALAN PROGRAM EVIEWS 
EViews merupakan salah satu program computer yang menyediakan alat 

analisis, regresi, dan peramalan data yang canggih pada komputer berbasis 

Windows. Dengan EViews, kita dapat dengan cepat mengembangkan 

hubungan statistik dari data Anda dan kemudian menggunakan hubungan 

tersebut untuk memperkirakan nilai data di masa mendatang. Area di mana 

EViews dapat berguna meliputi: analisis dan evaluasi data ilmiah, analisis 

keuangan, peramalan makroekonomi, simulasi, peramalan penjualan, dan 

analisis biaya.  

Awalnya program ini dibangun oleh Quantitative Micro Software (QMS) 

lalu kemudian dikembangkan oleh MicroTSP, yang pertama kali dirilis pada 

tahun 1981. Meskipun EViews dikembangkan oleh para ekonom dan sebagian 

besar penggunaannya dalam bidang ekonomi, namun dalam aplikasinya tidak 

ada batasan dalam desainnya yang membatasi kegunaannya untuk deret 

waktu ekonomi. Aplikasi program ini dalam operasinnya dapat menggunakan 

perintah dengan menggunakan bahasa program yang terdapat dalam 

“command window” atau dengan metode klik 
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B. MEMUNCULKAN LAYAR EVIEWS 

Sebelum melakukan analisis terhadap berbagai data, perlu memasukan 

(input) data ke dalam program Eviews. Pada Eviews versi 8 (Eviews 8) maka 

ada beberapa hal yang harus diperhatikan sebagai berikut: 

1. Buka program Eviews 

 
2. Buka program Eviews, maka akan muncul Kotak seperti berikut: 

 

 

Menu utama Jendela eviews yang menjadi bagian utama dalam 

mengoprasikan eviews. Menu utama terdiri dari File, 

Edit, Object, View, Proc, Quick, Options, Add-ins, 

Windows, dan Help. Jika kita mengklik setiap bagian dari 

jendela ini maka akan muncul sub menu yang memiliki 

fungsi khusus dalam mengoperasikan eviews. Misal 

“File”, maka Ketika kita klik maka akan muncul printah 
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untuk fungsi Undo, Cut, Copy, Copy Special dan lainnya. 

Command 

Window 

Tempat untuk memberikan perintah dalam bentuk 

bahasa program untuk menganalisis data tertentu. 

Contoh: series lgdp (ini maksudnya membuat variable 

lgdp) 

Area Kerja Area di tengah jendela adalah area kerja di mana EViews 

akan menampilkan berbagai objek jendela yang 

dibuatnya. Coba anda bayangkan, jendela ini mirip 

dengan lembaran kertas yang mungkin Anda letakkan di 

meja saat Anda bekerja. Jendela akan saling tumpang 

tindih dengan jendela terdepan dalam fokus atau aktif. 

 

C. MEMASUKKAN DATA 
 

1. Untuk memasukan data, anda dapat membuat working file. Caranya 

dengan klik File -> New -> Workfile. 
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2. Sebelum kita melakukan pengisian maka ada beberapa hal yang peru 

diperhatikan. 

a. Tipe dari Struktur Data (Working Structure Type) 

 
Unstrctured/Undate 

Data 

data yang tidak memiliki pola yang teratur, 

Contoh penting dari data yang tidak teratur 

ditemukan pada harga saham dan obligasi, di 

mana adanya hari-hari yang hilang karena hari 

libur dan penutupan pasar lainnya berarti bahwa 

data tersebut tidak mengikuti frekuensi harian (7 

atau 5 hari) yang teratur. 
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Date – regular 

frequency 

Data yang memiliki pola yang teratur (harian, 

bulanan, triwulan, tahunan, dan lain-lain). 

Contohnya data PDB triwulan. 

 

 
 

Balanced Panel Gabungan data cross section dan time series, 

dimana jumlah unit dan waktu sama pada setiap 

individu. 

 

 
 

 

b. Data Specification 

Pemberian keterangan frekuensi pada data dengan pola data teratur 

(Date – regular frequency dan Balanced Panel) sebagai berikut: 
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Jenis Data Keterangan Cara Pengisian 

Annual Data Tahunan Start Date: 2015 

End Date : 2020 

Semi-Annual Data untuk semester 

(6 bulanan) 

Start Date: 2015:1 

End Date : 2020:2 

Quarterly Data triwulan (3 

bulanan) 

Start Date: 2015:1 

End Date : 2020:4 

Monthly Data bulanan Start Date: 2015:1 

End Date : 2020:12 

Weekly Data mingguan Start Date: 1/1/2015 

End Date : 12/31/2020 

Daily – 5 days week Data untuk 5 hari 

seminggu dari Senin 

hingga Jumat 

Start Date: 1/1/2015 

End Date : 12/28/2020 

Daily – 7 days week Data untuk 7 hari 

seminggu dari Senin 

hingga Minggu 

Start Date: 1/1/2015 

End Date : 12/31/2020 
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3. Misal kita memiliki data sebagai berikut:  

Tahun 
PDB (miliar Rp) 

Investasi 

Swasta 

(miliar Rp) 

Konsumsi 

Pemerintah 

(miliar Rp) 

Pendidikan 

(miliar Rp) 

Y X1 X2 X3 

1984 

          

649,837.46            3,318.99  

          

9,428.90            1,021.70  

1985 

          

665,671.76            3,994.22  

        

11,951.50            1,314.00  

1986 

          

747,875.82            5,439.78  

        

13,559.30                839.00  

1987 

          

785,298.85          13,449.56  

        

17,481.00                463.00  

1988 

          

830,315.84          23,333.34  

        

20,739.00                370.00  

1989 

          

892,633.56          32,536.61  

        

24,331.00            1,683.00  

1990 

          

957,280.15          76,514.05  

        

29,998.00            2,065.00  

1991 

      

1,023,813.59          58,570.97  

        

30,227.00            2,503.00  

1992 

      

1,089,945.74          50,607.52  

        

33,605.00            3,002.00  

1993 

      

1,160,753.06          56,631.08  

        

40,290.00            3,565.00  

1994 

      

1,297,667.99        105,482.56  

        

44,069.00            3,061.00  

1995 

      

1,404,336.40        161,976.13  

        

50,435.00            3,359.00  

1996 

      

1,514,130.05        172,041.73  

        

62,561.00            3,970.00  

1997 

      

1,585,292.32        277,194.03  

        

89,610.00            4,677.00  

1998 

      

1,377,195.35        169,593.18  

      

147,717.00            8,368.00  

1999 

      

1,388,090.70        130,873.26  

      

156,800.00            8,381.00  

2000 

      

1,456,385.71        240,365.30  

      

161,400.00            5,397.00  

2001 

      

1,442,984.60        215,397.36  

      

218,900.00            9,701.00  

2002 

      

1,506,124.40        112,822.15  

      

189,300.00          11,307.00  

2003             160,283.75                15,058.00  
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1,577,171.30  190,300.00  

2004 

      

1,656,516.80        132,639.74  

      

237,700.00          15,339.00  

2005 

      

1,750,815.20        118,318.13  

      

267,008.00          25,987.00  

2006 

      

1,847,126.70          74,700.94  

      

325,189.00          43,287.00  

2007 

      

1,964,327.30        132,361.58  

      

348,435.00          54,067.00  

2008 

      

2,082,456.10        183,205.23  

      

532,514.00          61,410.00  

2009 

      

2,178,850.40        139,462.78  

      

440,202.00          89,918.00  

2010 

      

2,314,458.80        206,413.57  

      

526,765.00          84,086.00  

2011 

      

2,464,566.10        252,595.47  

      

652,291.70          91,483.00  

2012 

      

2,613,180.68        329,722.65  

      

681,819.00        103,667.00  

2013 

      

2,758,975.55        476,969.31  

      

729,059.63        118,467.00  

Data yang digunakan adalah data time series dengan jenis data Annual 

(1983 – 2013).  
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4. Klik OK  
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Pilih Type of Obyek: Series 

Name for obyek: Y (keterangan: nama terserah masing-masing, misalnya 

kita ganti PDB juga bisa) 

Klik OK 
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5. Klik Y 

 

6. Lakukan hal yang sama untuk variable X1, X2 dan X3 sehingga menjadi 

seperti ini: 
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7. Blok variable Y, X1, X2 dan X3, klik kanan lalu pilih as group 
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8. Masukan data dengan copy – paste dari file excel Data Regeresi Eviews 

(Sheet: data1). 
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9. Data siap untuk dianalisis. Meskipun ada juga cara menginput data 

dengan mengimport data langsung dari file excel ke eviews. 

 

D. MENYIMPAN HASIL INPUT DATA 
3. Jika file inputan data ingin disimpan klik File -> Save As. Lalu simpan di 

folder yang diinginkan. 

. 
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4. Klik OK. 

 
 

E. GRAFIK 
Menggunakan data dari file inputan data1, kita dapat membuat grafik 

sesuai dengan kebutuhan kita masing-masing. Misalnnya membuat grafik 

untuk variable Y sebagai berikut: 
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F. STATISTIK DESKRIPTIF 
Menggunakan data dari file inputan data1, kita akan melakukan analisis 

statistic deskriptif untuk variable Y, X1, X2 dan X3 sebagai berikut: 

Mean Nilai rata-rata variable 

Median Nilai tengah 

Maximum Nilai tertinggi dari variable 

Minimum Nilai terendah dari variable 

Std. Dev. Tingkat rata-rata penyimpangan data terhadap meannya 

Skewness Tingkat distribusi data 

Jarque-Bera &  

Probabilit 

Digunakan untuk uji kesesuaian untuk mengetahui apakah 

data sampel memiliki kemiringan dan kurtosis yang cocok 

dengan distribusi normal 

Sum Total variabel 

Sum Sq. Dev Sum (Variabel^2) 

Observation Banyaknya data yang dianalisis 
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Jika ingin mengcopy data hasil analsisi statistic deskriptif ke file word, maka 

dapat dilakukan dengan cara sebagai berikut: 

1. Klik cell bagian atas hingga terblok seluruh bagian seperti ini: 

 
2. Lalu klik kanan, copy 

 
3. Pilih Formatted -> OK. Lalu paste ke file word yang diinginkan dengan 

klik unformat 
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Jika ingin menyimpan hasil statistic deskriptif, maka dapat dilakukan 

dengan klik Freeze, lalu Klik Name 
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G. ANALISIS REGRESI 
Menggunakan data dari file inputan data1, kita akan melakukan analisis 

regresi untuk variable Y (variable dependen), X1, X2 dan X3 (variable 

independent) sebagai berikut: 
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1. Buka file inputan data1 

 
2. Klik Quick -> Estimate Equation 
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3. Lalu isi kotak dengan kode [ y c x1 x2 x3 ], lalu klik OK 

 
4. Hasilnya sebagai berikut: 
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5. Untuk interpertasi data dapat dilihat pada bab sebelumnya di Bab X. 

Analisis Data Menggunakan Program SPSS. Namun penjelasannya 

tambahan sebagai berikut: 

Akaike info criterion (AIC), Schwarz criterion (SC) dan Hannan-Quinn 

criterion (HQC) = Digunakan untuk menguji kelayakan model selain 

menggunakan Uji F. Semakin kecil AIC, SC dan HQC maka semakin baik 

modelnya. 

6. Jika menginginkan grafik yang menunjukan data dan prediksi serta 

residual regresinya maka caranya klik Resids: 

  

7. Sedangkan untuk persamaan regresi caranya dengan klik View -> 

Representations 
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H. UJI ASUMSI KLASIK 
Untuk asumsi klasik yang terdiri dari Autokolerasi, Multikolinearitas, dan 

Heterokedaktasitas maka dianalisis dengan cara sebagai berikut: 

1. Uji Lineritas 

Untuk mengetahui apakah variabel bebas linear atau tidak terhadap 

variabel terikat dapat menggunakan uji Ramsey Reset Test. Caranya 

sebagai berikut: 

 
 

 
 

Interpretasi Output : hasil dari uji Ramsey Reset Test adalah Nilai p value 

yang ditunjukkan pada kolom probability baris F-statistics adalah sebesar 

0.0000 (Likelihood Ratio = 25.64280), artinya lebih besar dari tingkat 

alpha 0,05 sehingga dapat disimpulkan bahwa variabel bebas tidak linear 

dengan variabel terikat. 

2. Uji Normalitas 

Untuk mengetahui apakah residual data berdistribusi normal atau tidak 

dapat menggunakan Jerque Bera (JB). Caranya sebagai berikut: 

Pada tampilan output eviewes, klik View -> Resudual Diagnostics -> 

Histogram – Normality Test 



158 Laboratorium Statistik 

  
Interpertasi output: jika probabilitas JB lebih >5% maka berdistribusi 

normal, Jika lebih kecil <5% maka tidak berdistribusi normal. Hasil 

menunjukan probabilitas JB sebesar 0.388964 atau >5% maka 

disimpulkan data berdistribusi normal. 

3. Autokolerasi 

Untuk autokorelasi dapat menggunakan uji Durbin Watson.  

 
Kriterianya yang digunakan adalah sebagai berikut: 

Keputusan Kriteria 

Ada autokrelasi positif 0 < d < dL 

Tidak ada autokrelasi positif dL ≤ d ≤ dU 

Ada autokrelasi negatif 4 - dL < d < 4 

Tidak ada autokrelasi negatif 4 – dU ≤ d ≤ 4 – dL 

Tidak ada autokrelasi negative & positif dU < d < 4 – dU 

Keterangan: dU = durbin watson upper; dL = durbin watson lower 

Interpertasi output: nili durbin Watson sebesar 0.581934. 
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Untuk mengetahui ada autokrelasi perlu melihat table durbin Watson 

untuk mendapatkan nilai dU dan dL. Diketahui variable dependen ada 3 

(X1, X2 dan X3), Jumlah Observasi ada 30. Misalkan digunakan tingkat 

signifikansi 0,05. Maka table durbin Watson sebagai berikut: 

K = variable independent; N = jumlah observasi 

 
Berdasarkan table durbin Watson maka diperoleh dU = 1.2138; dL = 

1.6498; sehingga masuk dalam keputusan: 0 < 0.581934 < 1.6498 (Ada 

autokrelasi positif). 

4. Multikolinearitas 

Untuk mengetahui ada tidaknya multikolinearitas dapat menggunakan 

nilai VIF (variance infation factor). Uji Multikolinearitas bertujuan untuk 

menguji apakah dalam model regresi ditemukan adanya korelasi yang 

tinggi atau sempurna antar variabel independent. Caranya klik View -> 

Coefficient Diagnostics -> Variance Inflation Factors. Jika nilai VIF > 

10 aka terjadi multikolinearitas. 
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5. Heterokedaktasitas 

Untuk mengetahui ada tidaknya heterokedaktasitas salah satunya dapat 

menggunakan Uji Breusch-Pagan-Godfrey. Cara klik View -> Residual 

Diagnostics -> Heterokedaktasitas Tests. Pilih Breusch-Pagan-

Godfrey lalu OK. 
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Jika nilai probabilitas > 0.05 maka tidak ada masalah heteroskedastisitas, 

sebaliknya jika nilai probabilitas < 0.05 maka ada masalah 

heteroskedastisitas. Berdasarkan hasil uji Breusch-Pagan-Godfrey 

menunjukkan nilai probabilitas lebih besar dari Alpha (0.05) yaitu 

0.1999. Jadi disimpulkan bahwa tidak terdapat masalah 

heteroskedastisitas pada data ini. 

 

I. REGRESI DATA PANEL 
Data panel merupakan gabungan dari data cross section dan time series. 

Data panel membantu para peneliti untuk mengeksplorasi kegeiatan para 

pelaku ekonomi tidak hanya antara invdividu, perusahaan, atau negara tetapi 

perialku ekonomi lintas waktu. Secara pragmatis, penggunaan data panel lebih 

kepada persoalan terkesediaan data yang terbatas. Misal penggunaan data 

time series, dimana waktu yang digunakan hanya 5 tahun (pendek) sehingga 

analisis data menggunakan data time series dengan data minim jadi tidak 

dapat dilakukan. Disisi lain, misalnya kita menggunakan data cross section 

tetapi memiliki jumlah unit analisis yang terbatas. Oleh karena itu, data panel 

dapat menjadi solusi dalam menghadapi keterbatasan data tersebut sehingga 
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jumlah observasi dapat meningkat secara signifikan tanpa melakukan 

treatment apapun terkait dengan data yang digunakan. 

1. Kelebihan Data Panel 

Kelebihan dalam menggunaka data panel dibandingkan dengan data cross 

section dan time series adalah sebagai berikut: 

i. Data panel mampu mengontrol heterogenitas individu. Data panel 

menunjukkan bahwa individu, perusahaan, negara bagian, atau 

negara adalah heterogen. Analsis menggunakan data time-series dan 

cross-section yang tidak mengendalikan heterogenitas ini berisiko 

mendapatkan hasil yang bias. 

ii. Data panel memberikan data yang lebih informatif, lebih banyak 

variabilitas, lebih sedikit kolinearitas antar variabel, lebih banyak 

derajat kebebasan, dan lebih efisien. Misalnya analsisi menggunakan 

data time-series terganggu dengan multikolinearitas. 

iii. Data panel lebih mampu mempelajari the dynamics of adjustment. 

Distribusi cross-sectional yang terlihat relatif stabil 

menyembunyikan banyak perubahan. Misal mobilitas tenaga kerja, 

pengangguran, perumahan, pendapatan lebih baik dipelajari dengan 

panel. Data panel juga cocok untuk mempelajari durasi keadaan 

ekonomi seperti pengangguran dan kemiskinan, dan jika panel ini 

cukup panjang, karena data panel dapat menjelaskan kecepatan 

penyesuaian terhadap perubahan kebijakan ekonomi. 

iv. Model data panel memungkinkan kita untuk membangun dan 

menguji model perilaku yang lebih rumit daripada data cross-section 

atau time-series yang menimbulkan bias akibat dari adanya agregasi 

data individu. Bias yang dihasilkan dari agregasi atas perusahaan 

atau individu dapat dikurangi atau dihilangkan. 

2. Struktur Data Panel (Unstacked vs Stacked) 

Penyusunan struktur data panel dapat dibagi menjadi 3 struktur data 

yaitu Undated, Stacked dan Unstacked. 

i. Undated 

Cara pembuatan struktur data Undated pada program eviews 

dilakukan sebagai berikut: 

BANK ID TAHUN IC RESIKO 
PROFI

T 

PT. BANK RAKYAT INDONESIA 

AGRONIAGA, Tbk 
BRIA 2011 

2.25758

6 
0.15 11.39 

PT. BANK RAKYAT INDONESIA 

AGRONIAGA, Tbk 

BRIA 
2012 

2.40895

2 
0.19 10.26 
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PT. BANK RAKYAT INDONESIA 

AGRONIAGA, Tbk 

BRIA 
2013 

2.45265

2 
0.17 8.89 

PT. BANK RAKYAT INDONESIA 

AGRONIAGA, Tbk 

BRIA 
2014 

2.36734

1 
0.16 7.05 

PT. BANK RAKYAT INDONESIA 

AGRONIAGA, Tbk 

BRIA 
2015 

2.41647

4 
0.15 7.65 

PT. BANK ANTAR DAERAH 
BAN

D 
2011 

1.98080

4 
0.24 7.73 

PT. BANK ANTAR DAERAH 
BAN

D 
2012 

1.94335

6 
0.25 9.51 

………………………………………………

. 
……… ……… ………… ……… …….. 

………………………………………………

. 
……… ……… ………… ……… …….. 

PT. BANK RESONA PERDANIA 2014 2014 
4.95914

1 
0.08 9.53 

PT. BANK RESONA PERDANIA 2015 2015 4.06437 0.04 7.42 

PT. BANK WINDU KENTJANA 

INTERNATIONAL, Tbk 
2011 2011 

3.78348

2 
0.57 7.24 

PT. BANK WINDU KENTJANA 

INTERNATIONAL, Tbk 
2012 2012 

2.89336

4 
0.17 15.91 

PT. BANK WINDU KENTJANA 

INTERNATIONAL, Tbk 
2013 2013 

2.58480

1 
0.18 10.79 

PT. BANK WINDU KENTJANA 

INTERNATIONAL, Tbk 
2014 2014 

1.94129

4 
0.15 5.28 

PT. BANK WINDU KENTJANA 

INTERNATIONAL, Tbk 
2015 2015 

2.08730

7 
0.17 6.21 

Keterangan: data lengkap dapat dilihat pada Lampiran 1. Contoh 

Data Panel. 

Buat New workfile -> pada working file structure type pilih 

Unstructured/Undated -> isi observations 190. Data 190 diperoleh 

dari jumlah bank (individu) sebanyak 38 dikali dengan jumlah waktu 

(5 tahun / 2011-2015). 
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Hasil proses berikutnya adalah lembar workfile kosong diisi. Jika 

kita liat maka workfile ada sebanyak 190 observasi, namun tidak 

dibagi berdasarkan menurut bank dan tahun sebagaimana 

Lampiran 1. Contoh Data Panel. Data ini nantinya tidak akan 

konsisten dengan penyesuaian waktu, penggunaan lag (misal lag -

1), pengujian autokorelasi. 
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ii. Unstacked 

Contoh struktur data unstacked dapat dilihat sebagai berikut: 

 Keterangan: data lengkap dapat dilihat pada Lampiran 1. Contoh 

Data Panel. 
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Cara pembuatan di eviews sebagai berikut: 

Buat New workfile -> pada working file structure type pilih Dated - 

regural frequency-> isi tahun Start Date 2011 dan End date 2015. 

Data ini nantinya akan konsisten dengan penyesuaian waktu, 

penggunaan lag (misal lag -1), pengujian autokorelasi. 
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iii. Stacked 

Struktur data stacked dapat dilihat pada Lampiran 1. Contoh Data 

Panel. Untuk penginputan di eviews dapat dilakukan sebagai berikut: 
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Pada bagian cross section identitifer, kita diminta untuk mengisi 

nama individu (bank). Sebagiknya diisi dengan menggunakan kode. 

Misal PT. BANK RAKYAT INDONESIA AGRONIAGA, Tbk diisi dengan 

kode BRIA. Urutannya sesuai dengan data inputan sebagaimana 

Lampiran 1. Contoh Data Panel 
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3. Model Data Panel 

Ada tiga bentuk model data panel yaitu model common effect (CEM), 

model fixed effect (FEM) dan model random effect (REM).  

i. Model Common Effect (CEM) 

Model ini merupakan model yang paling sederhana. Model ini dalam 

estimasinya mengasumsikan bahwa setiap unit individu memiliki 

intersep atau slop yang sama. Jadi regresi yang dihasilkan oleh data 

berlaku untuk setiap unit individu sehingga tidak ada perbedaan 

karateristik individu dan waktu. Model ini biasanya menggunakan 

pendekatan panel Ordinary Least Square (OLS). 

ii. Model Fixed Effect (FEM) 

Berbeda dengan CEM atau OLS, model fixed effect dalam estimasinya 

mengasumsikan bahwa setiap unit individu (38 bank) memiliki intersep 

atau slop yang berbeda (misal menggunakan data pada Lampiran 1. 

Contoh Data Panel). Perbedaan ini dapat disebebkan adanya karateristik 

khusus yang dimiliki setiap bank, misal dalam hal aktivitas manageria. 

Jadi model ini mengakomodir “individualitas” masing-masing inidvidu 

(bank) dengan membuat intersep yang bervariasi namun tetap 

mengasumsikan koefisien slop konstan untuk setiap bank. Oleh karena 
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itu, disebut fixed effect karena adanya time invariant yaitu intersep 

berbeda untuk setiap bank, tetapi tidak bervariasi terhadap waktu. 

iii. Model Random Effect (REM) 

Jika dalam model fixed effect bahwa nilai perbedaan individu (yang 

ditunjukan sebagai unobserved factor) dapat berkorelasi dengan variable 

bebas, maka dalam random effect justru sebaliknya. Jadi model random 

effect akan mengestimasi data dimana variable gangguan mungkin saling 

berhubungan antarwaktu dan antarindividu. Oleh karena itu, model 

random effect akan memasukan unobserved factor dan disturbance error 

dalam komponen error agar tidak ada korelasi antara unobserved factor 

dengan peubah eksogen. 

4. Penentuan Model Terbaik 

Dalam analisis regresi data panel ada tiga model yang dapat digunakan 

yaitu model common effect (CEM), model fixed effect (FEM) dan model 

random effect (REM). Namun untuk memnentukan mana dari ketiga model 

tersebut yang terbaik dalam analsisi data maka dilakukan pengujian. Ada pun 

prosedur pengujian model terbaik sebagai berikut: 

i. Uji Chow 

Uji chow digunakan untuk menentukan model terbaik antara model 

common effect (CEM) dengan model fixed effect (FEM). Ketentuan jika 

dalam hasil output chow-test/likelihood ratio test menunjukan F test 

maupun chi-square signifikan (< 0.05 atau lebih kecil dari <0.05) maka 

model fixed effect (FEM) lebih baik dibandingkan model common effect 

(CEM). Jika sebaliknya maka hasil menunjukan tidak signifikan maka 

model terbaik yang dipilih adalah model common effect (CEM) sehingga 

dapat langsung dipilih untuk interpertasi tanpa harus menuju tahapan 

pengujian selanjutnya yaitu Uji Hausman. 

ii. Uji Hausman 

Uji hausman digunakan untuk menentukan model terbaik antara model 

fixed effect (FEM) dengan model random effect (REM). Uji dilakukan jika 

dalam uji chow ditemukan adanya hasil yang signifikan sehingga FEM 

lebih baik dibandingkan CEM. Ketentuan dalam uji Hausman adalah jika 

dalam hasil output Hasuman Test menunjukan F test maupun chi-square 

signifikan (< 0.05 atau lebih kecil dari <0.05) maka model fixed effect 

(FEM) lebih baik dibandingkan model random effect (REM). Sebaliknya, 

jika tidak signfikan maka REM menjadi pilihan terbaik. 
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5. Analisis Data Panel dengan Program Eviews 

Untuk melakukan analisis data panel dengan menggunakan program 

Eviews dapat diukuti dengan tahapan sebagai berikut: 

i. Dalam analisis data panel ini akan menggunakan data yang terdapat pada 

Lampiran 1. Contoh Data Panel. Pada data tersebut terdapat 38 bank 

dengan waktu analysis 5 tahun (2011 – 2015). Variabel dependen = IC 

(intelektual capital). Variable independent = Resiko dan Profit. Semua 

variable dalam satuan persen. 

ii. Input data dengan membuat New workfile -> pada working file structure 

type pilih Dated - regural frequency-> isi tahun Start Date 2011 dan End 

date 2015.  
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iii. Jika data sudah terinput maka tahapan selanjutnya adalah klik Estimate -

> isi Pool Estimation. Ini adalah proses analisis untuk model common 

effect (CEM). 

 
 

Dependent Variable: IC_?  

Method: Pooled Least Squares  

Date: 08/14/21   Time: 10:20  

Sample: 2011 2015   

Included observations: 5  

Cross-sections included: 38  

Total pool (balanced) observations: 190 

          
Variable Coefficient Std. Error t-Statistic Prob.   
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C 3.865013 0.364920 10.59140 0.0000 

RESIKO_? -9.481193 2.010041 -4.716916 0.0000 

PROFIT_? 0.058795 0.009111 6.453305 0.0000 

          
R-squared 0.280528     Mean dependent var 2.911546 

Adjusted R-squared 0.272833     S.D. dependent var 2.274983 

S.E. of regression 1.939971     Akaike info criterion 4.178887 

Sum squared resid 703.7721     Schwarz criterion 4.230155 

Log likelihood -393.9942     Hannan-Quinn criter. 4.199655 

F-statistic 36.45635     Durbin-Watson stat 1.452019 

Prob(F-statistic) 0.000000    

           

 

iv. Tahapan selanjunya adalah analysis dengan menggunakan model fixed 

effect (FEM), caranya klik Estimate -> ganti Cross-section menjadi Fixed 

Effect -> OK. 

 
 

Dependent Variable: IC_?  

Method: Pooled Least Squares  

Date: 08/14/21   Time: 10:24  

Sample: 2011 2015   

Included observations: 5  

Cross-sections included: 38  

Total pool (balanced) observations: 190 

          
Variable Coefficient Std. Error t-Statistic Prob.   



176 Laboratorium Statistik 

          
C 2.929459 0.423557 6.916336 0.0000 

RESIKO_? -2.852495 2.489488 -1.145816 0.2537 

PROFIT_? 0.047186 0.010416 4.530118 0.0000 

Fixed Effects 

(Cross)     

BRIA--C -0.507986    

BAND--C -0.830025    

BAGI--C -0.820305    

BUKO--C 3.189631    

BUAR--C -0.545931    

BBCA--C 0.810332    

BCIN--C -0.010423    

BDAN--C -0.119403    

BEKO--C -0.850093    

BAGA--C -0.806234    

BAHA--C 0.553238    

BICB--C -2.353679    

ICBC--C 0.203688    

BIDX--C -0.143023    

BBII--C -0.117549    

BAMS--C -0.687969    

MAYA--C -0.191676    

BMEG--C -0.283069    

BMES--C 1.447849    

BMEX--C -0.621642    

BUTI--C -0.191782    

BNPS--C -0.563981    

OCBC--C -0.021472    

BIND--C 2.348372    

BPAN--C 0.888900    

BPER--C -0.738481    

BQNB--C -0.852314    

BSBI--C -2.301051    

BSIN--C 0.393382    

BUOB--C -0.166266    

BNPP--C 1.413945    

BCOM--C -0.732136    
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BAGR--C -1.004181    

BCAP--C -0.339539    

BKEB--C 3.947636    

BRAB--C -1.639732    

BRES--C 2.235693    

BWIN--C 0.007279    

          
 Effects Specification   

          
Cross-section fixed (dummy variables) 

          
R-squared 0.551836     Mean dependent var 2.911546 

Adjusted R-squared 0.435313     S.D. dependent var 2.274983 

S.E. of regression 1.709550     Akaike info criterion 4.095002 

Sum squared resid 438.3843     Schwarz criterion 4.778586 

Log likelihood -349.0252     Hannan-Quinn criter. 4.371912 

F-statistic 4.735868     Durbin-Watson stat 2.339463 

Prob(F-statistic) 0.000000    

           

 

v. Tahapan selanjutnya adalah melakukan uji chow untuk memilih model 

terbaik antara CEM atau FEM. Hasil analisis menunjukan bahwa F test 

maupun chi-square signifikan (< 0.05 atau lebih kecil dari <0.05) maka 

model fixed effect (FEM) lebih baik dibandingkan model common effect 

(CEM). 
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vi. Setelah melakukan uji chow, dimana hasil terbaik adalah model fixed 

effect (FEM) maka tahapan selanjutnya melakukan analisis dengan model 

random effect (REM). caranya klik Estimate -> ganti Cross-section 

menjadi Random Effect -> OK. sebagai berikut: 
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Dependent Variable: IC_?  
Method: Pooled EGLS (Cross-section random effects) 
Date: 08/14/21   Time: 10:41  
Sample: 2011 2015   
Included observations: 5  
Cross-sections included: 38  
Total pool (balanced) observations: 190 
Swamy and Arora estimator of component variances 

          
Variable Coefficient Std. Error t-Statistic Prob.   

          
C 3.535087 0.385992 9.158435 0.0000 

RESIKO_? -7.149346 2.058818 -3.472548 0.0006 
PROFIT_? 0.054801 0.009053 6.053107 0.0000 

Random Effects 
(Cross)     
BRIA--C -0.253381    
BAND--C -0.312892    
BAGI--C -0.463008    
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BUKO--C 1.515778    
BUAR--C -0.285617    
BBCA--C 0.337676    
BCIN--C -0.091128    
BDAN--C -0.051841    
BEKO--C -0.386053    
BAGA--C -0.152366    
BAHA--C 0.258520    
BICB--C -1.124779    
ICBC--C 0.035432    
BIDX--C -0.207600    
BBII--C -0.077116    

BAMS--C -0.223337    
MAYA--C -0.213358    
BMEG--C -0.155928    
BMES--C 0.722913    
BMEX--C -0.108395    
BUTI--C 0.120125    
BNPS--C -0.313055    
OCBC--C 0.027597    
BIND--C 1.060705    
BPAN--C 0.288484    
BPER--C -0.435682    
BQNB--C -0.290441    
BSBI--C -1.355826    
BSIN--C 0.045560    
BUOB--C -0.073950    
BNPP--C 0.743276    
BCOM--C -0.225875    
BAGR--C -0.405213    
BCAP--C -0.294508    
BKEB--C 1.939710    
BRAB--C -0.764082    
BRES--C 0.958562    
BWIN--C 0.211093    

          
 Effects Specification   
   S.D.   Rho   
          

Cross-section random 0.812319 0.1842 
Idiosyncratic random 1.709550 0.8158 

          
 Weighted Statistics   
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R-squared 0.212937     Mean dependent var 1.995470 
Adjusted R-squared 0.204519     S.D. dependent var 1.960243 
S.E. of regression 1.748336     Sum squared resid 571.5988 
F-statistic 25.29608     Durbin-Watson stat 1.774439 
Prob(F-statistic) 0.000000    

          
 Unweighted Statistics   
          

R-squared 0.274000     Mean dependent var 2.911546 
Sum squared resid 710.1573     Durbin-Watson stat 1.428229 

           

vii. Tahapan selanjutnya adalah melakukan uji hausman untuk memilih 

model terbaik antara FEM atau REM. Hasil analisis menunjukan bahwa F 

test maupun chi-square signifikan (< 0.05 atau lebih kecil dari <0.05) 

maka model fixed effect (FEM) lebih baik dibandingkan model random 

effect (REM). 
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BAB V  

ANALISIS DATA MENGGUNAKAN  

PROGRAM SMARTPLS 
 

 

 

 

 

 

 

Dalam analisis data penelitian khususnya penelitian kuantitatif, peran 

statistik hampir mutlak diperlukan. Metode dan alat analisis yang digunakan 

sangat tergantung dari jenis data, jumlah variabel, permasalahan dan tujuan 

penelitian. Peneliti diharapkan mampu memilih metode dan alat analisis data 

yang tepat. 

Ada berbagai macam alat analisis data statistik dalam aplikasinya. 

Didukung dengan kemajuan teknologi komputer, tersedia berbagai alat 

analisis data yang dapat digunakan mahasiswa seperti program SPSS, LISREL, 

Eviews, AMOS, MATLAB, dan lainnya 

Program lain yang dapat digunakan dalam analisis data statistik dapat 

menggunakan Program SmartPLS. SmartPLS merupakan metode analisis 

dengan Structure Equation Modelling (SEM) yang berbasis variance. 
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A. SEM BERBASIS VARIAN DAN KOVARIAN 
SEM adalah suatu teknik statistka untuk menguji dan mengestimasi 

hubungan kausal dengan mengitegrasikan analisis faktor dan analisis 

jalur. SEM dikembangkan dari general liner model (GLM) dengan regresi 

berganda sebagai bagian utamanya.  

Pada dasarnya, SEM dapat berbasis pada varian atau kovarian. SEM 

berbasis varian adalah SEM yang menggunakan varian dalam proses 

iterasi atau blok varian antarindikator atau parameter yang diestimasi 

dalam satu variable laten tanpa mengkorelasikannya dengan indikator-

indikator yang ada di variabel laten lain dalam suatu model penelitian. 

Berbeda dengan SEM berbasis kovarian yang melakukan 

interkorelasi atau membebaskan indikator-indikatornya untuk saling 

berkorelasi dengan indikator dan variable laten lainnya. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Perbedaan SEM Berbasis Varian Dan Kovarian 

 

 

Konstruk 

Indikator 

Indikator 

Indikator 

 

Konstruk 

Indikator Indikator Indikato

r 

 

Konstruk 

Indikator Indikator Indikator 
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Konsekwensi proses interasi berbasis varian adalah adanya 

pengabaian efek multikolinearitas antar indikator dan variable laten. 

Selain itu, interasi berbasis varian tidak menuntut berbagai asumsi 

yang rigid, sehingga informasi yang dihasilkan tidak cukup untuk model 

estimasi. Sebaliknya, metode ini tepat digunakan untuk model prediksi 

yang hanya mengukur kausalitas pada jenjang variable laten. 

Metode SEM yang banyak digunakan salah satunya SEM berbasis 

varian adalah PLS. Sedangkan untuk SEM yang berbasisi kovarian 

diantaranya adalah LISREL dan AMOS. PLS hadir untuk mengatasi 

berbagai kendala-kendala yang dihadapi SEM yang berbasisi kovarian. 

Namun ada beberapa perbedaan-perbedaan yang dimiliki antara SEM 

berbasis kovarian dan SEM berbasis varian. 

 

B. PERBANDINGAN SEM BERBASIS VARIAN DAN 

KOVARIAN 
 

Parameter 

Pembanding 
LISREL dan AMOS PLS 

Sifat Konstruk Reflektif Formatif dan 

Reflektif 

Distribusi Asumsi Memenuhi asumsi 

Normalitas, Outliers, 

Multicollinearity. 

Tidak terkendala 

asumsi. 

Basis teori Mensyaratkan dasar teori 

yang kuat 

Dapat menguji 

model penelitian 

dengan dasar teori 

yang lemah 

Ukuran sampel Membutuhkan sampel 

yang besar 

Dapat dijalankan 

dengan sampel yang 

kecil 

Implikasi Optimal untuk ketepatan 

prediksi 

Optimal untuk 

ketepatan parameter 
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1. Sifat Konstruk 

Sifat konsutruk dapat bersifat reflektif dan formatif. Model reflektif 

sering juga disebut confirmatory factor model dimana kovarian 

pengukuran indicator seolah-olah dipengaruhi variable laten atau 

mencerminkan variasi dari variable laten. Berikut adalah contoh 

gambar variable laten dengan indikator reflektif: 

 

 

 

 

 

 

 

 

 

 

 

Gambar 1.2. Model Indikator Reflektif 

 

 

Ciri model indikator reflektif adalah: 

i. Arah hubungan kauslitas seolah-olah (seperti) dari variable 

laten ke indikator 

ii. Antar indicator diasumsikan saling berkolerasi 

iii. Menghilangkan satu indikator dari model pengukuran tidak 

akan merubah makna dan arti variable laten 

iv. Kesalahan pengukuran (error) pada setiap waktu (tingkat) 

indicator didasarkan pada model matematis dari analisis 

faktor. 

Model indikator formatif tidak memerlukan asumsi bahwa semua 

indicator memiliki factor bersama. Berbeda dengan model reflektif, 

diasumsikan bahwa semua indicator memiliki faktor bersama. Berikut 

adalah contoh gambar variable laten dengan indikator formatif: 

 

Laten  

Indikator 1 

Indikator 2  

Indikator 3 

e1 

e2 

e3 

e1 
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Gambar 1.3. Model Indikator Formatif 

 

Ciri model indikator reflektif adalah: 

i. Arah hubungan kauslitas seolah-olah (seperti) dari indicator ke 

variable laten 

ii. Antar indicator diasumsikan tidak berkolerasi 

iii. Menghilangkan satu indikator dari model pengukuran akan 

merubah makna dan arti variable laten 

iv. Kesalahan pengukuran (error) pada setiap waktu (tingkat) 

indikator didasarkan pada model matematis dari analisis 

komponen utama. 

 

2. Asumsi 

Asumsi di dalam PLS hanya berkaitan dengan pemodelan 

persamaan struktural:  

i. Hubungan antar variabel laten dalam inner model adalah linier 

dan aditif 

ii. Model srtuktural bersifat rekursif.  

3. Basis Teori 

Pada LISREL dan AMOS membutuhkan dasar teori yang kuat. Suatu 

model penelitian harus memiliki justifikasi teori dan atau konsep yang 

kuat, dimana hubungan antar variable dalam model penelitian 

merupakan deduksi dari teori. Tidak ada standarisasi berapa kajian 

empiris yang dibutuhkan untuk menjadi justrifikasi bahwa hubungan 

antar variable sudah memiliki justifikasi teori yang kuat. Bisa 15, 20 

atau lebih hasil kajian empiris yang menunjukan hasil yang sama.  

Laten  

Indikator 1 

Indikator 2  

Indikator 3 
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4. Ukuran Sampel 

Secara umum, untuk LISREL dan AMOS membutuhkan sampel 

antara 100–200. Kelebihan dari menggunakan metode PLS adalah 

kebutuhan ukuran sampel yang tidak besar bila dibandingkan LISREL 

dan AMOS. Ukuran sampel yang digunakan di PLS sebagai patokan 

sebagai berikut: 

i. Sampel size kecil 30 – 50 atau sampel besar 200. 

ii. Atau sepuluh kali jumlah indikator formatif (mengabaikan 

indicator reflektif) 

iii. Atau sepuluh kali jumlah jalur structural (structural paths) 

pada iner model. 

5. Implikasi 

Untuk LISREL dan AMOS tujuan analisis secara umum adalah 

mengestimasi model untuk mengukur tingkat ketepatan representasi 

model dengan indikator-indikator pengukurannnya (parameter). 

Sedangkan PLS, menguji efek prediksi hipotesis parsial dan hipotesis 

model yang diukur pada jenjang konstruk atau variabel laten. 

 

C. PARTIAL LEAST SQUARE (PLS) 
Aplikasi SEM dengan PLS telah banyak digunakan dalam berbagai 

penelitian diberbagai bidang. Misalnya dalam penelitian bidang 

manajemen, akuntansi, ekonomi, psikologi, sosial, pendidikan, psikologi 

dan bidang lainnya yang umumnya melibatkan variable-variabel laten. 

PLS pertama kali dikembangkan oleh Herman Wold (1985) sebagai 

metode analisis yang powerfull untuk mengatasi keterbatasan-

keterbatasan di SEM yang berbasis kovarian. Keterbatasan antara lain 

ukuran sampel, asumsi pada evaluasi model dan basis teori. Berikut 

notasi atau lambang yang digunakan pada model persamaan struktural 

dengan PLS yang dapat dilihat pada gambar dibawah ini: 
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Notasi Pemodelan Persamaan Struktural Dengan PLS 

 

Keterangan: 

    = Ksi, variabel latent eksogen   

    = Eta, variabel laten endogen  

x  = Lamnda (kecil), loading faktor variabel latent eksogen  

y  = Lamnda (kecil), loading faktor variabel latent endogen  

x = Lamnda (besar), matriks loading faktor variabel latent 

eksogen  

y = Lamnda (besar), matriks loading faktor variabel laten 

endogen  

   = Beta (kecil), koefisien pngruh var. endogen terhadap endogen  

    = Gamma (kecil), koefisien pngruh var. eksogen terhadap 

endogen  

    = Zeta (kecil), galat model  

   = Delta (kecil), galat pengukuran pada variabel laten eksogen  

    = Epsilon (kecil), galat pengukuran pada variabel latent 

endogen  

 

Software SmartPLS diciptakan oleh Institut of Operation 

Managemen and Organization (School of Business) University of 

Hamberg. Untuk dapat menginstal program SmartPLS maka perlu 

terlebih dahulu menginstal program Java Runtime Enviromental (JRE). 
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Untuk dapat mendownload gratis program SmartPLS dapat mendaftar 

di https://www.smartpls.com/downloads  

 

 

D. LANGKAH-LANGKAH PEMODELAN PERSAMAAN 

STRUKTURAL DENGAN PLS 
Langkah-langkah pemodelan persamaan structural dengan PLS 

tidak jauh berbeda dengan analisis jalur dan SEM. Secara diagram dapat 

diberikan seperti gambar berikut: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Langkah-Langkah Pemodelan Persamaan Struktur Dengan PLS 

 

Keterangan: 

1. Merancang Model Struktural (Inner Model) 

Perencanaan model dapat berbasis teori (kalau sudah ada), hasil 

penelitian empiris, analogi (cara bernalar dengan membandingkan dua 

hal yang memiliki sifat sama), normatif (misal peraturan pemerintah, 

undang-undang, dan lain sebagainya) dan rasional (premis-premis). 

Merancang Model Struktural (inner 
model) 

 

Merancang Model Pengukuran (outer 
model)  

 

Mengkonstruksi Diagram Jalur  

 

Konversi Diagram Jalur ke Sistem 
Persamaan  

 

Estimasi: Koef. Jalur, loading dan 
Weight  

 

Evaluasi Goodness of Fit  

 

Pengujian Hipotesis (Resampling 
Bootstraping)  

 

https://www.smartpls.com/downloads
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Jadi dimungkinkan melakukan eksplorasi hubungan natar variabel 

laten. 

2. Merancang Model Pengukuran (Outer Model) 

Perencanaan model pengukuran menjadi penting untuk 

menentukan apakah indicator bersifat reflektif atau formatif. Dasarnya 

adalah tepri, penelitian empiris sebelumnya atau kalau belum ada 

adalah rasional (logic thinking). Dengan merujuk pada definisi 

konsepsional dan operasional akan terlihat sifat indikator. 

3. Mengkonstruksi Diagram Jalur 

Bila langkah satu dan dua sudah dilaksanakan maka dibuat model 

penelitiannya. 

4. Konversi Diagram Jalur Ke Sistem Persamaan 

Outer model yaitu spesifikasi hubungan antara variabel laten 

dengan indikatornya. Sedangkan untuk Inner model yaitu spesifikasi 

hubungan antar variabel laten. 

a. Outer model  

Untuk variabel latent eksogen 1 (reflektif) 

x1 = x1 1 + 1  

x2 = x2 1 + 2  

x3 = x3 1 + 3  

Untuk variabel latent eksogen 2 (formatif)  

2 = x4 X4 + x5 X5 + x6 X6 + 4  

Untuk variabel latent endogen 1 (reflektif) 

y1 = y1 1 + 1  

y2 = y2 1 + 2  

Untuk variabel latent endogen 2 (reflektif) 

y3 = y3 2 + 3  

y4 = y4 2 + 4 

b. Inner model  

1 = 11 + 22 + 1  

2 = 11 + 31 + 42 + 2  

 

5. Estimasi: Weight, Koefisien Jalur dan Loading 

Penduga parameter di dalam PLS meliputi 3 hal yaitu: 
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i. Weight estimate, yaitu penduga outer weight (yang 

menghubungkan antara variabel laten dengan indikatornya), 

tujuannya adalah untuk menghitung data variabel laten. 

ii. Path estimate (penduga jalur), yaitu penduga koefisien jalur 

(yang menghubungkan anatar variabel laten) dan penduga 

outer loading (yang menghubungkan antara variabel laten 

dengan indikatornya). 

iii. Means estimate yaitu penduga parameter berdasarkan 

resampling, tujuannya adalah untuk pengujian (hipotesis) 

parameter. 

6. Evaluasi Goodness of Fit 

a. Outer model refleksif  

1. Convergent validity  

Nilai loading 0.5 sampai 0.6 dianggap cukup, untuk jumlah 

indikator dari variabel laten berkisar antara 3 sampai 7. Namun 

disarankan lebih besar dari 0,70. 

2. Discriminant validity  

Direkomendasikan nilai AVE (average variance extracted) lebih 

besar dari 0.50 

3. Composite realibility 

Nilai batas yang diterima untuk tingkat reliabilitas komposit 

(ρc) adalah ≥ 0.7, walaupun bukan merupakan standar absolut. 

b. Outer model formatif :  

Dievaluasi berdasarkan pada substantive content-nya yaitu dengan 

melihat signifikansi dari weight tersebut. 

c. Inner model:  

Diukur menggunakan Q-Square predictive relevance. Rumus Q-

Square: Q2 = 1 – ( 1 – R12) ( 1 – R22 ) ... ( 1- Rp2 ) 

dimana R12 , R22 ... Rp2 adalah R-square variabel endogen dalam 

model. Interpretasi Q2 sama dg koefisien determinasi total pada 

analisis jalur (mirip dengan R2 pada regresi)  

7. Pengujian Hipotesis (Resampling Bootstraping) 

Hipotesis statistik untuk outer model: 

H0 : λi =  0  lawan 

H1 : λi ≠ 0 
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Hipotesis statistik untuk inner model: variabel laten eksogen 

terhadap endogen: 

H0 : γi =  0  lawan 

H1 : γi ≠ 0  

Hipotesis statistik untuk inner model: variabel laten endogen 

terhadap endogen: 

H0 : βi =  0  lawan 

H1 : βi ≠ 0 

Statistik uji:  t-test;  p-value ≤ 0,05 (alpha 5 % = 1,96); signifikan 

Outter model signifikan:  indikator bersifat valid   

Inner model signifikan: terdapat pengaruh signifikan  

PLS tidak mengasumsikan data berdistribusi normal: menggunakan 

teknik resampling dengan metode Bootstrap. 

E. INSTAL PROGRAM SMARTPLS 
Sebelum menggunakan program SmartPLS, perlu disiapkan terlebih 

dahulu programnya. Program dapat di install secara gratis untuk versi student 

(Pelajar). Namun versi ini memiliki keterbatasan seperti jumlah obeservasi 

yang dianalisis maksimal hanya 100, jika lebih dari 100 maka kita perlu meng-

upgrade dengan versi professional atau business yang tentu saja berbayar. 

Berikut adalah proses instalasi program SmartPLS: 

1. Buka web SmartPLS 
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2. Donwload SmartPLS berdasarkan Spesifikasi komputer anda 32Bit atau 

64Bit 

 
3. Klik Next 
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4. Klik Next 

 
5. Tunggu sampai selesai 
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6. Klik Install 

 
7. Klik Finish 
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8. Pilih Studen FREE Klik Contiue 

 
 

9. Klik Contineu 

 
10. Pilih Start dan siap untuk digunakan 
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F. MENYIMPAN DATA 

Data yang dianalisis yang akan diinput ke dalam program SmartPLS harus 

diatur sedemikan rupa di program excel, untuk nantinya akan diubah tipe file 

menjadi bentu CSV (Comma Separated Values/ Comma Delimmeted). Jika 

tidak diubah, program tidak akan membaca data inputan. Misalnya ada contoh 

penelitian yang berjudul: Pengaruh Perceived Price dan Perceived Quality 

terhadap Perceived Value. Penelitian ini jumlah responden sebanyak 80 

responden. Penelitian ini memiliki model penelitian, variable dan indicator 

sebagai berikut: 

 

 

Variabel Construct 

Perceived Value (PV) PV1 Functional value 

 PV2 Emotional value 

 PV3 Value for money 

 PV4 Novelty value 

 PV5 Social value 

Perceived Price (PP) PP1 equal price 

 PP2 make sense 

 PP3 expensive price 

Perceived Quality (PQ) PQ1 overall quality 
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 PQ2 functional 

 PQ3 reliable 

 PQ4 durable 

 

Adapun susunan data penelitian (lebih lengkap dapat dilihat pada Lampiran 2. 

Contoh Data Penelitian Perceived Value) yang di excel harus diatur sebagai 

contoh berikut: 

 

 
 

Kemudian data di Save As dengan milih format CSV. 
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G. ANALISIS SEM KASUS I 

EViews merupakan salah satu program computer yang 

Setelah data disimpan dengan menggunakan format CSV, maka data siap 

untuk dianalisis. Berikut tahapan analysis SEM dengan menggunakan program 

SmartPLS dengan menggunakan data pada Lampiran 2. Contoh Data 

Penelitian Perceived Value: 

1. Buka program SmartPLS yang sudah di install 
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2. Klik File -> Create New Project  

  

 

3. Isi nama file sesuai dengan yang diinginkan, misalnya Perceived Value -> 

OK 
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4. Import data yang telah disiapkan dengan cara double klik  
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5. Open data yang telah diubah dalam bentuk CSV 

 
 

 

6. Double Klik Perceived Value untuk membuat model analisis. 
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7. Arahkan krusor untuk membuat variabel lalu klik Laten Variabel 

 

 
Jika sudah membuat variabel, silahkan klik Select -> klik kanan untuk 

Rename lalu isi sesuai dengan nama variabel pada model penelitian. 
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Lalu klik Connect untuk menghubungkan variabel dengan cara tarik garis 

connect ke variabel. Setelah dibuat Connect lalu Kembali klik Select 
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8. Masukan data ke dalam model dengan cara blok indicator untuk setiap 

variable yang akan dimasukan (Tekan ctrl lalu klik setiap indicator). Misal 

variabel Perceived Price (PP). 

  
9. Tekan indicator yang sudah terblok sambil digerakan kearah variabel 

indicator Perceived Price (PP) lalu lepas sehingga menjadi seperti ini: 
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Lakukan pada variabel yang lain: 

 
10. Rapikan indicator dengan cara klik kanan, lalu pilih arah indicator misal 

seperti ini: 
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11. Jika sudah dinilai rapi maka tahapan selanjutnya ada melakukan analisis. 

Dalam analisis dengan PLS ada 2 hal yang dilakukan. Pertama, menilai 

outer model atau measurement model. Outer model adalah penilaian 

terhadap reliabilitas dan validitas variabel penelitian. Ada beberapa 

kriteria untuk menilai outer model yaitu convergent validity, discriminant 

validity dan composite reliability. Kedua, menilai inner model atau 

structural model, pengujian inner model atau model struktural 

dilakukan untuk melihat hubungan antara konstruk, nilai signifikasi 

dan R-square dari model penelitian. 

12. Klik Calculate -> PLS Algorithm -> Start Calculation 
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13. Tahap pertama, kita perlu melakukan pengecekan outer loading untuk 

setiap variabel. Outer model atau measurement model adalah penilaian 

terhadap reliabilitas dan validitas variabel penelitian. Ada tiga kriteria 

untuk menilai outer model yaitu: Convergen validity, Validitas 

diskriminan dan Composit Reliability.  

14. Convergent Validity 

Uji validitas konvergen dalam PLS dinilai berdasarkan loading factor 

(korelasi antara skor ítem / skor komponen dengan skor variabel) 

indikator – indikator yang mengukur variabel tersebut. Indikator 

dianggap valid jika memiliki nilai loading diatas 0,70. 

Untuk mengetahui nilai dapat klik Outer Loading atau Perceived Value. 
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Jadi outer loading dapat dilihat dalam bentuk table atau gambar model. 

Jika kita melihat grafik maka terlihat indicator dengan outer loading < 

0.70 berwarna merah. Sedangkan warna hijau outer loading diatas 0.70. 

Berdasarkan outer loading diatas, indikator PP3, PQ3, PQ4, dan PV4,; 

memiliki nilai outer loading kurang dari 0,7 sehingga tidak memenuhi 

kriteria validitas konvergen. Jika menghadapi kondisi seperti ini maka 

indicator-indikator tersebut perlu di delete (dihapus), lalu lakukan 

kembali analsisi ulang hingga seluruh indikator berada pada nilai outer 

loading 0,7. Berikut prosesnya: 
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Dari hasil analisis tahap ke 2 dengan mendelete indicator dibawah 0.70 

diperoleh hasil seluruh indicator diatas 0.70 sehingga telah memenuhi 

kriteria validitas konvergen. 

15. Selanjutnya adalah pengecekan Validitas diskriminan. Untuk menguji 

validitas diskriminan yaitu dengan cara membandingkan antara nilai 

akar average variance extracted (AVE) untuk setiap variabel laten 

dengan koefisien korelasi antara variabel laten lainnya. Bilamana akar 

AVE lebih besar dari korelasi antar variabel laten tersebut dengan 

variabel lainnya, maka discriminant validity terpenuhi. Namun 

direkomendasikan nilai AVE (average variance extracted) lebih besar 

dari 0.50. 

16. Kemudian pengecekan Composite Reliability yang digunakan untuk 

menguji kekonsistenan instrumen penelitian menurut penilaian 

responden dapat melihat dari nilai Cronbach’s Alpha dan nilai 

Composite Reliability. Nilai Cronbach’s Alpha (batas bawah nilai 

reliabilitas suatu konstruk) sedangkan nilai Composite Reliability (nilai 

sesungguhnya reliabilitas suatu konstruk). Instrumen penelitian dengan 

composite reliability baik jika nilainya diatas 0,70. 
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Dari hasil pengecekan Validitas diskriminan dan Composite Reliability 

diketahui bahwa valid dan reliabel. 

17. Tahapan selanjutnya adalah inner model. Pengujian inner model atau 

model struktural dievaluasi dengan melihat persentase varian yang 

dijelaskan dengan melihat R-square untuk variabel dependen dari model 

penelitian. 
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Nilai R-square sebesar 0.898 yang dapat diinterpretasikan bahwa 

kemampuan model dalam menerangkan variasi variabel dependen 

sebesar 89.8 persen (0.898 x 100%) sedangkan 10.2% dijelaskan oleh 

variabel lain diluar yang diteliti. 

18. Selanjutnya untuk melihat pengaruh dan signfikasi variabel dengan 

cara sebagai berikut: 
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Hasil menunjukan Perceived Price (PP) dan Perceived Quality (PQ) 

berpengaruh positif dan signifikan terhadap Perceived Value (PV). 

 
Pengaruh 

Antar Variabel 

Koefisien T Statistik P Value Arah Sig/Tidak Sig 

PP -> PV 0.883 33.428 > 

1.96 

0.000 < 0.05 (+) Sig 

PQ -> PV 0.130 2.843 > 1.96 0.005 < 0.05 (+) Sig 

 

19. Informasi lain terkait dengan hasil analsisi yang perlu juga diketahui 

adalah Multikolenieritas. jika nilai VIF dibawah 5,00 maka tidak terjadi 

multikolinearitas. Hasil analisis menunjukan tidak ada masalah terkait 

multikolinearitas. 
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H. ANALSISI SEM KASUS II (PENGARUH LANGSUNG DAN 

TIDAK LANGSUNG) 
Analisis SEM untuk kasus ke II menggunakan dapa pada Lampiran 3 

Contoh Data Penelitian Loyalitas. Pada kasus ini jumlah responden yang 

diteliti sebanyak 100 responden. Penelitian ini berjudul pengaruh citra 

perusahaan dan kualitas layanan terhdap kepuasan dan loyalitas pelanggan.  
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1. Proses analisis data sama seperti pada contoh kasus I, namun dalam 

kasus II terdapat variabel dependen (Y) sebanyak 2 variabel, dimana 

variabel Y1 (Kepuasan Pelanggan) juga menjadi variabel independen 

terhadap variabel Y2 (Loyalitas). 

2. Tahapannya buka data Lampiran 3 Contoh Data Penelitian Loyalitas 

lalu save as menjadi format CSV. 

3. Klik File -> Create New Project -> Isi nama file sesuai dengan yang 

diinginkan, misalnya Loyalitas -> OK 

4. Import data yang telah disiapkan dengan cara double klik 

 
5. Open data yang telah diubah dalam bentuk CSV (dalam hal ini Lampiran 

3 Contoh Data Penelitian Loyalitas) 

6. Double Klik Loyalitas untuk membuat model analisis. 
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7. Arahkan krusor untuk membuat variabel lalu klik Laten Variabel 

8. Jika sudah membuat variabel, silahkan klik Select -> klik kanan untuk 

Rename lalu isi sesuai dengan nama variabel pada model penelitian. Lalu 

klik Connect untuk menghubungkan variabel dengan cara tarik garis 

connect ke variabel. Setelah dibuat Connect lalu Kembali klik Select. 

9. Masukan data ke dalam model dengan cara blok indicator untuk setiap 

variable yang akan dimasukan (Tekan ctrl lalu klik setiap indicator). 

Rapikan sehingga membetuk model penelitian sebagai berikut: 

 
10. Selanjutnya data siap untuk dianalisis. Sama seperti pada kasus I, dalam 

analisis dengan PLS ada 2 hal yang dilakukan. Pertama, menilai outer 

model atau measurement model. Kedua, menilai inner model atau 

structural model. 

11. Klik Calculate -> PLS Algorithm -> Start Calculation 
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12. Tahap pertama, kita perlu melakukan pengecekan outer loading untuk 

setiap variabel. Outer model atau measurement model adalah penilaian 

terhadap reliabilitas dan validitas variabel penelitian. Ada tiga kriteria 

untuk menilai outer model yaitu: Convergen validity, Validitas 

diskriminan dan Composit Reliability. 

13. Covergen validity. Uji validitas konvergen dalam PLS dinilai berdasarkan 

loading factor. Indikator dianggap valid jika memiliki nilai loading diatas 

0,70. Berdasarkan outer loading dibawah ini, indikator X1.3, X2.1, dan 

X2.5; memiliki nilai outer loading kurang dari 0,7 sehingga tidak 

memenuhi kriteria validitas konvergen.  
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Jika menghadapi kondisi seperti ini maka indicator-indikator tersebut 

perlu di delete (dihapus), lalu lakukan kembali analsisi ulang hingga 

seluruh indikator berada pada nilai outer loading 0,7. Berikut prosesnya: 
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Dari hasil analisis tahap ke 2 dengan mendelete indicator dibawah 0.70 

diperoleh hasil seluruh indicator diatas 0.70 sehingga telah memenuhi 

kriteria validitas konvergen. 

14. Selanjutnya pengecekan Validitas diskriminan dan Composite Reliability. 

Untuk menguji validitas diskriminan yaitu direkomendasikan nilai AVE 

(average variance extracted) lebih besar dari 0.50. Sedangkan Composite 

Reliability disarnakan instrumen penelitian dengan composite reliability 

baik jika nilainya diatas 0,70. Hasil menunjukan model valid dan reliabel 

yang terlihat dari nilai AVE > 0.50 dan composite reliability > 0.70. 

 
15. Tahapan selanjutnya adalah inner model. Pengujian inner model atau 

model struktural dievaluasi dengan melihat persentase varian yang 

dijelaskan dengan melihat Rsquare untuk variabel dependen dari model 

penelitian. Goodness of fit inner model (kelaikan model) diukur 

menggunakan R-square (R2) variabel dependen dengan menggunakan 

ukuran Q-Square test dan juga melihat besarnya koefisien jalur 

strukturalnya. Q-Square predictive relevance mengukur seberapa baik 

model struktural yang dihasilkan dengan PLS. Perhitungan Q-Square 

dilakukan dengan rumus: 

Q2 = 1 – (1- R1
2) (1- R2

2) 

 
Besarnya nilai Q2 = 1 – (1 – 0.353) (1 – 0.390) = 0,605. Hal ini dapat 

diinterprestasikan bahwa model cukup baik, yaitu mampu menjelaskan 
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fenomena loyalitas pelanggan sebesar 60,5 %, sedangkan sisanya (39,4 

%) dijelaskan oleh variabel lain yang belum masuk ke dalam model. 

16. Selanjutnya untuk melihat pengaruh dan signfikasi variabel dengan cara 

sebagai berikut: Klik Calulate -> Bootstrapping -> Start Calculation. 

 

 
Hasil menunjukan sebagai berikut: 

Citra Perusahaan (X1) berpengaruh positif dan signifikan terhadap 

Kepuasan (Y1) 

Citra Perusahaan (X1) berpengaruh positif dan signifikan terhadap 

Loyalitas (Y2) 

Kualitas Layanan (X2) berpengaruh positif dan signifikan terhadap 

Kepuasan (Y1) 

Kualitas Layanan (X2) berpengaruh positif dan tidak signifikan terhadap 

Loyalitas (Y2) 

Kepuasan (Y1) berpengaruh positif dan signifikan terhadap Loyalitas (Y2) 

17. Informasi lain terkait dengan hasil analsisi yang perlu juga diketahui 

adalah Multikolenieritas. jika nilai VIF dibawah 5,00 maka tidak terjadi 



Bab V Analisis Data Menggunakan Program SmartPLS 223 

multikolinearitas. Hasil analisis menunjukan tidak ada masalah terkait 

multikolinearitas. 

 
18. Selanjutnya untuk mengeksplor lebih jauh, analsisi dapat ditambah 

dengan melihat pengaruh langsung dan tidak langsung serta total 

pengaruh variabel termasuk presetase pengaruh. Caranya sebagai 

berikut: 

Path 
Pengaruh 

Langsung Tidak Langsung 

X1 -> Y1  Ya  Tidak 

X2 -> Y1  Ya  Tidak 

X1 -> Y2  Ya  Ya (Melalui Y1) 

X2 -> Y2  Ya  Ya (Melalui Y1) 

Y1 -> Y2  Ya  Tidak 
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Path 
Pengaruh Total Pengaruh 

Langsung Tidak Langsung 

X1 -> Y1 0.346 - 0.346 

X2 -> Y1 0.410 - 0.410 

X1 -> Y2 0.362 (0.346)*(0.421) 0.507 

X2 -> Y2 0.307 (0.216)*(0.421) 0.397 

Y1 -> Y2 0.421 - 0.421 

 

Untuk merubah dari Path Coefficient menjadi Prosentase, 
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Rumusnya: = (path coefficient x Latent Variabel Correlation) x 100%         

 

  

 

 Path 
Pengaruh (%) Total 

Pengaruh 
(%) 

Langsung Tidak Langsung 

X1 -> Y1 0.346*0.440 - 15.22 
X2 -> Y1 0.410*0.490 - 20.09 
X1 -> Y2 0.362*0.432 (0.346*0.440)*(0.421*0.582) 19.37 
X2 -> Y2 0.307*0.389 (0.216*0.490)*(0.421*0.582) 14.54 
Y1 -> Y2 0.421*0.582 - 24.50 
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I. ANALISIS SEM KASUS III (MEDIASI) 
Pada kasus ketiga, kita akan khusus membahas mengani variabel mediasi 

atau mediator. Namun sebelum melakukan analsisi, ada beberaoa hal penting 

yang perlu kita ketahui mengenai variabel mediasi. Gambar dibawah ini 

menunjukan model penelitian yang menggunakan variabel mediasi: 

 
Dimana: 

p3    = efek langsung, 

p1.p2             = efek tidak langsung, 

p3 + (p1.p2) = efek total 

 

Pertanyaan penting yang diajukan adalah kapan suatu variabel dikatakan 

sebagai variabel mediasi? Untuk menjawab hal tersebut, program SmartPLS 

memberikan role of tumb sebagai berikut: 
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Keterangan:   

No mediasi     = variabel tidak berperan sebagai mediasi atau mediator 

Full Mediation = variabel independen tidak mampu mempengaruhi 

secara signifikan variabel variabel dependen tanpa 

melalui variabel mediasi 

Partial Mediation = variabel independen mampu mempengaruhi secara 

langsung variabel dependen tanpa 

melalui/melibatkan variabel mediator 

 

 
Variabel Construct 

Social Media 

Marketing Activities 

(SMMA) 

Entertainment (SMMA1) 

Interaction (SMMA2) 

Trendiness (SMMA3) 

Customization (SMMA4) 

Word-of-mouth (SMMA5) 

Perceived Value 

(PV) 

Aesthetics (PV1) 

Playfulness (PV2) 

Consumer Return on Investment (PV3) 

Service Excellence (PV4) 

Satisfaction (ST) Continuance Intention (ST3) 

Participate Intention (ST3) 

Purchase Intention (ST2) 

 

Pada tahapan ini analysis SEM dengan menggunakan kasus variabel mediasi 

menggunakan data pada Lampiran 4 Contoh Data Penelitian Mediasi. Tahapan 
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analisis sama seperti pada kasus I dan II, namun disesuaikan dengan model 

penelitian. Adapun tahapannya sebagai berikut: 

1. Klik File -> Create New Project 

2. Isi nama file sesuai dengan yang diinginkan, misalnya Mediasi -> OK 

3. Import data yang telah disiapkan dengan cara double klik 

4. Open data yang telah diubah dalam bentuk CSV (Nama file Contoh Data 

Penelitian Mediasi) 

5. Double Klik Mediasi untuk membuat model analisis. 

6. Arahkan krusor untuk membuat variabel lalu klik Laten Variabel 

7. Jika sudah membuat variabel, silahkan klik Select -> klik kanan untuk 

Rename lalu isi sesuai dengan nama variabel pada model penelitian. 

8. Lalu klik Connect untuk menghubungkan variabel dengan cara tarik garis 

connect ke variabel. Setelah dibuat Connect lalu Kembali klik Select 

9. Masukan data ke dalam model dengan cara blok indicator untuk setiap 

variable yang akan dimasukan (Tekan ctrl lalu klik setiap indicator). Misal 

variabel Social Media Marketing Activities (SMMA). 

10. Tekan indicator yang sudah terblok sambil digerakan kearah variabel 

indicator Social Media Marketing Activities (SMMA) lalu lepas. Lakukan 

pada variabel yang lain dan data siap dianalisis sehingga menjadi seperti 

ini: 

 
11. Lakukan pengujian untuk, pertama menilai outer model atau 

measurement model. Kedua, menilai inner model atau structural model. 

Hasil outer model sebagai berikut: 
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Hasil inner model sebagai berikut: 
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12. Jika digambarkan hasil sebagai berikut: 

 
Mengikuti role of tumb penentuan variabel mediasi maka diketahui p1 

(SMMA -> PV = signifikan), p2 (PV -> ST = tidak signifikan) dan p3 (SMMA 

-> ST = signifikan) maka dapat disimpulkan tidak ada mediasi atau Direct 

Only (No Mediation). 

 

J. ANALISIS SEM KASUS IV (MODERASI) 
Setelah membahas variabel mediasi, maka tahapan selanjutnya dalah 

membahas analisis data SEM dengan menggunakan variabel moderasi. Namun 

sebelum melakukan analisis moderasi ada beberapa hal yang perlu diketahui 

sebagai berikut: 

1. Penentuan suatu variabel moderasi atau bukan moderasi sudah dibahas 

pada bab sebelumnya. 
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Jenis Variabel 

Moderasi 

Ciri-Ciri Keterangan 

p2 p3 

Moderasi Murni 
Tidak 

Signifikan 
Signifikan Moderasi 

Moderasi semu Signifikan Signifikan Moderasi 

Moderasi 

potensial 

Tidak 

Signifikan 

Tidak 

Signifikan 
Moderasi 

Moderasi prediksi Signifikan 
Tidak 

Signifikan 
Bukan Moderasi 

2. Untuk analsisi data dengan menggunakan variabel moderasi, kita akan 

menggunakan data pada Lampiran 5 Contoh Data Penelitian Moderasi 

dengan model sebagai berikut: 

Variabel Construct 

Awareness of 

environmental 

regulations/policies 

(AER) 

National environmental regulations (AER1) 

National resource saving and conservation 

regulations (AER2) 

Regional environmental regulations (AER3) 

Regional resource saving and conservation 

regulations (AER4) 

Developed countries' environmental 

regulations (AER5) 

Products potentially conflict with laws (AER6) 

Flexibility 

Orientation (FO) 

Empowerment (FO1) 

Growth (FO 2) 

Change (FO 3) 

Creativity (FO4) 

Flexibility (FO5) 

Corporate 

Environmental 

We always attempt to go beyond basic 

compliance with laws and regulations on 
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Proactivity (CEP) environmental issues (CEP1) 

Our corporate management gives a high 

priority to environmental issues (CEP2) 

The top managers in our company give 

environmental issues a high priority (CEP3) 

We effectively manage the environmental risks 

that affect our business (CEP4) 

 

 
Pada tahapan ini analysis SEM dengan menggunakan kasus variabel mediasi 

menggunakan data pada Lampiran 4 Contoh Data Penelitian Mediasi. Tahapan 

analisis sama seperti pada kasus I dan II, namun disesuaikan dengan model 

penelitian. Adapun tahapannya sebagai berikut: 

1. Klik File -> Create New Project 

2. Isi nama file sesuai dengan yang diinginkan, misalnya Moderasi -> OK 

3. Import data yang telah disiapkan dengan cara double klik 

4. Open data yang telah diubah dalam bentuk CSV (Nama file Contoh Data 

Penelitian Moderasi) 

5. Double Klik Moderasi untuk membuat model analisis. 

6. Arahkan krusor untuk membuat variabel lalu klik Laten Variabel 

7. Jika sudah membuat variabel, silahkan klik Select -> klik kanan untuk 

Rename lalu isi sesuai dengan nama variabel pada model penelitian. 

8. Lalu klik Connect untuk menghubungkan variabel dengan cara tarik garis 

connect ke variabel. Setelah dibuat Connect lalu Kembali klik Select 
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9. Masukan data ke dalam model dengan cara blok indicator untuk setiap 

variable yang akan dimasukan (Tekan ctrl lalu klik setiap indicator). Misal 

variabel Awareness of environmental regulations/policies (AER). 

10. Tekan indicator yang sudah terblok sambil digerakan kearah variabel 

indicator Awareness of environmental regulations/policies (AER) lalu 

lepas. Lakukan pada variabel yang lain dan data siap dianalisis sehingga 

menjadi seperti ini: 

 
11. Lakukan pengujian untuk, pertama menilai outer model atau 

measurement model. Kedua, menilai inner model atau structural model. 

Hasil outer model sebagai berikut: 
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12. Setelah dilakukan penilaian outer model, dimana hasil Convergen 

validity, Validitas diskriminan dan Composit Reliability telah memenuhi 

validitas dan reliabilitas maka tahapan selanjutnya adalah membentuk 

variabel moderasi. Adapun cara membuat variabel moderasi adalah 

sebagai berikut: 
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Jika ingin menampilkan indikator 

 
 

13. Setelah membentuk variabel moderasi maka tahapan selanjutnya adalah 

melakukan inner model sebagai berikut: 
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14. Dari hasil ini dapat ditentukan apakah variabel Flexibility Orientation 

(FO) sebagai variabel moderasi atau bukan moderasi. Jika mengikuti 

kriteria diatas maka diketahui p2 (FO -> CEP = signifikan) dan p3 

(Moderating Effect 1 -> CEP = tidak signifikan) masuk dalam kategori 

Bukan Moderasi. 
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